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This is my last issue as editor 
of Mac|Life. I’ve been running the 
magazine for a few years, since just 
before its 100th issue, and it’s been 
a really fun time to follow Apple. 
We’ve had the Apple Watch, the 
launch of Apple Music, the removal 
of the headphone port, iPad Pro, the 
Touch Bar, the 12-inch MacBook, and 
lots more. I’ve loved every second of it, 
and I want to thank every one of 
Mac|Life’s readers for being here.

But I’ve been thinking about the fact 
that the next time Apple makes an 
announcement (hopefully for new 

iPads in March, after I write this) I’ll be watching with a different 
perspective. I’ll be analyzing it differently. Maybe I’ve already 
started, because all this then triggered another thought:

Aren’t we overdue a dent in the universe?
The new releases I’ve listed above were all really cool in their 

own way, along with even more stuff like the AirPods, but it’s 
been too long since I was truly blown away by the newness and 
originality of an Apple release. I think the last thing with the 
kind of impact I’m talking about was the Mac Pro – and that’s 
still being sold in exactly the same form as it was in 2013.

What I really want is something with the wow factor of the 
iPhone 4. Remember how revolutionary that was? The metal-
and-glass design was stunning, the first Retina display was 
gorgeous, the new Apple A4 chip promised an amazing future, 
the camera was light years ahead of what Apple had made 
before… it was something of a revolution.

I’m hopeful that we’re going to see an iPhone 4-level event 
for the phone this year. There are some brilliant new possibilities 
in screen technology, camera sensors, and no doubt some Apple 
design magic going on. In fact, if we get only an iPhone 7s, I’m 
going to be pretty disappointed. I think 2017 is going to be a big 
year for Apple overall – I think almost everything will get an 
update – and I’m looking forward to watching along.

Time To resTarT

maTT BolTon, Editor

Twitter: @matthewbbolton

>>>ThE TEam

alan stonebridge
Usurper 

Incoming Editor Al knows 

everything about his Mac 

apps already, of course! 

mat Gartside
art editor 

Mat was going to learn to 

use Reminders better, but 

it slipped his mind.

Jo membery
operations editor 

Jo’s also leaving, so she’d 

better boost her Mail 

skills to keep in touch.
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You can back up 
hundreds of gigs 
from Macs to a 
Time Capsule – 
why not iOS too?

Changing the ringer volume on the Home screen 
should not affect other volume levels. Conversely, 
changing the volume on an active app, such as 
Music, should not change it for any other app.

I use the “Bedtime” feature, which allows me to 
set the wake-up volume. However, I have overslept 
on occasion because the volume was reduced after 

I changed it while in some other app.
I have not been able to discern the pattern. I can’t tell if changing 

the volume on any other app changes the Bedtime wake-up alarm 
volume or if it is just certain apps or just on the Home screen. I have 
to remember to check Bedtime’s alarm volume to be sure I can hear it. 
Of course, at bedtime, I often forget because I am so sleepy. 
STEwarT DalE SpEncEr

Go to Settings > Sounds; under Ringers and Alerts, turn off “Change with 
Buttons,” then use the slider above to set these sounds to a fixed volume 
– they’re then unaffected by changes to the “master” volume level, and 
only inaudible when the Ring/Silent switch is set to silent.

my ioS 11 wish
I’d like iOS backup capability to 

an AirPort unit on my network. 

DErEk bErggrEn

oh, we’d love that too! we’ve 

had our devices configured to 

backup to icloud for years, 

rather than having to connect 

them to iTunes to perform a 

local backup. with more of our 

information being stored on 

ioS devices all the time, we 

would still want a remote 

backup in icloud as well – but 

a faster way to restore would 

be very welcome.

Sadly, if rumors about 

discontinuation of further 

airport development turn out 

to be true, the chances of this 

happening seem slim. right 

now, the closest you can get is 

to use macoS Server to cache 

The Sim trays in both of 

your iphones are designed 

to accept a nano-Sim card. 

So yes, you’ll be able to 

temporarily transfer the Sim 

card from the iphone 7 plus 

to the iphone 5 in order to 

activate it, and then switch 

it back into the newer phone.

if you find yourself in a 

similar predicament with 

future devices, there’s a handy 

guide to which apple devices 

take each Sim card size at 

apple.co/1FZyf0s.

iwork in limbo
Has Apple killed Pages and 

Numbers? Because the last 

serious update to these apps 

was in 2013.

Tim SElForS

improvements to the iwork 

apps have indeed slowed in 

recent years, but we doubt 

apple has any intention of 

killing them off; they’re great 

added value when you buy a 

mac or an ioS device. more 

likely the company is cautious 

about adding what might be 

seen as bloat. last year,  

the apps gained Touch bar 

support and real-time 

collaboration features.

personal data from icloud, 

which will speed up the 

restoration of that data to 

your current device (if you 

need to start over) or to a 

new one.

There’s a guide to doing this  

in this issue’s create, on page 

106. Though the process itself 

is pretty simple, it’s not for 

everyone – ideally, you’ll need 

a spare mac for it, which you 

can permanently leave on.

iphone Similarities
I wiped my old iPhone clean and 

now it wants a SIM card. It says 

it needs a “functioning” SIM  

card. My new phone is a iPhone 

7 Plus – would its SIM card 

work or is it a different size? 

Frustrating. I just want to use 

the phone as an iPod.

linDa mcmUllEn

The iPhone 5 and later models all 
take the miniscule nano-SIM card.
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FEED YOUR MIND. FEAST YOUR EYES.

Apple aims to 
further enhance 

your daily life
Tim Cook says augmented reality is 

“a big idea, like the smartphone” 
BY GERAlD lYNch,  

MIchEllE FITzSIMMONS,  
AND AlAN STONEBRIDGE

AS IF TIM cOOk hadn’t dropped enough hints already, 
further evidence has emerged that Apple will be heavily 
pushing augmented reality technology with the iPhone. 
Steven Milunovich of research group UBS claims that 
“According to some industry sources, the company may 
have over 1,000 engineers working on a project in Israel 
that could be related to AR.”

Given Cook’s recent comments, and that Apple 
has purchased multiple AR firms including Tel Aviv’s 
PrimeSense (focused on 3D sensing tech) and RealFace 
(facial recognition cybersecurity experts), there’s gallons 
of fuel now ready to add to the fire.

Tim Cook has long sung the praises of AR tech. Last 
year, he declared during a US tech conference his belief 
that “A significant portion of the population of 
developed countries, and eventually all countries, 

Will Apple’s rumored plans 
for augmented reality 

come to actual reality? 
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Feed your mind. Feast your eyes.

iPhone 8 tipped 
to ditch lightning
Apple may be about to extend  
USB-C to its smartphone BY EMMA BOYlE

ThE iPhONE 8 may be dropping 

Apple’s Lightning port for USB-C, 

according to a recent report from 

the Wall Street Journal. It states 

that the next iPhone will feature 

a “USB-C port for the power cord 

and other peripheral devices 

instead of the company’s original 

Lightning connector.”

Though this would be a 

surprising move from Apple 

considering it’s never been shy 

about the fact that its devices 

and peripherals have their own 

connection standards, it has  

precedence in Apple’s MacBook 

and MacBook Pro computers.

That said, the report doesn’t 

explicitly state that the USB-C 

port will be on the handset itself. 

It could mean Apple is planning 

to change the connector on its 

power adapters. 

This would mean that rather 

than charging cables and plugs 

with USB-A to Lightning 

connectors, we could see USB-C 

to Lightning – Apple already sells 

cables of this kind.

An alternative scenario has 

been suggested by Ming-Chi Kuo, 

an analyst with KGI Securities, 

whose past predictions have 

been largely accurate. “All three 

iPhones rumored to be launched 

in 2017 will retain Lightning 

connectors with the addition of 

USB-C Power Delivery for faster 

charging,” he said – the three 

phones likely being the iPhone 

7S, 7S Plus and iPhone 8. 

According to the Wall Street 

Journal’s sources, the iPhone 8 

will drop the traditional Home 

button and replace it with a 

touch-sensitive function area 

that would behave something 

like the Touch Bar on the latest 

MacBook Pro. 

The iPhone 8 is also expected 

to feature a curved edge-to-edge 

OLED display similar to those 

seen on Samsung’s Galaxy Edge 

smartphones, while the other 

iPhone models will retain the 

standard LCD displays.

We’ve heard several of these 

rumors already, which helps to 

add weight to the Journal’s 

report – and would mean the 

iPhone 8 is almost certainly the 

most expensive phone to come 

out of Cupertino to date.

will have AR experiences every day, 
almost like eating three meals a day. 
It will become that much a part of 
you,” he added.

 He continued to promote this 
benefit of AR in an interview with 
the Independent online newspaper 
in February, in which he stated his 
preference of AR to VR because it 
“allows individuals to be present in 
the world but hopefully allows an 
improvement on what’s happening 
presently. Most people don’t want to 
lock themselves out from the world 
for a long period of time and today 
you can’t do that because you get 
sick from it.” Cook continued: 
“With AR you can, not be engrossed 
in something, but have it be a part 
of your world, of your conversation. 
That has resonance.”

All this is certainly possible, 
and a recent report from VR/AR 
evangelist Robert Scoble, citing 
sources “at the highest levels,” 
points to the tech giant teaming up 
with optical experts at Carl Zeiss to 
develop augmented reality glasses.

However, Cook closed his 
interview with The Independent on 
a cautious note with regards to any 
product release. “I regard it as a big 
idea like the smartphone. The 
smartphone is for everyone… I think 
AR is that big, it’s huge. I get excited 
because of the things that could be 
done that could improve a lot of 
lives… But there are things to 
discover before that technology is 
good enough for the mainstream.”

Apple already sells 
its own USB-C to 
Lightning cable.
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Feed your mind. Feast your eyes.

Apple hints at 
updated pro Macs

Tim Cook offers assurance 
that his company still has 
creative types on its mind

BY DArren AllAn

The iMac went super-
slim in late 2012, yet 
it still has a thick 
screen bezel.

tiM cook hAs spoken out regarding 
plans to do more with Macs in the 
“pro” market. In a shareholders’ 
meeting at Apple’s headquarters in 
Cupertino, Cook indicated that the 
company hasn’t forgotten about its 
high-end customers. “You will see 
us do more in the pro area,” he said. 
“The pro area is very important to 
us. The creative area is very 
important to us in particular.”

The comment is clearly a general 
one, but was meant to placate those 
who are unimpressed with the lack 
of a refreshed Mac Pro or indeed 
iMac. A new version of the former, 
in particular, has been a long time 
coming: its last update was at the 
end of 2013. 

It’s unsurprising, then, that many 
creative pros are getting impatient. 

The Mac Pro’s 
compact, heat-
dispensing design is 
still impressive, but 
the components 
inside are looking 
long in the tooth.

Cook hinted that things are 
happening behind the scenes, albeit 
somewhat obliquely: “Don’t think 
something we’ve done, or something 
that we’re doing that isn’t visible 
yet, is a signal that our priorities are 
elsewhere,” he added.

Last October’s MacBook Pro 
update muddied the waters even 
further. The Touch Bar was seen as 
gimmicky by some pundits, while 
others weren’t impressed with the 
connectivity options, or the fact that 
16GB remains the maximum amount 
of memory, apparently due to power 
issues. These are the drawbacks of 
creating a thin and light device with 
a large battery capacity; Apple is 
rumored to double memory to 32GB 
and add Intel Core i5 and i7 “Kaby 
Lake” processors later this year.

When asked about the possibility 
of a touchscreen Mac, Cook restated 
Apple’s position that the iPad and 
Mac will remain distinct entities: 
“Expect us to do more and more 
where people will view [the iPad] as 
a laptop replacement, but not a Mac 
replacement – the Mac does so much 
more. To merge these worlds, you 
would lose the simplicity of one, 
and the power of the other.”

>>>Start
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>>> David Chartier is a content strategist and writer with vast experience analyzing the tech world.  

He runs the website Finer Things in Tech (finerthings.in) and hosts its podcast, The Finer Things In.

A
s iOs becomes more 
sophisticated, our apps 
are beginning to disappear. 
I don’t mean that we’re 

downloading fewer apps; on the 
contrary, we’re downloading more 
than ever, and Apple recently 
made its largest quarterly 
developer payout in App Store 
history. But there’s a big shift 
happening in the way we use our 
apps and what they mean to us. 
As our apps become more powerful 
and useful, they’re also fading into 
the background of our day-to-day 
lives, posing both new challenges 
and opportunities for those who 
build them.

Gone are the days when the only 
way to use an app was to tap it on 
your Home screen. Over the last 
few major upgrades to iOS, we’ve 
gained features such as the Today 
view and its widgets, actionable 
push notifications, 3D Touch, the 
Share sheet, and the Apple Watch 
with its companion apps.

Third-party developers have 
also built their own system for 
letting apps talk to and automate 
each other, with tools like Launch 
Center Pro and Workflow (note: 
I’ve done some contract work for 
Workflow in the past). These 
mechanisms all enable features to 
live outside of their apps in various 
capacities, allowing you to do some 

pretty amazing stuff with just 
a couple of taps.

I’ve taken the time to make 
habits out of some of these 
features, and they really do open 
some amazing doors. I can select 
text in a Safari page and, with a 
couple taps, append it to a new 
article I’m writing in Ulysses, 
without ever opening the app. 
I can mark a task as completed 
from a Today widget without 
opening my task app. Email can 
be deleted or archived from a push 
notification without having to read 
the entire message. A content-
blocking app, 1Blocker, works 
invisibly as a plugin for Safari, 
protecting my privacy on the 
internet, while a phone spam 
blocking app, Nomorobo, works 
the same way in the Phone app.

These apps and their key 
features are all tremendously 
useful. But I increasingly go days, 
sometimes weeks, without tapping 
or even looking at the original app. 
It certainly is convenient: I get 
more done in less time and fewer 
taps across myriad apps. But with 
apps more often fading into the 
background, it also means 
developers might need to find 
new ways to make their wares 
sustainable, like replacing one big 
purchase every two to three years 
with small, exceedingly affordable 

subscriptions. Some apps, such as 
photo editor Over, built a live chat 
system right in for feedback and 
support. It’s a great way to foster 
a relationship and build loyalty, 
which subsequently earned my 
subscription to its library of 
content for my client work.

Let’s step back from the details, 
though. In terms of having an 
assortment of pocketable tools 
for helping you accomplish all 
sorts of tasks, this app unbundling 
is starting to feel like the most 
significant evolution in apps 
since the store debuted. As apps 
integrate with iOS and each other 
in deeper ways, they’ll become 
even more indispensable, even 
if you barely ever see them.

With ever increasing communication 
between them, david chartier asks: 
When is an app no longer an app?

>the shift

Widgets 
almost 
remove 
the need 
to use apps 
themselves.
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Feed your mind. Feast your eyes.

A
fter eight years of driving 
a 1998 Toyota Camry, my 
husband finally upgraded 
to a 2017 Dodge Challenger - 

a modern reimagining of the 1970s 
muscle car that he could never 
afford as a teenager. For Frank, 
it’s a chance to go in a straight line 
faster than any human really 
needs to. But for me, it was a 
chance to finally evaluate Apple’s 
CarPlay thoroughly.

CarPlay was announced by 
Apple back in 2013 as a system to 
allow your car to connect to your 
iPhone. Although adoption was 
slow, today all major car 
manufacturers support CarPlay. 
Now that I’ve gotten to extensively 
test it, I can confidently say every 
iPhone owner should consider 

adding CarPlay to their 
vehicle. At the core, 

CarPlay is just 
a reskin 

of iOS for a second screen. The 
interface is simplified for driving, 
trading functionality for safety. 
Many of your apps are inaccessible 
in CarPlay, such as Mail; but ones 
that make sense to use while 
driving, like Maps and Music, do 
appear. Some third-party apps 
are also usable in CarPlay, mainly 

those focussed on audio output, 
such as Audible and MLB At Bat.

When the CarPlay interface is in 
use, the system is a delight. In the 
Challenger, Siri can be accessed by 
holding a steering wheel button, 
giving you the ability to get 
directions or send text messages. 

Playlists from your iPhone are also 
easily accessible with Siri. The 
advantage of CarPlay isn’t just 
gaining access to your phone’s 
maps and music - it also promotes 
safety while driving. 

where the system falls apart is 
with the terrible Dodge software 
that supersedes CarPlay. It’s a UI 
nightmare. Dodge has its own 
(far worse) versions of navigation 
and music that have far more 
prominent buttons. To access 
CarPlay you must plug in your 
phone physically to a USB port, 
then continually choose the last 
option for the CarPlay submenu. 
For people that are less technical, 
CarPlay will probably confuse 
them to the point they’ll ignore it.

The other problem with CarPlay 
is that things frequently don’t 
work as you’d expect in the 
minimal interface. I listen to Anna 
Lunoe’s Hyperhouse show every 

With a new car in the family, Brianna wu 
finally has the chance to discover the pros 
and cons of CarPlay – with mixed results

>game looP

i can confidently say 
every iPhone owner 

should consider adding 
CarPlay to a vehicle

>>>Start
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>>> Brianna Wu is the head of development at Giant Spacekat, developer of Revolution 60 on iPhone and iPad,  

and is a regular speaker at industry events, as well as host on the podcasts Isometric and Rocket.

a word of warning: 
the security on most 

oBD-ii wireless devices 
is nonexistent

my parents didn’t get 
me a tractor, but they 
did get me a piece-of- 
garbage 1987 honda

week on Apple Music, which is two 
hours long. But I can’t scrub through 
this unusually long track by touching 
the screen, as you might expect to be 
able to. Also, CarPlay does support 
wireless connections, but it’s not 
implemented in many cars - 
meaning you’ll probably have to 
plug in your phone. 

Despite these quibbles, CarPlay 
is a must have for an iPhone owner. 
In fact it’s so good, I ordered a 
custom Double-DIN dash for my 
2001 Audi TT roadster so I can install 
a Sony CarPlay receiver. I can’t wait 
to have Siri built into my car, leaving 
my right hand free to shift the 
manual transmission.

i grew uP in Mississippi, where the 
age you could get a driver’s license 
was, unwisely, just 14 years old - the 
reasoning being that your average 
teenager needs to drive tractors on 
the highway for their after-school 
farm job. My parents didn’t get 
me a tractor, but they did get me 
a piece-of-garbage 1987 Honda 
Accord instead.

When the car broke down, my 
parents wouldn’t pay to take it to a 
mechanic - but they would allow me 
to buy any part so I could learn to 
repair it myself. When I look back 
at the reasons I became a software 
engineer, I realize that gaining 
confidence from fixing that 1987 
Accord was a large factor.

All of which brings us to 2017 
and the ways in which the Apple 

ecosystem can help with car 
maintenance, too. While cars with 
onboard computers in the early ’90s 
could give you error codes from 
sensors, these were very expensive 
systems that were proprietary to 
each auto manufacturer. After a 
California lawsuit, the OBD-II port 
became a standard for every car sold. 
Today, these systems are so easily 
integrated with your iPhone, 
there’s no reason not to pick one up. 

On Amazon, you can pick up any 
number of OBD-II Bluetooth and 
Wi-Fi devices. I got mine from 
Foseal for just $20, which broadcasts 
its own Wi-Fi network that you 

connect your Mac or iPhone to. 
Regulations require your car’s 
OBD-II port to be easily user 
accessible, meaning you can quickly 
plug in a device and get diagnostic 
information on your phone.

Here, I used the $10 iPhone app 
OBD Fusion to find out why my 2001 
Audi TT was telling me “Service 
Required.” The engine was misfiring, 
and the heater circuit was producing 
errors. A quick inspection of the 
engine showed that the wiring 
around the coil pack had started to 
fray. By giving me this complete 
information, I could see that a repair 
my mechanic originally quoted at 
$1,600 could also be done with just 
a $20 harness repair.

 
a worD of warning however: the 
security on most OBD-II wireless 
devices is nonexistent. Mine 
connects with no security through 
a default IP address. Though it’s 
tempting to leave it plugged in all 
the time to get real-time engine 
stats on your iPhone, it leaves your 
car extremely susceptible to hacking. 
If you want real-time data, go with 
a plugin solution.

In 2017, our iPhones are the 
centerpiece of our lives, so it makes 
sense that they should be the 
centerpiece of our cars as well. 
Hopefully, Apple will continue to 
refine CarPlay as aggressively as it 
has refined iOS. CarPlay is off to a 
great start, but the quirks keep it 
just short of “It just works.” 

Being able to diagnose car faults on your 
iPhone can potentially save you money. 

 maclife.com  spring 2017   15



Feed your mind. Feast your eyes.

The iKlip Grip Pro stand is versatile enough for most times when a tripod is needed.

6 accessories to enhance  
your iPhone photography

Take more interesting shots with these affordable add-ons 
BY alan stoneBridge

now that we’re well into daylight 
saving time, you’ve got more hours 
in the evening to enjoy outdoors. 
Much of the time you’ll have your 
iPhone with you, so why not take 
the opportunity to spend the lighter 
nights using it to improve your 
photography skills?

If you’re already feeling confident 
about using a camera app, whether 
Apple’s or a more powerful third- 
party alternative, you can grow your 
talent by adding accessories to your 
iPhone to take shots that aren’t 
possible with the phone alone.
Whether it’s better selfies or 
sweeping vistas that you want, you 
don’t have to haul around a DSLR 
camera and bulky and heavy lenses 
to wow your friends.

Shed some light 
with the Lumimuse.

studio neat glif 

The latest model 

of this smartphone 

tripod mount 

($28) finally adds 

a quick-release 

lever, so you can 

quickly switch 

between taking 

handheld and 

stabilized shots. 

iK Multimedia 

iKlip grip Pro

Alternatively, try 

this convertible 

stand ($60). It can 

work as a tabletop 

tripod, a handgrip 

for steady video 

recording, a selfie 

stick, or you can 

detach the tripod 

mount to attach to 

a full-size tripod.

Manfrotto 

lumimuse 

Better illuminate 

portrait photos 

with a 3, 6, or 8 

LED. Lumimuse 

features a quarter-

inch thread for 

use with a tripod.

Joby griptight 

Pro Phone

Deformable legs 

enable this stand 

to be attached in 

all sorts of places. 

It even fits your 

iPhone in a case.

hisY Bluetooth 

Camera remote

This $25 remote is 

helpful for taking 

selfies or group 

shots that include 

you, or to keep a 

tripod-mounted 

iPhone steady at 

dusk. (You can use 

an Apple Watch 

for this, too.)

olloclip active 

lens set

The 2x telephoto 

and ultrawide 

lenses in this $100 

set broaden your 

compositional 

choices, and its 

mount enables 

each to be used 

with your iPhone’s 

front- or rear-

facing cameras. 

You can buy other 

lenses separately.

The HISY Bluetooth remote: shoot yourself.

>>>Start
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The premier source for everything video games, TV, films, and more.

www.gamesradar.com



Ehang 184
ehang.com
From $170,000–245,000

>>> A person-carrying drone! The Ehang 184 is 

designed with short transport routes in mind; 

it can only fit one person, with a bit of luggage, 

and while it can only fly for 23 minutes (after 

a two-hour charge time), it can reach a top 

speed of 60 mph. It’s intended to fly at altitudes 

around 1,000 ft, but rumors suggest it can 

reach the heady heights of nearly 11,500 ft. The 

passenger can’t “pilot” the craft, only take off 

and land – which means, theoretically, owners 

won’t even need to hold a license, although we 

suspect it won’t be quite that simple…

>>>Start Feed your mind. Feast your eyes.

THE GEAR WE’RE LUSTING AFTER

CRAVE

18   Spring 2017  maclife.com



Polaroid Pop
polaroid.com
Around $200

>>> This 3x4-inch instant camera snaps your photos 

digitally and spits out Polaroid-style prints at the 

same time. The device boasts a 20MP camera, 

image stabilization, and a 3.97-inch LCD 

touchscreen. It uses Zink (Zero Ink technology) so 

don’t expect prints of the highest quality – but for 

quick photo sharing with friends, the new Polaroid 

Pop is perfect. You can add fun filters and stickers 

on the spot, and it can also record 1080p video. 

It’s due out before the end of 2017, and while it 

might seem spendy for small prints, can you really 

put a price on iconic and instant? (Yes.)

PowerVision PowerRay
powervision.me
Around $2,000

>>> Fishing can be so relaxing – but also very 

competitive. Why not up your game with a little 

smart-gadget assistance? The PowerRay Fishfinder 

floats in the water and relays detailed information 

to its mobile app. You get data on fish distribution, 

temperatures, and underwater terrain – plus 4K 

UHD footage, so you can watch what’s happening 

under the surface. The PowerRay can reach depths 

of up to 98 ft, but there’s an add-on Fishfinder 

sonar system that can detect fish up to 131 ft below.

LG PJ9
lg.com
$TBC

>>> This little Bluetooth speaker floats on a base, 

known as a Levitation Station, thanks to a set of 

electromagnets, gently rotating while it pumps 

out tunes, with the base containing a powerful 

subwoofer for extra-beefy bass. The airborne device 

offers 360-degree sound and up to 10 hours of 

battery life – it’s even waterproof so you can take 

it outside and show the world your mastery of 

physical laws. The speaker descends back into its 

base to recharge when it runs out of juice. And just 

why would you want a floating speaker? Why not.
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Craig grannell reveals tools and shortcuts that 
help you get full value from the free apps Apple 
bundles with every Mac

Y
ou would find it difficult 
not to notice Apple’s 
fondness for minimalism. 
After all, it’s not like the 

iPhone is awash with ports and 
buttons, and if the new MacBook 
Pro is anything to go by, all Macs 
will soon be fitted out with only 
USB-C and headphone ports, 
making it rather tricky to plug 
something into the wrong bit.

In software, it’s a mite tougher 
to pare things down quite so much; 
you must strike a balance between 
making an app accessible and 
ensuring that it remains intuitive 
and capable. For the most part, 
Apple succeeds, but it does 
sometimes exhibit a tendency 
to bury important features and 
interesting settings in places 
where not everyone would 
consider looking for them.

This feature is about all these 
things. We’ll explore the software 
you get for free with every Mac, 
and frequently delve into new 
features introduced in Sierra, as 
well as long-standing ones that 
are little-used. The idea is that in 
spending a short while flicking 
through these pages, you’ll come 
out the other side armed with new 
skills to make working with your 
Mac faster and more efficient.

Note that for the most part, 
none of our advice in this feature 
is especially complex. These tips 
neither require you to put on your 
“advanced Mac-head” cap, nor 
first read a weighty tome on how 
to use the Mac. Instead, this is 
about highlighting useful features, 
options, settings and controls that 
might have passed you by – but 
that with a flick of a virtual switch 
could prove transformative to how 
you use your Mac.

95 incredible app secrets
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1
View the sidebar

You can browse your 

library with or without a sidebar; 

without it, views and playlists are 

accessed through the arrow next 

to Library in the navigation bar. 

To toggle the sidebar, choose 

View > Show/Hide Sidebar.

4
edit coVer art

If album art is missing, sign 

in to the iTunes Store, ≈-click 

the album and choose Get Album 

Art. If that fails, pick Get Info 

instead, click Edit Items, and drag 

art from an online search into 

the Artwork tab.

2
switch media type

This menu enables you to 

switch between types of media, 

or you can press ç+1 through 

9. You can edit its contents: 

pick Edit Menu from it and leave 

check marks next to only those 

items you want to be visible.

5
smart playlists

If you have a lot of music, 

pick File > New > Smart Playlist. 

Set one rule to “Last played not 

in the last 30 days” and then set 

playback to shuffle. Voila, an 

instant jukebox with no recently 

played tracks!

3
see the status bar

The Status Bar is hidden 

by default, but you can make it 

visible with View > Status Bar. 

It shows the current view or 

selection in terms of storage size 

taken up, duration of running 

time, and an item count.

6
use the miniplayer

Turn iTunes’ window into 

the MiniPlayer by clicking the 

album artwork in the status area, 

or press ß+ç+m. In iTunes > 

Preferences > Advanced you’ll 

find an option to keep it on top 

of other windows.

16 tremendous iTunes tips
Delve deeper into Apple’s famous digital jukebox to tame  
its interface and tweak the way it presents your music

1

2

5

4

3

6

>>>Feature
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how to Take control of viewing your music

> Tricks for a tip-top listening experience

1 View only recently  
added music

Select Recently Added in the sidebar to 

see music, including store purchases and 

Apple Music items added to your own 

library, in reverse chronological order.  

To see what you can play while offline, 

choose View > Only Downloaded Music.

2 The column browser
Select Songs in the sidebar, then 

choose View > Column Browser > Show 

Column Browser (or press ç+B) to 

restore the classic interface (from very 

old versions of iTunes) for filtering your 

collection by genre, artist and then 

album from left to right in the window. 

3 Change view options
Choosing View > View Options 

often provides a number of settings that 

enable you to further tweak how your 

music is presented in the current view. 

For example, when using the column 

browser, you can turn on album art and 

pick the visible columns.

consider quality

Most of us will find the 256Kbps 

AAC music files created by 

importing a CD into iTunes are 

good enough quality. For the 

greatest flexibility in future – in 

case more efficient compression 

tech arrives – consider switching 

from the default AAC encoder to 

Apple Lossless. To do so, click 

Import Settings in iTunes’ 

General prefs.

The drawback is Apple Lossless 

files use more space than AAC, 

which might quickly use up your 

Mac’s storage. One fix is to use 

File > Library > Consolidate Files  

to put your music on an external 

drive and manually clean out the 

originals later on. You’ll find a 

detailed overview of what this 

involves at apple.co/2lpHbsL.

1 bring back star ratings

Simply put a check mark next to 
Star Ratings in iTunes’ General 
preferences to restore them. 

2 check your sound quality

If you find playback sounds flat or 
odd, check that Sound Enhancer 
and Sound Check under Playback in 
iTunes’ preferences aren’t the cause. 
Also, try a different preset in 
Window > Equalizer.

3 check your ios apps’ size

Switch to Apps from the media 
selector, then click Library to the 

right. If you download iOS apps to 
your Mac, they may use lots of space. 
If you’re low on storage, ≈-click an 
app, view it in Finder, and back up 
the entire folder. Then in iTunes, 
select the largest apps, press ç+∫ 
and pick Move to Trash.

4 refresh the itunes store

The iTunes Store will sometimes 
show a blank page or just stop 
working. When this happens, 
press ç+R to reload it. 

4 back up your ios deVices

Now and again, connect your iPhone  
or iPad to your Mac, select it at the 
top left, click Summary in the 
sidebar, and then click Back Up Now.  

5 use file sharing

With an iOS device selected, pick 
Apps in the sidebar and scroll down 
to File Sharing; it lists apps that can 
transfer files to and from your Mac.
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1
use pinch gestures

You could drag the resize 

slider on the toolbar, but it’s 

much more pleasing, if your Mac 

has a trackpad, to pinch to zoom. 

Pinch gestures also open or 

close the image that’s currently 

under the pointer.

4
browse faster

With a photo from an 

album or the timeline open, 

swipe left or right on a trackpad 

or Magic Mouse to view adjacent 

images. To browse faster, click 

Show Thumbnails, put the 

pointer over them, then swipe.

2
edit your photos

After opening a photo, 

a button with three slider 

controls appears in the toolbar; 

it takes you to editing mode. 

Alternatively, press ® with a 

photo open, or selected in an 

album, to go straight to editing it.

5
use the sidebar

Photos has five large 

buttons across its toolbar for its 

major sections. Choosing View > 

Show Sidebar switches to an 

alternative means of navigating 

that’s more efficient if you have 

many albums.

3
get info

Press ç+I to bring up 

the contextual Info window. With 

one image selected, it shows 

camera info and settings. For an 

album or a multiple selection, 

it summarizes dates, places, 

keywords and more.

6
choose a key photo

When you create a new 

album from several photos, the 

app assigns a representative 

thumbnail. If you’re unhappy 

with its choice, open the album, 

≈-click an image, and choose 

Make Key Photo.

16 fantastic features of Photos
Make fast work of browsing and editing your digital  
photo collection using Apple’s Photos app

1

2

5

4

3

6
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how to Clear screenshots out of your library

> Master the finer points of Photos

1 Find screenshots
If you take screenshots on iOS, 

they’ll end up in iCloud Photo Library and 

on all connected devices. You can view 

them in the Screenshots album in Photos. 

Sadly, there’s no way to stop them from 

showing up elsewhere in your library.

2 select and delete
Hold ç and click screenshots 

you no longer want, then ≈-click one, 

choose Delete, and click the Delete 

button on the confirmation dialog. Made 

a mistake or changed your mind? Shots 

can be recovered within 40 days.

3 save keepers
Go to the Recently Deleted album 

and select those images you want back, 

then click Recover. Or, hold Alt and drag 

them to Finder to save them outside of 

Photos; this copies them as PNG files, 

rather than compressed JPEGs.

icloud & photos

It’s important to know about the 

differences between options 

found in the iCloud tab of 

Photos’ prefs. My Photo Stream 

is for accessing recent photos on 

devices not using iCloud Photo 

Library; it contains images from 

the last 30 days, and it costs 

nothing. iCloud Photo Sharing 

is also free, and is for sharing 

select images with other people.

iCloud Photo Library stores 

full-quality originals of all your 

photos online. This can quickly 

use up the storage in your iCloud 

account, though; to get more, 

click Manage in System 

Preferences > iCloud. Your 

devices can be set to download 

either the originals or versions 

optimized for their screen. 

1 add adjustments

When editing a photo, the Adjust 
tool initially provides three options: 
Light, Color, and Black & White. For 
more, click Add and choose one; 
click Save as Default to use your 
chosen adjustments in future.

2 View fine details

Adjustments are first presented as a 
single bar that you can drag across to 
change the effect’s strength. Put the 
pointer over the bar and click the 
downwards-facing arrow that 
appears to reveal more settings.

3 search with smarts

The Sierra version of Photos now 
enables you to search for places, 
people, and even objects; try 
searching for “tree” or “food.”

4 reduce motion

Sierra introduced accessibility 
settings that reduce motion in the 
system and apps. Photos has its own 
item in its General preferences, 
which removes the animation that 
plays when you change sections by 
clicking the buttons in its toolbar.

5 saVe some memories

The Memories section essentially 
shows automatically generated 
albums. Scroll to the bottom of a 
memory to add it to your favorites, 
which appear in the Albums section.

6 share your photos

Select some photos, click the Share 
button, and then pick iCloud Photo 
Sharing. You can invite other people 
to subscribe to a shared album. 
While viewing one of your shared 
albums, click the toolbar’s People 
button to set whether others can 
post, toggle notifications, and more.

 maclife.com  spring 2017   25

95 incredible app secrets



1
pin faVorite sites

You can pin tabs for sites 

you use often so that they’re 

immediately accessible in any 

Safari window that has the tab 

bar visible. Either ≈-click on a 

tab and choose Pin Tab, or drag 

a tab to the far left of the bar.

4
show all tabs

When you click this button 

you’ll get a visual overview of the 

tabs open in the same Safari 

window, and also a list of tabs 

open on your other devices 

which are signed into the same 

iCloud account.

2
the faVorites bar

Choose View > Favorites 

Bar, then visit a site, click in the 

address bar and drag the site’s 

icon to the bar to pin a shortcut 

there. In Safari‘s General prefs, 

new tabs can be set to show your 

favorites, which appear as icons.

5
quieten noisy tabs

If a tab is playing sound, 

you can mute it by clicking the 

speaker icon on that tab, or the 

one in the address bar. If the 

latter is shown as an outline 

rather than solid, clicking it will 

mute all tabs.

3
share web pages

Click the Share button and 

you can add the current page to 

your reading list for later perusal 

(access this list in Safari by 

pressing ≈+ç+2), add it to 

your bookmarks, or send it to a 

number of other services.

6
strip away clutter

On a page with lots of 

body text, click the paragraph 

icon at the address bar’s left end 

to switch to Reader and see only 

the vital text and images. Click 

‘aA’ at the bar’s other end to 

adjust presentation.

16 surfing shortcuts in Safari
Make Apple’s web browser work the way you want it to,  
and tame the worst tendencies of websites

1

2

5

436
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how to Access mobile content on your Mac

> Advanced tips to help you browse better

1 Turn on a menu
In Safari’s Advanced preferences, 

turn on the Develop menu. It’s primarily 

designed for web developers, but its 

Open Page With submenu is useful for 

opening the current page in another 

browser if it doesn’t work well in Safari.

2 Change user agent
Some websites bizarrely still insist 

on Flash for video. Others present a more 

cluttered desktop version than they do 

on mobile devices. When you find this 

happens, try choosing “iPad” under User 

Agent in the Develop menu.

3 switch back
The mobile site might look 

different, but should still be usable. You 

can change back by selecting Default 

from the User Agent submenu. If you use 

an option often, set up a shortcut for it in 

System Preferences’ Keyboard pane.

search smart

Safari’s Search preferences 

present several search engines 

to choose from, not just Google; 

DuckDuckGo is increasingly 

popular, for instance.

If Include Safari Suggestions 

is enabled, you’ll get results for 

basic queries in the search bar: 

start typing “weather” and you’ll 

likely get a local forecast before 

you finish. Enter your favorite 

football team’s name to see its 

last result. 

You can even submit terms 

straight to a website’s search 

engine. To train Safari, visit a site 

and use its search engine; next 

time you start typing the site’s 

address, use † to complete it, 

then add terms and press ® to 

go to the site’s search results.

1 use mission control

Hold ≈ and tap the Mission Control 
key on your keyboard to see an 
overview of all Safari windows.

2 show full site addresses

By default, Safari shows a site’s 
domain (such as apple.com) but not 
the full address of the page you’re 
on (say, apple.com/mac). You can 
change this in its Advanced prefs by 
putting a check mark next to “Show 
full website address.”

3 tame notifications

Some websites will ask for your 
permission to show alerts in 
Notification Center. If you 
accidentally grant permission, go to 
Notifications in Safari’s preferences 
and click Deny next to the site name.

4 manage downloads

In Safari’s General preferences there 
are options that govern downloads; 

you can alter the folder where 
they’re stored, tell Safari to remove 
items from its download list after 
a specific action, and auto-open 
“safe” files, such as Zip archives.

5 access passwords

If you allow Safari to save passwords 
for websites, they can be reviewed in 
the Passwords tab of its preferences. 
Enter your user account’s password 
(or use Touch ID) and you can click a 
password to temporarily reveal it.

6 control tabs

In Safari’s Tabs prefs, you can alter 
behaviors such as whether clicking a 
link opens it in a new tab or window.
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1
collaborate!

Pages, Numbers and 

Keynote enable working on docs 

with other people at the same 

time. Click Collaborate on the 

toolbar to invite people to work 

on your doc using the Mac, iOS 

or iCloud.com apps.

3
remoVe background

Add an image, click the 

Format button in the toolbar 

and click Instant Alpha. Click and 

drag on an area of the image to 

make that color, and similar 

ones, transparent. The effect 

is applied contiguously.

4
rename text styles

You can assign your own 

style names to tell them apart 

more easily. Click the style 

selector in the Format sidebar, 

move the pointer over a style’s 

name, click the arrow to its right 

and choose Rename Style.

2
access word count

To keep an eye on how 

wordy a Pages document has 

become, choose View > Show 

Word Count. Move the pointer 

over the counter and a pop-up 

indicator appears; click it to 

change the unit that’s used. 

You can drag the counter 

anywhere over your doc.

how to Copy content between iWork apps

1 Copy/paste images
Try this example. In Keynote, 

make a doc based on the Showroom 

template. Add a slide with a bike image 

on it, then select the bike and copy it to 

the Clipboard. Over in Pages, make a 

blank doc and paste the bike into it.

2 Move a chart
The iWork apps can move about 

more than just images. In Numbers, 

create a new doc using the Charting 

Basics template. Select one of the charts, 

copy it to the Clipboard, and then paste it 

into your Pages document.

3 Edit the chart
The chart isn’t a static image – 

you can still edit it. Click the chart and 

then click the Edit Chart Data control 

that appears next to it. A new window 

then appears, in which you can adjust 

data and add new rows.

7 Pages, Keynote & Numbers tips
The apps formerly known as iWork mesh well together, and are  
packed with plenty of great features for you to learn

12

4

3
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do more with 

contacts

Contacts has a lot going 

for it. In its Template 

preferences, define the 

default information you 

consider important when 

creating a new contact. 

Also, when editing existing 

contacts, you can drag in a 

photo that’ll then show up 

in other apps.

Use the note section in 

contact cards to add simple 

keywords, such as “family.” 

Choose File > New Smart 

Group and set a condition 

for “Card contains” followed 

by your keyword. That group 

can then be used in Mail; to 

aid autocompletion in Mail’s 

To field, prefix the group’s 

name in Contacts with a 

symbol, such as $.

5 Calendar and Contacts hints
Ensure you’re always on time and that you never forget  
a face with the Mac’s built-in personal organizers

1
View the sidebar

Click the Calendars 

button to open the Calendar List 

sidebar. Use the checkboxes to 

show or hide events by calendar. 

There’s a smaller calendar to 

help with looking up dates; drag 

up on the line above it for more.

3
fast detail entry

Drag over the calendar 

to set an event’s duration over 

hours or days, then enter details. 

Or, more quickly, click the + 

button and use plain English, 

such as “Lunch with Tatyana 

on Friday from 12 to 2.”

2
fine-tune calendar

In Calendar’s General 

preferences, weekends can be 

omitted from Week view by 

setting “Days per week” to 5. 

“Scroll in week view by” sets the 

arrows around the Today button 

to advance by a week or a day.

4
time to leaVe

Double-click an event to 

edit it, click the time and date 

row, and set a “Time to Leave” 

alert to be notified based on 

your and the event’s locations, 

live transit conditions, and View 

> Directions in the Maps app.

1

2
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how to Fine-tune your iBooks experience

1
use icloud

When first used, iBooks 

asks if you want to use iCloud. 

If you do, items you add to your 

library will be synced across your 

devices that use the same 

account. To activate it later, turn 

on iBooks in iCloud > iCloud Drive 

in System Prefs on your Macs 

and Settings on iOS devices.

3
sort and View more

By default, iBooks puts 

recent additions at the top left, 

which you can change in View > 

Sort By. Books are represented 

by a thumbnail image; View > 

Show Title & Author adds those 

details under the book covers.

4
create collections

Click Collections and you 

may see iBooks has sorted your 

documents into Books and PDFs. 

To make a new collection, select 

some items, ≈-click one, choose 

New Collection from Selection, 

and name it in the sidebar. 

2
don’t use icloud

Yes, we know what we just 

said, but if you keep your books 

only on one Mac, you can use 

the app purely as a reader for 

eBooks and PDFs – the latter 

open in Preview. (If your iCloud 

account has plenty of free 

storage, you might leave iCloud 

on anyway.)

1 go full(ish) screen
If any app naturally suits full-

screen mode, it’s iBooks. However, if 

you want the clock visible while reading, 

å-click the Zoom button (the green one) 

to make the window fill the rest of the 

display for a better experience.

2 Change the theme
If you can’t read a book‘s text 

comfortably, click the appearance button 

(AA) to adjust size, font, and page and 

text colors. For a faster way to adjust the 

text size multiple times in succession, 

press ç+= or ç+-.

3 Take things further
Unsure about a word’s meaning? 

Double-click it for its definition. Want to 

scribble down some thoughts? Highlight 

a block of text then choose a color, and 

add a note; click the note icon near the 

top left of iBooks to view your notes.

7 iBooks insights
Oddly enough, Apple’s book-reading app isn’t just for reading – 
you can also use it to collect and comment on books

1

2

4

3
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3

arrange pdfs

Preview can merge PDFs and 

manage pages pretty easily.  

To delete a page, the 

simplest way is to use the 

sidebar’s Contact Sheet 

view, select the page, press 

∫ and then save the file.

To merge pages from one 

PDF into another, open both 

and have their windows side 

by side and in Contact Sheet 

view. In one window, select 

the pages you want to move,  

drag them into place in the 

other document’s window, 

and then save that second 

document. Alternatively, if 

you want to merge an entire 

PDF into another, open one, 

drag the second file from 

Finder into the Contact 

Sheet view, and then save 

the combined document.

5 power tools in Preview
Open a PDF? Sure. But with Preview you can do far more, 
from automated slideshows to scribbling all over a document

1
sidebar speediness

Choose View > Show 

Sidebar to see a pane of page 

thumbnails for your document. 

That menu also contains options 

to switch to a table of contents, 

highlights and notes, bookmarks, 

or a contact sheet of thumbnails.

3
add highlights

For basic edits to a PDF, 

use the Highlight button in the 

toolbar. Select some text, click 

the button’s downward arrow, 

and choose a color – or use 

strikethrough to flag something 

for deletion. Remember to save!

2
change your View

Preview uses a continuous 

scrolling view of single pages by 

default. If you’ve opened a comic 

or magazine, View > Two Pages is 

better for a wide screen. Feel like 

reading slowly in an automated 

fashion? Try View > Slideshow.

4
make major edits

You can’t directly make 

more drastic changes in Preview, 

but you can pick View > Show 

Markup Toolbar and use its tools 

to add shapes, free-form 

sketches, sticky notes, text 

boxes, and signatures.
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1
explore Views

Each view has its own 

advantages: Map makes roads 

more visible; Transit shows public 

transport routes; and Satellite 

shows overhead photos and a 

pseudo-3D view in some cities. In 

the Map and Satellite views, View 

> Show Traffic shows congestion.

3
share searches

Using the Share sheet, you 

can send your current selection 

to apps and other services, or to 

iOS. Choose Send to iPhone and 

you’ll receive a notification on 

that device; tap it and Maps will 

open with the same search.

4
export directions

Choose File > Export as 

PDF and your current search will 

be exported as a printable 

document. This is handy for 

sharing with someone who lacks 

a computer or mobile device, or 

to get written directions.

2
find nearby points 

of interest

Click in the search field to see 

your recent searches for places 

and directions. If your Mac has a 

Touch Bar, it will show shortcuts 

to food and drink, local stores, 

and entertainment. Or just type 

a general description of what 

you want to find, such as 

“Chinese food.”

how to Look up and share directions

1 set things up
Choose View > Show Scale, and 

use the Labels and Distances submenus 

to fine-tune the map’s appearance. Next, 

click Directions; in the sidebar that 

opens, type a location (or “My Location”) 

in the Start field.

2 Build a journey
Enter your destination in the End 

field, and use the buttons below to 

request driving, walking, or public 

transport directions; driving may show 

multiple routes with durations. Pick View 

> Show Traffic to see jams.

3 Use public transit
Transit provides directions for 

public transportation; in its Leave pop-up 

menu, set the time and day you want to 

leave or arrive. Click Details next to a 

route below to view its steps, then send 

it to your iPhone or export it as a PDF.

7 maneuvers in Maps
Find your way around the world and unearth  
nearby points of interest with this informative tool

1

2

4
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refresh reminders

At its core, Reminders is 

an app for making digital 

checklists. The app can 

boost your productivity and 

efficiency in several ways. 

Put the pointer over an  

item, click the info button, 

and you can turn the item 

into a time- or location-

based reminder. So if a task 

is time-sensitive, Reminders 

can give you a gentle nudge 

on your iCloud-connected 

Macs, iOS devices and even 

Apple Watch.

Lists can also be shared 

with people: Set up a list, 

put the pointer over it in 

the sidebar and click its 

broadcast icon. To stop 

sharing with someone, 

select them under Shared 

With and press ∫. 

5 Notes and Reminders niceties
Never lose nuggets of genius on scraps of paper again –  
instead, store them safely in these two apps

1
format your notes

Click the format menu (Aa) 

to give notes titles and headings. 

In Notes’ preferences, you can 

set the first line of new notes to 

be a title or heading. Be mindful 

that the first two lines are shown 

in the sidebar. 

3
temporary lists

Click the checklist button 

(or press ß+ç+l) to turn the 

current or selected lines into 

a checklist. Click an item’s circle 

to mark it as done, or move the 

insertion point to the item’s row 

and press ß+ç+u.

2
work with 

attachments

Maps’ and Safari’s Share buttons 

can add content to Notes as a 

visual preview; click one of those 

previews to reopen its location or 

page. In Notes, use this button 

to browse all such attachments.

4
share notes

Click the Share button to 

send the current note to the likes 

of Mail or Facebook. If a note is 

stored in iCloud, not just on your 

Mac (check in the sidebar), click 

the Add People button to invite 

someone else to collaborate.

12 4
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how to Use the Favorites bar

1
filter out junk

In Mail > Preferences, 

click the Junk Mail tab and turn 

on filtering. You can define how 

the app processes junk 

messages, and you can exempt 

certain messages to avoid false 

attribution. Enabling filtering 

adds a Junk mailbox in the 

Mailbox List sidebar, as well.

3
saVe attachments

Open a message and put 

the pointer over the separating 

line between its body and the 

sender’s info above it to reveal 

some icons; click the paper clip 

button to save, open or preview 

the message’s attachments.

4
set up Vips

Click a contact’s name at 

the top of a message and choose 

Add to VIPs; their messages then 

also appear in the VIPs mailbox. 

Set “New message notifications” 

in Mail’s General prefs to VIPs to 

filter out other interruptions.

2
sort and filter

Messages are usually 

sorted in reverse chronological 

order; click the “Sort by” menu 

at the top left of the list to 

change this. Alternatively, click 

the filter button (top right), then 

the filter’s description left of that 

to see only messages from VIPs, 

for example.

1 set up favorites
Choose View > Show Favorites Bar 

to make the bar visible. It initially 

includes Inbox, Sent, and VIPs (if you’ve 

identified any contacts as such). The bar 

provides quick access to these mailboxes, 

even when the mailbox list is hidden.

2 Add new favorites
You can drag any mailbox from 

the mailbox list to the Favorites bar – 

even Smart Mailboxes. If you drag a 

mailbox that contains nested mailboxes, 

clicking it in the Favorites bar reveals a 

list of them from which to choose.

3 File messages
Press ≈+ç and a number key  

to move the selected message to the 

mailbox in the matching position (1 to 9, 

left to right) on the Favorites bar; if that 

mailbox has others inside it, the email’s 

put in the most recently selected one.

7 Mail management tips
Who wants to spend more time emailing? Not us. 
Use these tips to speed up your time in Mail

1

2
4

3
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And the rest…
Top tips for four more apps that can save you  
time and help you to be more productive

textedit

Apple’s text editor may seem 
basic, but it’s surprisingly 
feature-rich. Do you want to 
format to a specific page size? 
Choose Format > Wrap to Page, 
and then pick a paper size in File 
> Page Setup. Need to export to 
a PDF file? Easy: choose File > 
Export as PDF.

It’s well worth visiting the 
app’s preferences, too. In the 
Open and Save tab, you can 
dictate how web pages open; by 
default, drag an HTML file onto 
TextEdit’s icon and it’ll open as 
formatted text rather than code 
– handy for quickly copying and 
pasting content. Change the 
HTML setting in the top group 
to see the actual code making up 
the web pages, if that’s what you 
actually want.

In the New Document tab, 
the Format section dictates the 
default format for TextEdit itself: 
rich text or plain text. When 
you’re editing a file, you can 
subsequently switch between 
these from the Format menu.

calculator

Calculator has hidden powers 
lurking within it. There are two 
alternative views: click the green 
Zoom button or press ç+2 to 
enter Scientific mode. ç+3 
opens Programmer mode, and 
ç+1 returns to the default.

You can also use Calculator 
for conversions. To do so, first 
select a measurement type from 
the Convert menu, then pick the 
units you want to use. Previous 
conversions are kept in Convert > 
Recent Conversions; you can 
assign a keyboard shortcut to any 
of those in System Preferences > 
Keyboard > Shortcuts > App 
Shortcuts. Be mindful, though, 
as only the last 20 conversion 
types are stored. 

stickies

The Stickies app can be a useful 
way of placing a temporary 
reminder on your display without 
getting it gunky from the glue of 
a real sticky note. Text in your 
sticky notes can be styled, such 
as using big fonts to draw 

attention, and notes can be 
collapsed/expanded by pressing 
ç+m. Collapsed notes show 
their first line of text, so make 
sure that’s informative.

If you have lots of notes, you 
can quickly organize and collapse 
them by choosing Window > 
Arrange. Also, use the Note 
menu’s options to fine-tune 
reminders you keep open on your 
screen – you can have sticky 
notes float over other windows, 
and make them semi-
transparent so other content 
isn’t entirely blocked. Use the 
Color menu’s yellow and gray 
options for best results.

time machine

Every Mac user should use 

Time Machine to keep their 

data safe. Though Time 

Machine is straightforward 

to use, you can do more with 

it than plugging in a drive 

and clicking OK to back up.

The Options button in 

Time Machine’s preferences 

gives you a way to define 

exclusions (if, say, you 

don’t want stuff like your 

Downloads folder to be 

backed up). Your external 

drives may appear in the list; 

remove them if you want 

changes to files stored on 

them to be backed up. Want 

rid of all backups of a file? 

Choose Enter Time Machine 

from its menu bar icon, 

browse to the file, ≈-click it, 

and pick Delete All Backups.
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BEGINNER’S 
guide to 

HOMEKIT

he idea of “the 
connected home” 
has been bandied 
about for a few 
years now, usually 

as though it’s some sort of 
upcoming innovation.

However, the truth is that 
you can create your own 
smart home, complete with 
automated actions and 
intelligent sensoring, right 
now. All you need is an 
iPhone or iPad running iOS 
10, which includes Apple’s 
HomeKit – a system designed 

to interact with compatible 
smart accessories. These  
can range from multicolor 
LED lights and smart plugs  
to weather sensors, smoke 
alarms, locks, and even 
ceiling fans.

Such products aren’t 
massively expensive and 
usually don’t require any 
complicated installation. 
So in the next few pages, 
we’ll look at some of the  
best HomeKit stuff available, 
and explain how to get 
started with setting it up.

You don’t need to be an MIT graduate or a 
millionaire to have a smart home… J.R. Bookwalter 

shows you how to get started

T
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2 PHIlIPS Hue 
tap SwitcH
$49.99

By adding an optional Hue 

Bridge, this combined switch 

and remote control can 

control up to 50 lights and 

10 accessories with no wires 

or batteries necessary, 

thanks to the wonders of 

kinetic energy. It’s a great 

way to control all your 

Philips Hue bulbs from 

anywhere at home using 

four configurable buttons.

lIGHTING

3 luTRON caSéta Smart 
LigHting dimmer Kit
$189.95–255.00

When individual products 

alone simply won’t do, here’s 

a complete bundle that 

includes a Wireless Smart 

Bridge, a pair of in-wall 

dimmers with Pico remote 

controls, matching wall 

plates, and tabletop 

pedestals for one reasonable 

price. This one’s easy to set 

up, but the Smart Bridge 

requires an Ethernet port.

PHIlIPS Hue go
$79.99

With more than 16 million colors to choose from, your home 

lighting need never be boring again. Although not the cheapest 

option around, this multicolor LED is portable, easy to use, and 

features a built-in timer for switching on or off automatically. 

Its brightness and color temperature are also adjustable.

ElGaTO eve LigHt SwitcH
$49.95

HomeKit-enabled light bulbs are one thing, but 

nothing beats the tactile feel of a wall switch 

connected to your smart home. This replaces an 

existing switch and allows you to use any existing 

bulb in a single or multi-light setup, switching lights 

on or off from the wall, Siri, or by tapping your 

iPhone; it’s especially great for families with kids.

1

4
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1

auGuST Smart LocK – Second generation
$299.95

Keyless home entry with a stylish design is no longer a 

dream. This second-generation model enables iPhone 

owners to lock or unlock whatever door in which it’s 

installed, provide customizable access to others, and keep 

an activity log. It’s also available in a range of colors to fit 

almost any décor.

ElGaTO eve motion
$49.95

Wouldn’t it be nice to 

walk in the front door 

and be greeted by a 

home that’s just the 

right mood or 

ambience? This wireless 

motion sensor makes it 

possible, but works 

equally well for being 

alerted to the presence 

of intruders. Eve Motion 

features a passive 

infrared sensor with a 

30-foot reach and wide 

120-degree field of 

motion detection.

KwIKSET Smartcode  
916 toucHScreen 
eLectronic deadboLt
$190.00–215.00

Aimed at homeowners who 

want a traditional deadbolt 

lock with the convenience 

of HomeKit connectivity, 

this stylish touchscreen 

electronic deadbolt features 

a keypad with up to 30 

assignable user codes, 

available in a range of 

metallic finishes including 

brass, nickel, and bronze.

4 FlIR FX Hd outdoor 
wi-Fi Security camera
$249.99

Wirelessly recording 1080p 

HD video with unlimited 

cloud storage for up to two 

days, this motion-sensing 

camera is a great option. 

It also has a microSD slot  

for local storage, along with 

a four-hour backup battery, 

though it’s known for having 

a buggy companion app and 

occasionally sending 

phantom alerts.

SEcuRITy
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3

cONNEcTSENSE 
Smart outLet
$59.95

Why purchase one smart 

plug when you can double 

the fun for just a little more? 

This device connects to 

both wall outlets at once, 

replacing dumb sockets 

with a pair of smart, 

independently controlled, 

Wi-Fi-equipped versions. 

Smart Outlet features easy 

setup, a 2.4A USB charging 

port, and the ability to be 

remotely controlled through 

an Apple TV hub.

iHOME SmartpLug SerieS
$39.99 iSP5 or iSP6 

$49.99 iSP8

With support for appliances up to 1800W, 

iHome offers not just one but three different 

SmartPlug models. The slightly more 

expensive iSP8 adds RF remote control and 

power metering, but the older models are 

otherwise identical, requiring no hub, and 

narrow enough to stack two units in a 

traditional wall outlet.

ElGaTO eve energy
$49.95

Not just another smart plug, 

Eve Energy enables you to 

keep a close watch on your 

electrical consumption, with 

graphs that provide insights 

on how much power is being 

used by day, month, or year. 

The only downside is it’s a 

little on the large side, but 

using it in the bottom spot 

of a double outlet keeps the 

top one free. 

iDEvIcES SwitcH
$49.99

Like many of the products in this 

category, Switch offers remote control 

over home appliances with the ability 

to track energy consumption. But this 

model places the outlet along the right 

edge, leaving room for a handy, 

customizable LED nightlight capable of 

displaying whatever color, brightness, 

and saturation level fits your mood.

4

POwER
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iHOME iSS50 Smartmonitor
$79.99

The “home of the future” is now a reality, thanks 

to this five-in-one device that enables HomeKit users 

to monitor their home environment from anywhere. 

SmartMonitor includes sensors for motion, 

temperature, light, sound, and humidity, complete 

with push notifications and automated triggers 

for custom scenes, all controlled with Siri voice 

commands, the iHome app, or Apple’s Home app.

ElGaTO eve weatHer
$49.95

“Siri, what’s the weather like outside?” gets a serious upgrade 

with this wireless outdoor sensor that reads the surrounding 

temperature, humidity, and air pressure. With IPX3 water 

resistance, this little white box is designed to be mounted outside 

your home, and its app provides plenty of visually rich graphs.

3 FIRST alERT oneLinK 
wi-Fi SmoKe + carbon 
monoXide aLarm
$149.95

If there’s one HomeKit 

product everyone should 

own, it’s this Wi-Fi-enabled 

alarm. With a sealed battery 

that lasts up to 10 years, 

the alarm sends you push 

notifications even when 

you’re away from home, and 

features Bluetooth mesh to 

communicate with other 

models placed around the 

same household.

4 ElGaTO eve  
door & window
$39.95

If you want to keep tabs 

on open doors or windows 

when you’re away from 

home, this wireless contact 

sensor does the job nicely, 

providing push notifications 

courtesy of an Apple TV 

or iPad set as your home 

hub. Detailed graphs display 

how many times the door or 

window has been opened 

each day, month, or year, 

if you really want to know.

SENSORS
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HuNTER SignaL  
ceiLing Fan
$349

If you’re still yanking a chain 

to get the air flowing in 

certain rooms of your home, 

it’s time for an upgrade. This 

ceiling fan is equipped with 

Wi-Fi and can be controlled 

through Siri commands or 

scenes created in the Home 

app. You can even install 

multiple fans and control 

them all from one place; 

the only potential drawback 

is you can’t use Siri to dim 

the accompanying light.

ElGaTO eve room
$79.95

Although it lacks Wi-Fi connectivity and push 

notifications, this unassuming white box 

otherwise provides a wealth of information 

about the room where it’s installed to help 

make it more comfortable. Mount it on a wall 

and you’ll be able to view not only current 

temperature and humidity readings, but also 

the quality of the air you’re breathing.

iDEvIcES tHermoStat
$129.95

Although it can be a little 

daunting to program at first, 

this thermostat enables 

homeowners to bark 

commands at Siri and set 

the ideal temperature in a 

jiffy. The device looks great 

on a wall, but best of all, 

a hub is not required, and 

there are no monthly 

subscriptions to use the 

scheduling and custom 

scene features.

1

3

cOMFORT

wITHINGS aura connected 
aLarm cLocK + SLeep SenSor
$299.95

It may be on the expensive end of the 

scale, but if you value good sleep this is 

a bargain at twice the price. In addition 

to its alarm clock, speaker, and bedside 

lamp functionality, Aura features a free 

Health Mate app that enables you to 

visualize your nocturnal activity with 

an eye toward improving sleep patterns.
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Technology that enables you 
to control your home from 
your smartphone or tablet is 
becoming more common, and 

the range of such accessories that works 
with iOS devices is growing all the time. 
Among them are lighting, motion 
sensors, thermostats and much more. 
Apple provides a system that enables 
these devices to work together and be 
controlled from your iPhone or iPad. 
It’s called HomeKit, and you control 
accessories compatible with it in the 
Home app that’s included with iOS 10.

Perhaps you want to install smart 
lighting, environmental sensors to check 
temperature and humidity, smart plugs so 
you can switch devices such as lamps and 
heaters on or off in response to a sensor, 
or motion sensors to light your path if you 
get up during the night. You can control 
accessories in groups using “scenes,” 
and activate those using Siri by saying 
things like “Hey Siri, it’s film night.”

Initially, you’ll need to set up your 
accessories in the Home app, which 
acts as a hub to monitor and control 
them. Add accessories by scanning 
stickers on them (or their packaging or 
documentation), then optionally tell the 
app which room each accessory is located 
in to make things easier to manage.

AccessoRy compATiBiliTy

When you’re buying smart accessories, 
look out for the “Works with Apple 
HomeKit” badge. The Home app only 
works with accessories that support 
HomeKit – this doesn’t mean you can’t 
use other kinds of smart accessory with 
iOS, only that you can’t control or 
automate them in Apple’s app, which is 
what we’re focussing on here.

Non-HomeKit devices are controlled 
in their own apps and some can be 
automated using services such as IFTTT.
com. However, some devices work with 

both HomeKit and other systems. Philips 
Hue is an example; it supports HomeKit 
through a bridge, a device that plugs into 
your router and relays commands that 
it receives from the Home app to the 
lights. Bridges also have to be added to 
Home, which enables the accessories 
they work with to also be added, despite 
not independently supporting HomeKit.

Here you’ll learn how to set up and 
manage your HomeKit accessories. When 
you’ve done that, turn to page 44 to find 
out how to make your home smarter than 
ever by setting up automated responses 
to events. AlAn sToneBRidge

REQUIRES
iOS 10’s Home app, 

at least one HomeKit-
compatible accessory

yoU wIll lEaRn
How to set up your 

accessories, arrange  
them in rooms, and set  

up scenes to control 
several with one tap 

IT wIll TaKE
30 minutes

STaRT yOuR SMaRT HOME
Learn how to set up and control your HomeKit

 
gEnIUS TIp

 
If your iOS device lacks 

3D Touch, rather than 
pressing firmly on an 

item to edit it, hold your 
finger on it for a short 

time (a long press).
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4 THe HOme OvervIew
Tap Home for a status summary 

and favorite accessories. Tap the arrow 

(top left) to rename your home, give 

others control, and see if a 4th-gen 

Apple TV or iPad 4 or newer, set as a 

hub in Settings > Home, is available.

1 GeT STarTeD
Skip Home’s intro page, then 

tap Add Accessory on the My Home 

page to see nearby HomeKit-

compatible accessories. If none appear, 

tap the sentence at the bottom for 

advice. Otherwise, tap one to connect.

7 GrOup acceSSOrIeS
To control things as a group, 

long/deep press on an accessory, 

tap Details, then Group with Other 

Accessories. Name the group, tap 

accessories to add, then tap Done. 

Their tiles are merged into one switch.

5 eDIT THe Summary
In the Home page, tap Details to 

see which accessories contribute to the 

summary. Apply a long/deep press to 

an accessory, tap Details, then Status 

and Notifications and set the Include in 

Favorites switch as you want it.

2 aDD an acceSSOry
Align the accessory’s sticker 

with your iPhone camera’s view to scan 

it and add the accessory to your home. 

Name it and add it to a room if you 

want. Making it a favorite adds it to 

the Home page and Control Center.

8 creaTe a Scene
Scenes set more complex states 

of multiple accessories in one tap. They 

can also be triggered by conditions 

such as temperature, motion in a room, 

or your location. Tap + on the Home or 

Rooms page, Add Scene, then Custom.

9 cOnfIGure yOur Scene
Name the scene, then tap Add 

Accessories, tap those to include in it, 

then Done. Apply a long/deep press to 

accessories in turn to set their desired 

statuses, then tap Done. Scenes can be 

controlled from any room they affect.

6 OrGanIze yOur rOOmS
Tap Rooms in the bottom bar 

and swipe horizontally to see what’s in 

each. Tap the list icon, Room Settings, 

then Edit to set the order in which 

rooms appear. Tap Done then Edit to 

reorder the current room’s accessories.

3 cHecK fOr upDaTeS
To add more accessories, tap +, 

then Add Accessory. After doing this in 

the Home app, it’s worth downloading 

and opening any app its manufacturer 

provides, which may provide additional 

controls or firmware updates.

how To Set up and manage HomeKit accessories

beginner’s guide to HomeKit
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connecTing your smart home 
accessories to the Home app 
gives you the ability to check 
the status of sensors and 

toggle devices on or off at will, but that’s 
just the foundation of making your home 
smarter. Things get really clever when 
you use sensor data, the time of day, or 
a change in your location to trigger 
behaviors. For example, you can have a 
heater turn on when you leave work so 
your home is warm when you arrive there.

The Home app’s Automation tab is 
the key to doing this. There you can define 
conditions that will cause an accessory or 
scene to turn on or off. Automations can 
change the status of a single accessory, or 
they can activate multiple scenes at once. 
For example, an automation might turn 
on lights in multiple rooms at sunset, 
and set the brightness level of each light 
to a suitable intensity for that time of day 
and their location, so that you aren’t 
dazzled if you happen to be home. Or you 
might set one light to turn on along with 

your heating when you leave work at the 
end of the day, but only if the sun has set 
– indicating that it’s winter. 

You can disable automations to ensure 
they don’t run – say in summer or when 
you’re away from home – rather than 
deleting them and having to recreate 
them at a later date. The Home app marks 
those that are disabled as such, to help 
you find and turn them on again.

In the tutorial on page 42 we mentioned  
that it’s worth downloading whatever 
apps the manufacturers of your HomeKit 
accessories provide, so you can receive 
firmware updates. Automation is another 
good reason to do so, as these apps may 
provide features that Home does not.

Apple introduced the Home app in iOS 
10. It hasn’t seen major changes in the 
months since then, so there are some 
aspects that are less than great. If you set 
up many automations, for instance, they 
become a little tedious to browse and 
manage – but we’ve got some pointers to 
help you with that. AlAn sToneBRidge

REQUIRES
iOS 10’s Home app,  

HomeKit accessories 
already set up, and  

an apple Tv (4th-gen) 
with tvOS 10 or an ipad 
with iOS 10 set up as a 

Home Hub in its settings

yoU wIll lEaRn
How to automate your 

home based on your 
location, the time, or 

a particular change in 
an accessory’s status

how To Set up home automations

1 creaTe an auTOmaTIOn
Tap Automation in the bottom bar 

of the Home app. The first time you do 

this there’s only one thing you can do: 

tap the “Create new Automation” button. 

You’ll then be shown a list of possible 

trigger conditions.

2 pIcK a TrIGGer Type
An automation can be triggered 

by your arrival at, or departure from, a 

place; a time of day; when your actions 

change a device’s status, such as opening 

a door or turning off a light; or when a 

sensor detects, for example, smoke.

3 auTOmaTe by lOcaTIOn
Choose location and you’ll see a 

map with your position marked, above 

which are locations you’ve searched for 

in the past, plus a search bar to look up 

a new place. Pick a place, then tap either 

When I Arrive or When I Leave.

auTOMaTE yOuR SMaRT HOME
Make your abode truly clever with automatic responses to events

>>>Feature
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4 SeT THe area
Next, drag the blue handle on the 

edge of the circular boundary that’s 

shown around the location you chose, 

so that the boundary roughly covers 

the distance at which you want your 

automation to occur. Finally, tap Next.

7 SeT reSpOnSe
After setting up your trigger, 

you’ll be shown scenes you’ve set up, and 

all your accessories listed by room. Tap 

one or more of those you want to control, 

then Next. You’ll then see a summary of 

your trigger and what will be controlled. 

10 IDenTIfy auTOmaTIOnS
As the list of automations grows, 

you’ll need to scroll down to reach the 

button to create one. Sadly, automations 

can’t be reordered or renamed, but the 

trigger icons to their left go a little way 

to helping you find the one you want.

5 auTOmaTe by TIme
When automating by time, you 

have three options: sunrise or sunset, 

which will adjust automatically during 

the year; or a precise, fixed time. Below, 

tap the days on which you want the 

automation to occur.

8 cOnTexTual OpTIOnS
Depending on the trigger, you 

may see an option to limit the 

automation to post-sunset. Apply a long/

deep press to a scene or accessory, set 

its desired state, then tap outside the 

controls to return to the summary. 

11 auTOmaTIOn SummarIeS
Each row mentions accessories 

and scenes it controls, which can help 

you to distinguish the one you want to 

edit. You’ll see a number if there are too 

many to list, so you may still have to tap 

through to identify the one you want.

9 cHecK auTOmaTIOnS
Tap Automation in the bottom bar 

at any time to see the routines you’ve set 

up. It includes those created in Home or 

an accessory’s own app, which may 

provide extra features, such as this chart 

of historical readings in Elgato’s Eve app.

12 DISable Or DeleTe
Tap an automation and you’ll find 

a switch that enables you to disable it – 

say, because you don’t want your heating 

on in summer even after sunset. If you no 

longer need an automation, swipe left on 

it in the automations list and tap Delete.

6 auTOmaTe by STaTuS
The remaining two trigger types 

activate when an accessory’s status 

changes due to your action or sensor 

data. Tap the accessory that’ll trigger the 

automation, tap Next, then pick the state 

at which your automation will kick in.

Beginner’s guide to HomeKit
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O

Get

with your

and

nly those people who 
have never used an iPad 
or iPhone for any length 
of time could still cling 
to the hoary old myth 

that these devices are good solely for 
consuming content, not creating it.

Yet even if you’re a veteran iOS user, 
you might still be surprised at the sheer 
breadth of creative activities you can 
pursue using nothing more than your 
iPad or iPhone. In every artistic area, 
apps have now evolved and matured to 
such an extent that they rival – and in 
some cases, even exceed – anything 
found on the desktop.

So, whether you want to make better 
photos, strike up a tune or two, write the 
Great American Novel, or do anything 
else, there’s an app for you. Let’s go…

Put that game down 
and express your 

creativity! No matter 
what your artistic 
passion, your iOS 

device can help you 
develop it further

by matt bolton
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sharpen your 
photography 

techniques
Take and edit stunning 
photos with these apps

 Camera+ 

$2.99, camera.plus

> This is a killer app both for taking 
better photos and tweaking them 

so they look as good as possible. Manual focus, 
white balance, exposure, and shutter speed 
controls are all easily available when shooting. 
You can shoot raw photos, and there’s a big range 
of options to customize on-screen indicators. 
Its editing tools include many of the kind of 
adjustments and filters you’d expect, and also 
the fantastically clever Clarity filter, which makes 
even the dullest photos look vibrant and exciting. 
No snapper should be without this.

 VsCo 

Free, vsco.co

> This is the go-to 

editing app for 

many professional 

photographers, 

because it offers 

beautiful looks for 

your photos that are 

easily applied, with 

more added over 

time. To get the full 

set and immediate 

access to the newest 

tools, you’ll need  

the $19.99 per year 

subscription, but 

you can give it a  

try for free before 

committing. If you 

want to add texture 

to your pictures by 

using beautiful film 

effects, there’s no 

better option.

 mextures 

$1.99, mextures.com

> There are more 

apps than we could 

ever count that let 

you add filters to 

photos. We love 

Mextures because 

it makes it easy to 

create your own 

unique filters, giving 

your pics their own 

style. It enables you 

to mix different 

textures, color 

effects, light 

adjustments, and 

blending modes in 

layers – just putting 

the same few 

options in different 

orders can yield 

different results, 

let alone mixing 

different effects.

 Pixelmator 

$4.99, pixelmator.com

> This is as close to full Photoshop 
on the iPad as you can get right 

now – a fact which Adobe should be somewhat 
ashamed of. It’s easy to use, with a huge range of 
powerful tools for doing everything from cutting 
out parts of photos and applying simple image 
filters, to making fine-grained color alterations 
to raw images. It has a full layers system, so you 
can work non-destructively and apply changes 
only on certain layers. Powerful custom looks are 
at your fingertips, along with the ability to create 
collages, or fix unwanted elements in photos 
using the repair tools. 

Get creative with iPhone and iPad
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 KorG GadGet 

$39.99 korg.com

> This is a synth-specialist production app that’s fantastic 
for live electronic music performances, but also great for 

anyone who wants to play with a range of cool sounds. Some synths are 
played on a keyboard, while things like drum machines have pad 
arrangements. You can record and mix within the app, or export your 
recordings. For a wide range of electronic sounds, there’s nothing better.

 amPlitube 

$19.99 

ikmultimedia.com

> This is essential 

for guitar players – 

it enables you to 

combine digital 

recreations of real 

amps, stomp boxes, 

cabs, and even mic 

placement to create 

just about any sound 

you want for your 

electric guitar. It’s 

not cheap (the 

iPhone and iPad 

versions are sold 

separately, and 

many new sounds 

require an in-app 

purchase), but it 

sounds amazing.

become 
a slave 
to the 

rhythm
Record your next 

Billboard chart hit 
wherever you are

>>>Feature
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 GaraGeband 

$4.99, apple.com

> GarageBand is an 

astoundingly useful 

tool for both music 

pros and total 

novices alike, and is 

free with new iOS 

devices. If you’re a 

musical beginner, its 

autoplaying virtual 

instruments and 

pre-made loops 

mean you can 

instantly have fun. 

If you know what 

you’re doing, it’s a 

totally portable and 

truly professional 

recording studio.

 dm1 – the drum maChine 

$4.99 fingerlab.net

> For advanced electronic 
percussion, this is the app you  

need. Featuring over 200 drum kit sounds, from 
electronic to classic, it’s designed to make creating 
complex rhythms easy by using a sequencer, as well 
as enabling you to play with just your fingers. It’s 
easy to mix within the app, so you can get the sound 
just right when combining multiple elements – and 
you can add a multitude of effects too, of course. 
Plus, there are no sneaky in-app purchases.

 notion 

$14.99 presonus.com

> At its core, this is a musical notation 

editor for writing music… but it’s really 

much more powerful than that. You can record MIDI input 

to a score, enter notes with a tap, play them on virtual 

instruments, and even – on iPad – handwrite them. The 

best part is that you can then play back your score using 

sound samples from the London Symphony Orchestra. 

The app comes with piano playback built-in, and more 

instruments are available with in-app purchases. There’s 

even a mixer, so you can test different audio balances.

 musiC memos 

Free apple.com

> An amazing way to 

capture song ideas 

quickly. Hit record in 

this app and play or 

sing your song idea. 

The app captures 

your tempo and 

chords, and you  

can add a rhythm 

section from virtual 

instruments (much 

like GarageBand’s) 

to flesh it out. Then 

share it with others, 

or just refer to it 

while playing or 

recording with a 

more comprehensive 

setup. Songs can  

be organized and 

tagged efficiently 

too, so it’s a great 

way to store those 

seeds of ideas you 

want to grow 

sometime in future.

Get creative with iPhone and iPad

 maclife.com  spring 2017   49



 FilmiC Pro 

$9.99 filmicpro.com

> This is the best video recording 
app on iPhone – it’s that simple. 

It offers useful manual controls to get the look 
you want, as well as helpful visual overlays such 
as video histograms and audio levels, so you get 
a better feel for what you’re capturing. You can 
easily set and lock the focus, exposure, and white 
balance, so you get consistent shots. Even better 
is that you can customize the recording format; 
there are various resolutions up to 4K, frame rates 
from cinema-standard 24fps to slow-motion 
240fps, and capture rates up to 50Mbps.

 Flow sPeed  

 Control 

Free flowspeed 

control.com

> Recorded a cool 

slo-mo video, but 

frustrated by how 

iMovie and others 

only let you change 

its speed abruptly? 

Flow gives you more 

control, so you can 

gradually go from 

full speed down to 

the slowest… and 

then maybe half-

speed for a while, or 

even double-speed, 

all in one video! 

This app gives you 

ultimate control over 

slo-mo footage.

 VideoGrade 

$5.99  

flainezapps.com

> Give your video 

a new look, pro-

style, with this  

color-grading app – 

whether that’s a 

noir-ish tint or a 

cheerful, summery 

orange haze. You 

can also use this  

app to improve  

video quality,  

with sharpening, 

brightening, and 

white balance 

correction among 

other tools. It also 

boasts analog filters 

and individual color- 

channel control.

 Vont 

Free vont.phon.to

> Don’t like iMovie’s options for adding 

titles to a movie? This app gives you 

plenty more control over color, font style, shadows and 

similar effects, plus transitions. You can create multiple 

text elements, which can be controlled individually, and 

combined into one video to produce elaborate sequences.

 imoVie 

$4.99 apple.com

> Once you’ve recorded, prepared, 
and tweaked your clips, there’s no 

easier way to build a project than in iMovie, which 
is free with new iOS devices. You can grab clips 
from your device’s storage (or iCloud), quickly 
trim and build them into sequences, add sound 
effects and a soundtrack, add a theme, and make 
something really slick on the go. It even includes 
precision editing and image-layering tools.

Video with 
va-va-voom

Turn any footage into  
a masterpiece worthy  

of showing at Sundance
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 sCriVener 

$19.99 literature 

andlatte.com

> If you’re planning 

some long-form 

writing, this is the 

app you need. 

Scrivener includes 

powerful features 

for planning outlines 

and storing notes, 

which are visible 

right alongside your 

writing. It makes it 

easy to work on your 

words in sections, 

with relevant 

information for  

each one of them 

attached. Whether 

you’re writing a 

novel or doing  

a dissertation, 

Scrivener will be 

your best friend. 

 byword 

$5.99  

metaclassy.com

> For simple writing 

purposes – for the 

web, say, or just in 

a distraction-free 

environment – we 

love Byword. You 

can choose from 

a few appearance 

options, but it’s 

primarily designed 

to help you focus 

on getting the words 

down. It syncs with 

Dropbox or iCloud, 

and supports 

Markdown for  

web formatting – 

including the ability 

to publish directly 

to some blogging 

services from within 

the app. 

 PaGes 

$9.99, apple.com

> Pages is fine for simple 
writing, but where it really 
shines is in page layout – 
in fact, there’s nothing better 

for it on iOS. You can create and style text boxes in 
various shapes and formats, wrap text around 
images, add charts from Numbers, and create a 
great-looking document for a report or newsletter 
in minutes. Integration with iCloud makes Pages 
ideal for using on multiple devices, and at a pinch 
your documents can be edited on Mac or even a PC 
at iCloud.com. The app is free with new devices.

 editorial 

$4.99 editorial-app.com

> This is a text editor for the web 
age. Editorial has a number of 

features that make it perfect for writing, such as 
the ability to collapse sections of a document to 
keep them out of the way – but the killer features 
are its options for workflow. You can set up 
automated tasks to be run on your document with 
just a tap, performing checks as simple as scanning 
it to make sure brand names are correct, or as 
complex as finding, adding, and styling content 
found online based on triggers in your text – and 
much more beyond. You can find other users’ 
workflows online to easily add them to the app.

writing right
The tools you need – from 
a short blog to a long novel 

Get creative with iPhone and iPad
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 ProCreate 

From $2.99 procreate.si

> Turn your screen taps into beautiful paintings with this 
fantastic art app, which is easy to use but incredibly 

powerful. You can work in a variety of digital pencils, pastels, inks, and 
paints to produce natural-looking results. It comes with 128 brushes, and 
you can create your own for unique looks. You can work on huge canvasses 
too – up to 16,000 pixels wide – in multiple layers. It even records how 
you built up your canvas, so you can play it back as a video later.

 linea 

$9.99  

linea-app.com

> This iPad-only 

app is designed for sketching. 

Whether that’s rough art ideas, 

outlines for projects, app 

designs, or… anything really, 

Linea is laser-focussed on 

plotting out your drawings. 

The interface is optimized for 

Apple Pencil, though, meaning 

the controls are tiny in places.

 GraPhiC 

From $2.99 

graphic.com

> This is 

the closest there is to Adobe 

Illustrator on iOS. It’s a vector 

drawing tool for iPhone and iPad 

(each must be bought separately) 

that’s ideal for everything from 

technical drawing to coming up 

with funky logo designs, and 

supports the import and export 

of Photoshop files.

 assembly 

Free assemblyapp.co

> Do you want to 

make cool graphic 

designs but find 

yourself lacking 

in experience or 

specialist art 

knowledge? This is 

a vector illustration 

tool without the 

drawing: It comes 

with a series of 

shapes and editing 

tools, and you can 

assemble designs 

from component 

pieces (which snap 

together to ensure 

accuracy) and  

create surprisingly 

advanced and 

detailed images – 

then export them 

and pretend you 

made them by hand!

the fine 
art of 

drawing
Create stunning 
images with or 

without a stylus

>>>Feature

52   spring 2017  maclife.com

Get creative with iPhone and iPad



 Codea 

$14.99 twolivesleft.com

> This ingenious app lets 

you write code (in the Lua 

language), but adds some brilliant twists to 

make it easy to get to grips with. Certain 

elements can be altered with taps rather than 

by changing the code – tap a color element to 

pick from a color wheel, or an image element 

to browse stored pictures. Other parameters 

can be adjusted with tools such as sliders – 

or you can stay code-happy for everything.

 Coda 

$24.99 panic.com

> This text editor 
supports syntax 

highlighting in a wide range of 
languages, including HTML, PHP, 
JavaScript, and more than we can list. 
A custom keyboard helps you write 
code faster, there are great editing 
tools including a special magnifying 
loupe for moving the cursor, and tabs 
for multiple open documents at once. 
There’s even a full SSH client built-in.

 Pythonista 3 

$9.99  

omz-software.com

> This complete 

Python scripting 

environment makes 

the most of being 

specialized for one 

coding language, 

instead of several. 

It has a debugger 

included, tabs for 

multiple documents, 

a tool for quickly 

building visual 

interface prototypes, 

and even includes 

additional modules. 

Pythonista makes 

itself available as a 

sharing extension, 

so you can create 

Python scripts in 

other apps, and 

then run them 

in Pythonista.

 textastiC 

$9.99  

textasticapp.com

> This is the best 

website coding app 

on iOS, thanks to 

fantastic features 

such as syntax 

highlighting, local 

previewing of your 

work in the app’s 

browser (which you 

can then open in 

Safari), and code 

completion for 

HTML, JavaScript, 

CSS, and PHP. It has 

a built-in WebDAV 

server, and connects 

to FTP, Dropbox, 

Google Drive, and 

other services easily. 

It even has great 

support for external 

keyboards (including 

shortcuts), as well as 

special editing tools 

to make life easier.

Coding 
up a 

storm
Think you can’t 

write great 
programs or 

websites on iOS? 
Think again
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MAC

iPAD

iPHONE

Subscribe to 

Choose your 
perfect package

Ahead of the curve, and endlessly entertaining…

Only $18
Every Year

Instant digital access on your iPad, 
iPhone, and Android device.

Only $30
Every Year

Every issue delivered to your door 
at a fraction of the cost.

Get the DiGital eDitiOn Get the Print eDitiOn

interaCtive 
iPaD eDitiOn - 

inCluDeS extra 
imaGeS anD 
interaCtive 

featureS
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get both the Print & 
 Digital editions for only

 $42
Every Year

subscribe 
now and get

20% 
Off

Adobe Creative Cloud 
Photography plan

Get the COmPlete Print & DiGital bunDle

It’s easy to subscribe… 
bit.ly/maclife-subs

Save 
71%

TErms AnD ConDITIons Prices and savings quoted are compared to buying full-priced print and digital issues. You will receive 13 issues a year.  You can write to us or call us to cancel 
your subscription within 14 days of purchase. Your subscription is for the minimum term specified and will expire at the end of the current term. Payment is non-refundable after the 
14-day cancellation period unless exceptional circumstances apply. Your statutory rights are not affected. Prices and offers correct at time of print and subject to change. For full terms 
and conditions please visit bit.ly/magterms. Offer ends: 05/02/2017

SPeCial 
Offer
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We’ve reviewed 
many password 
manager apps over 
the years, with 

1Password continuing to be 
the cream that rises to the top. 
But if its relatively high cost 
or recent shift to subscription 
pricing is a turnoff, you’ll want 
to check out the next best 
thing: onePass 4 is a universal 
iOS app that takes a whimsical 
approach to password 
management. That’s not to 
say the devs have slacked off 
on security; the app uses the 
same local AES-256 encryption 

found in rival 
products, with the 
addition of its own 
TRI-PIN technology.

TRI-PIN eliminates 
the possibility of 
someone sneaking  
a peek at your four- 
digit PIN code, since 
the app uses a keypad 
made up of random 
colors and symbols 
that change each time 
you use the app. 
Instead of choosing 
numbers alone, codes 
are based on a 
sentence or phrase 

oneSafe 4
Add some class to password protection
$1.99  Developer Lunabee, onesafe-apps.com

Platform Universal  Requirements iOS 9.3 or later

oneSafe 4

   Item templates, edit icon 
or background colors

  TRI-PIN security

  Apple Watch, 3D Touch support

   No iOS sharing extension support

great 

Templates 
provide a great 
way for bank 
account, credit, 
ID, and other 
cards to look as 
great as they are 
safe and sound.

of your choosing; “I love 
getting five gold stars,” 
for example, translates to 
a passcode like Heart-Five-
Yellow-Star.

Rather than rely on TRI-PIN 
alone, oneSafe 4 also supports 
traditional password, pattern, 
and PIN code authentication, 
with or without Touch ID. The 
app is likewise agnostic when 
it comes to how data is stored, 
ranging from the most secure 
device-only option to cloud-
based sync with other devices 
via Dropbox, iCloud Drive, 
or CloudKit. That last one is 
Apple’s latest thing, which 
improves upon iCloud Drive, 
but oneSafe 4 doesn’t do well 
at explaining this during setup.

Visually, oneSafe 4 offers 
several advantages over 
1Password, such as the ability 
to edit icon and background 
colors, protect items with an 
additional password, or omit 
individual entries from being 
synced at all. We liked the 
ability to use decorative 
templates for bank account, 
credit, and ID cards, or to snap 
a photo of the card in question; 
we only wish oneSafe could fill 
in card details when using this.

Virtual cards are displayed 
on Apple Watch, where you can 
conveniently share item details 
via text message. 3D Touch has 
also been implemented on 
supported iPhones, providing 
handy shortcuts to add new 
web accounts, scan a card, take 
a photo, or search existing 
vault entries. One thing still 
missing is sharing extension 
support, which makes filling 
forms in mobile Safari more of 
a chore than it should be.

the bottom line. oneSafe 
4’s visual flair and additional 
security options are almost 
enough to make our hearts 
flutter. J.R. bookwalteR

oneSafe 4 can store items in a 
wide variety of different categories.
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Long gone are the days 

when you’d need to keep a 

dictionary in your house. No 

more CD-ROM dictionaries 

bundled with every computer. Nope, 

we’ve got the web now – so why would 

you want a dictionary app?

Well, if it’s LookUp, it’s the same 

reason you’d get one of those “Word of 

the Day” desk calendars: for pure fun. 

Every day, there’s a new word for you to 

learn, ranging from words like “piebald” 

to “beey” and almost everything in 

between. With each word of the day, you 

get a cute illustration which gets placed 

on the opening page. This is a fantastic 

In a world of subscription 

services, it’s really easy to 

break your budget without 

attempting to. How many 

times have you realized that after your 

Netflix and Hulu subscriptions, your 

gym membership, and your credit card 

auto-payment, you’ve almost got no 

money left in your checking account? 

That’s where Truebill wants to help.

Truebill works by asking you to log in 

to your credit card, checking, and PayPal 

accounts; it then looks for recurring 

payments and monitors them. Truebill 

will alert you when one of your payments 

posts, as well as to any new recurring 

LookUp
Beautiful art combines with a dictionary
$2.99  Developer Rajesh Bhargava, thetangible.in

Platform iPhone  Requirements iOS 10.0 or later

Truebill
Keep your spending in check with Truebill
Free  Developer Truebill, truebill.com

Platform iPhone  Requirements iOS 8.0 or later

excellent 

excellent 

Evocative art accompanies each daily word 
definition to help you remember it.

View your current recurring bills easily – 
including those you might have forgotten.

way to learn a new word and see a bit  

of artwork to help you remember what 

the word means. Each word of the day 

stays on the front page, adding to your 

collection of them that you can view 

at any point.

Of course, it’s also a functional 

dictionary that offers you definitions 

of words, and has basic thesaurus 

capabilities that allow you to look up 

synonyms. LookUp even allows you 

to get word definitions in other apps 

using the standard share/action bar. 

Whether you’re a lover of words or 

someone who needs a little help boosting 

their vocabulary, we highly suggest 

payments. In the event that you’ve 

missed a payment and incurred 

a late fee, Truebill alerts you and offers 

to request a refund on your behalf.

Truebill is a great tool for anyone to 

use. Its interface is easy to navigate and 

all the information is clearly presented; 

there’s no chance of getting lost in 

endless lists or tabs, and no intrusive ads 

to be swatted with an in-app purchase.

If you’re on a budget, or you’re just 

interested in knowing when your money 

is going to get pulled from your account, 

we highly suggest snagging Truebill.  

It’s a great way to keep track of just how 

much money is going to your monthly 

checking out LookUp. It’s great for 

anyone of any age, and we think that 

most people will soon become addicted 

to their daily new word.

the bottom line. We love LookUp; 

it’s a great way to boost your vocabulary 

every day. ambeR neely

subscriptions, as well as a great way to 

keep an eye on the money currently in 

your bank and credit accounts.

the bottom line. Perfect for those 

who are prone to forgetting just how 

much they spend on subscriptions every 

month. ambeR neely
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On opening 
this app, you’re 
presented with Eric 
Carle’s adorable 

bear looking out of his cave. 
Other than that, you’ve got 
a few trees behind, and a few 
tufts of grass in front.

What to do? Well, every one 
of our young testers asked 
that, then quickly stabbed 
away at the grassy clumps. 
On doing so, the bear ventures 

Eric Carle’s Brown Bear 
Animal Parade
Lovely animation, but not much more
$1.99  Developer StoryToys, storytoys.com

Platform Universal  Requirements iOS 6 or later

The finale is where the 
fun happens: you can 
record your own sounds 
for the animals.

Eric carlE’s Brown BEar 
animal ParadE

   Eric Carle animation with 
a slight 3D effect

  Voice recording feature

   Very quick to play

   Limited to particularly young audience

okay 

forth. Keep tapping the same 
clump of grass and a dragonfly 
or butterfly will appear; 
sometimes these appear within 
a golden circle. “What are you 
supposed to do with the golden 
circle?” we were asked. No 
idea. The golden circle doesn’t 
seem to hold any special power 
and may just be trying to 
indicate a firefly.

A few taps later and we get a 
bird in a tree and a gray circle. 
Tap the bird and it’s colored in. 
A musical note also appears 
and you get the musical sound 
for that animal. The gray 
triangle only seems to appear 
on the bird we play, and again 
we’re not sure what it’s 
supposed to indicate...

Anyway, the bird then 
follows the bear. Find a gray 

duck, color him in. The bird 
and the duck then follow the 
bear. Find a gray horse, color 
the horse… and so on. Each 
animal follows the bear in 
turn, and each has its own 
musical sound. Animals you 
encounter further along the 
route tend to do a bit more 
– the frog jumps over lily pads 
to cross a pond, a cat jumps 
into a basket from a tree 
branch and crouches as you 
color him in. 

The finale brings all the 
animals together; tap them 
repeatedly for a musical 
collaboration and confetti falls. 
At this point, you can record 
your own sound for the 
animals. You’re prompted to 
do this on the first go; after 
that it took us a while to realize 
you need to press and hold the 
animal to record on subsequent 
plays. This is the standout 
feature, and our kids really 
enjoyed putting their own 
voices to the sequence.

the bottom line. A cute 
Eric Carle animation with an 
entertaining voice recording 
feature, but definitely for a 
very young audience – and the 
app could do more for its $1.99 
asking price. jo membeRy

There’s that 
golden circle... 
what can it 
mean? Uh, just 
a firefly we think.
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The idea’s in the name here: 

use pictures instead of words 

to create a checklist of 

things to remember for a 

trip. Open Checkie, name your alarm, 

then choose a cute animal character for 

your reminder. Days of the week are at 

the top, with time underneath. Objects 

appear at the bottom: scroll through and 

drag and drop them on your character.

The majority are easy to figure out: 

a hat is a hat. But the blue folded icon – 

is this a book, magazine, or newspaper? 

This can be interpreted to your liking, 

of course, but we’re baffled by the red 

flower with a white rectangle…

Perhaps we’re just not 

hanging out with the right 

people, but they don’t seem 

to really text that much any 

more. Facebook Messenger, Twitter DMs, 

Slack, and WhatsApp seem far more 

useful than SMS and iMessage, perhaps 

because they’re easier to talk to people 

in other countries, or switch devices.

But here is an app made for people 

who do use the Messages app – and its 

sole purpose is to remind you to text 

back. Trying to figure out the exact 

situation that would require specifically 

this app, and not just the iPhone’s built-in 

Reminders, is a little difficult.

Checkie! – Visual checklist
A somewhat surreal aide-mémoire
$0.99  Developer Makoto Funamizu, enfani.jp

Platform Universal  Requirements iOS 9.1 or later

TxtBck
TxtBck’s got your (text) back
$0.99  Developer JaYes Apps, txtbck.info

Platform Universal  Requirements iOS 10.0 or later

good 

solid 

Drag and drop items you need for a task, such 
as your kid getting their school bag ready.

The interface is a little too simplistic 
to be helpful, but it gets the job done.

Adding an object is easy, although you 

do need to make sure there’s enough 

space on the screen to keep adding 

things or the item simply disappears 

when you try to drop it.

Once you’ve set the time for the alarm 

and the objects you want to bring with 

you, set the day(s) you want the alarm 

to go off and press the check mark. 

A preview of your character enables you 

to make further changes before you 

confirm. You can then tap each item to 

gray it out as you put it in your bag.

The characters blink, and ears twitch, 

so there’s a feeling of character, but it’s 

somewhat confusing in terms of 

The app is integrated with iMessage, 

so if you enable it, you can copy 

messages and set reminders right there 

and then. This is useful, but the amount 

of steps it takes is pretty much the same 

as setting a regular reminder. You can 

use TxtBck as its own standalone app, 

too, but it’s quite limited, even though 

you can have reminders pop up at certain 

times or locations, and can categorize 

them by Family, Friends, Work and so on.

No doubt this app will be exactly what 

someone needs – someone who will 

forget about a text as soon as they close 

the Messages app – but it just seems like 

something of a chore. For anyone who 

audience. The animals are very cute and 

kid-friendly, but then not every six-year-

old has their own iOS device. 

the bottom line. Drag, drop, 

forget until you get your reminder. 

A wider choice of icons would have 

been preferable, though. jo membeRy

has the “Storage almost full” notification 

constantly popping up – which is 

probably all of us – it isn’t particularly 

worth the memory.

the bottom line. It does the thing 

it’s supposed to, but do you really need 

an app for that? Kate GRay
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The iPad is already 
home to a variety of 
powerful sketching 
and painting apps, 

but Linea is somewhat 
different. It’s designed to give 
you just enough in the way of 
tools to capture your ideas, 
without overwhelming you 
with a complex selection that 
you’ll never use.

Linea
A great sketching tool for the Apple Pencil
$9.99  Developer The Iconfactory, linea-app.com

Platform iPad  Requirements iOS 10.0 or later, Apple Pencil (optional)

The sliders in the top 
bar are fiddly even 
with an Apple Pencil. 

Tapping a layer’s icon 
reveals merge and 
erase commands.

Linea

  Focusses on just the essentials

  Fast and natural-feeling drawing tools

   Opacity fiddly even with Apple Pencil

   Colour selection can feel 
somewhat unwieldy

exceLLent 

Though the iPad’s smooth 
surface can’t truly mimic 
drawing on paper, you’ll soon 
get a feel for Linea’s responses 
to pressure and the angle of 
your Apple Pencil, and then 
turn those into convincing 
lines using its technical and 
drawing pencils, felt tip pen, 
and wide tip marker. Where 
some apps translate pressure 
to line thickness, Linea more 
naturally binds it to the 
darkness of what you draw, 
and the side of the Pencil’s 
nib can be used for shading.

As with many other apps, 
you can twist two fingers on 
the digital paper to turn it, and 
double-tapping the lock icon 
fixes its orientation so your 
palm doesn’t move it. As your 
Pencil approaches a toolbar, 
the interface disappears so you 
can continue your movement 

unbroken. Each tool has three 
thickness settings, and you can 
spread apart two fingers to 
zoom in if you need to focus 
on fine detail or fixes.

You get five layers to work 
on, which can be merged if 
needed. We found this 
limitation imposed a helpful 
formality on our process. Layer 
opacities can be adjusted using 
tiny sliders – designed with 
Pencil in mind, yet still too 
small for comfort. Linea’s 
focus on the basics mostly 
works, though a ruler and a 
compass to enable precise lines 
and circles to be drawn would 
be a welcome addition.

the bottom line. 
A natural-feeling sketching 
app, with room to grow while 
keeping its simple appeal. 
AlAn StonebRiDge

There are various 
grids and paper 
textures to aid a 
variety of tasks.
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A Normal Lost Phone is 

designed to be an enigma. 

You “find” a phone, you 

unlock it, you read through 

the owner’s texts, you unravel the story 

of the person who held this device before 

you did. You figure out their passwords 

from passing references, work out how 

to connect to Wi-Fi, and you snoop 

through this person’s life, loves, and 

feelings. Eventually you know them 

better than some of their friends, and 

definitely more than most of their family.

There’s a sense of unease to it all – 

it feels wrong, you shouldn’t have this 

much unfettered access to someone 

Some games are so 

incredibly clever that you 

can spend almost as much 

time trying to figure out how 

they were made as you do playing them.

Splitter Critters is one of those. It’s 

deceptively simple: swipe your finger 

across the screen to “split” it, then drag 

the screen to move the two halves. 

You’re trying to guide some slightly 

simple, Lemmings-like aliens to the 

spaceship at the end of each level, and 

you’ll do so by lining up platforms, and 

avoiding lasers, lava, and other less 

friendly aliens. The simplicity masks 

some fantastic puzzle design in Splitter 

A Normal Lost Phone
A salutary lesson on changing your passwords
$2.99  Developer Accidental Queens, accidentalqueens.com

Platform Universal  Requirements iOS 6.0 or later

Splitter Critters
So clever, you’ll feel stupid
$2.99  Developer RAC7 Games, splittercritters.com

Platform Universal  Requirements iOS 7.0 or later

great 

excellent 

Be honest: you’ve always wanted to read 
through someone else’s emails, right?

Complex splitting of levels is the key to 
success – not to mention headaches.

else’s private life – but it all takes place 

in a safe, fictional space where your 

feelings of guilt and intrusion are part 

of the story.

Of course, it’s still possible to overstep 

boundaries, and A Normal Lost Phone 

does this a little bit towards the end, with 

some rather strange choices that the 

player must make to continue the game. 

Nevertheless, once it was all over, and 

after all we’d learned about the previous 

owner of the phone, we were left smiling.

A Normal Lost Phone isn’t a typical 

mobile game experience. There are a few 

puzzle aspects, but they mainly involve 

careful reading. There’s a plot, but it’s 

Critters’ 42 levels (and 12 bonus levels), 

as you tear up each environment in 

increasingly complex ways to save your 

little alien wards. The level-splitting idea 

is easy enough to get your head around, 

but when you’re ripping in angles, lining 

up lasers to power the ship, and trying 

not to cross any wires, it gets complex in 

the best of ways.

Like most really good games made 

by a small team, it can feel a little short 

for the money – though more levels are 

promised for the future – and it would 

have been nice to see certain puzzle 

mechanics explored in greater detail. 

But believe us when we say that this 

one you’ll have to discover for yourself. 

Instead, the game asks you to take the 

time to notice the details.

the bottom line. It’s not a 

particularly long experience or one that 

offers much replay, but the story of this 

lost phone is worth it. Kate GRay

creative, brain-teasing gem is well worth 

it, and we’d always rather have a handful 

of well-crafted levels than buckets of 

thoughtless ones.

the bottom line. A lovely, 

challenging puzzle game, made by some 

very smart cookies, that fully deserves 

your support. Kate GRay
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We’ve all done it, 
been late for that 
very important 
date. But what’s 

the worst you’ve had to face 
in terms of consequences? 
It’s not like your future self 
has upped and disappeared or 
anything, is it…?

Welcome to Causality. This 
puzzle game dabbles heavily 
in temporal tricks. Each level 

Causality
Time is a flat circle of your own missteps
$1.99  Developer Loju, playcausality.com

Platform Universal  Requirements iOS 9.0 or later

This route-blocking bollard 
will pop down just in time, 
thanks to Mr Purple there 
on the button.

Causality

   The time-travel mechanic is 
implemented in original fashion

   Maneuvering two versions of the same 
character at once is pleasingly tricksy

   Different puzzles stretch your brain 
in a variety of ways

   Rewinding can feel redundant 
when it’s easier to reset

great 

gives you one or more 
astronauts to guide to their 
color-coded end goals, and a 
particular number of turns in 
which to do it. The game’s 
basic mechanics are simple: 
a downwards swipe of your 
screen moves both spaceman 
and your turn counter on one 
space, while an upwards swipe 
rewinds them.

Your miniature Armstrongs 
follow certain rules: they carry 
on forwards unless directed 
otherwise – by yourself or by 
obstacles – and given a choice 
between left and right, will 
always opt for right. As a 
result, steering them as 
you’d like can take some 
lateral thinking. Puzzles have 
directional tiles whose guiding 
arrow can be rotated with a 
tap, and blocks that pop up and 
down at a press of a button can 
also help or hinder.

Then there are the portals. 
Arrive at one portal at a given 
point, and you’ll be whisked 
back a certain number of turns 
(which varies from puzzle to 
puzzle) to pop out from its 
twin. Essentially, it’s a way of 
buying yourself more time to 
carry out your objectives. But 
fail to arrive at said portal at 
the designated hour? That 
future-self avatar you’ve been 
directing about the map in 
tandem with old-you vanishes. 

If that sounds like there are 
a lot of moving parts to keep 
track of, it’s because there are 
– but in motion it’s all more 
fluid than words might 
suggest. The rewind mechanic 
is forgiving, and you’re never 
penalized for scrolling back 
as many turns as you like to 
iterate on a strategy. These 
aren’t always simple puzzles, 
but they are elegant ones.

the bottom line. If you 
take delight in tinkering about 
until you get something just so, 
this refreshingly original 
puzzler will push all your 
buttons. emma Davies

Hazards are 
flagged up on 
your timeline, 
so you can work 
around them.

62   spring 2017  maclife.com



Apple ships the iPhone and iPad 
with a strong array of apps to get 
you started with everything from 
messaging to tracking simple 
to-dos. But your world is strewn 
across medical documents, major 
projects, and sensitive information 
that all needs to be saved, tracked, 
or stored securely. So here are 
some great third-party tools for 
picking up where Apple left off.

Apple’s Health app is great for 
tracking things like daily exercise, 
menstrual cycle, and even 
nutritional intake. MyChart 
(Free, Universal) is for tracking 
the rest of your medical equation: 
documents, appointments with 
physicians, test results, and more. 
MyChart is gaining support across 
healthcare providers as a medical 
record and document hub, so 
there’s a good chance your doctors 
and their organizations support it, 
or will soon.

Over the years, Mint.com and 
its app Mint (Free, Universal) has 
become one of the go-to services 

for tracking and understanding 
your finances. A key feature is that 
it can watch transactions and 
finances across a ton of banks, 
credit cards, and investment 
accounts, as well as deal with  
other aspects such as the worth of 
your house and major purchases. 
You can build budgets to watch 
your spending, and enable the 
companion Mint Bills service to 
simplify and even automate paying 
your bills.

Passwords are a pain to 
remember, not easy or secure to 
share with others, and you risk 
your account safety if you use the 
same one everywhere. There also 
aren’t many easy ways to safely 
store sensitive family and legal 
documents. 1Password (Free with 
IAP, Universal) is a great solution 
for all of the above. It’s a password 
manager and secure wallet that can 
create long, unique passwords for 
all your stuff, log you in with one 
tap, store your sensitive 
documents, and securely share it 
all among your family or team.

You could spend days, even 
weeks, testing all the to-do and 

task and project apps available. 
We think trello (Free, Universal) 
is something special, with a unique 
design and flexibility that has 
something for everyone without 
dumping a mountain of features 
on you. You organize “cards” (like 
tasks or ideas) into lists across 
multiple boards, all which can 
contain attachments, comments, 
photos, and links. Trello is great 
for organizing your next party, that 
big project, or your company.

Now that we’ve tackled apps for 
your finances, health, and major 
projects, it’s time to tackle your 
kids’ chores. ChoreMonster 
(Free, Universal) is a good entry 
here, as it gamifies the system of 
assigning chores, applying 
rewards, and enabling everyone to 
track and contribute to the entire 
process. As your kids finish chores, 
they earn points they can use 
towards rewards you designate – 
video game time, ice cream, 
staying up later, you name it.

rounduP

5 apps to sort out your life
Deal with the big stuff in life using these helpful tools

By david Chartier

With Trello, you can organize all sorts 
of information in the way you want to.

Keep track of your body’s vital stats with 
MyChart – it can even liaise with your MD.

Kids love games, so why not make a game 
of doing their chores with ChoreMonster?
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A tip calculator seems like a 
natural fit for an Apple Watch 
app, yet so many developers 
seem to get it wrong. Many 
have the right idea but fail at 
execution, such as presenting 
a keypad that’s far too tiny for 
even averagely sized fingers to 
press correct digits.

Zane Tips attempts to rectify 
this problem by using voice 
input by default for subtotal 
and tip percentage, while 
retaining the option for 
tap-based numeric input in 
two different sizes: regular and 

Zane Tips
Not sure we’d tip even if this wasn’t free… 
Free  Developer Zane Innovations, zane-innovations.com

Platform Universal  Requirements iOS 8.0 or later

large. The app isn’t designed 
only for dining out in 
restaurants, but includes taxi, 
bags, and retail options as well.

It can also automatically 
record your current location 
from a comprehensive 
database of restaurants and 
other venues, and even 
monitors currencies from 
around the globe each day, so 
you have an idea of how much 
to tip (or not) if you’re abroad. 
However, that’s where the 
good news ends.

The iPhone app is a 
confusing mishmash of user 
interface concepts and styles, 
and the color schemes are 
quite an eyesore as well. It’s 
also riddled with in-app ads, 
although thankfully that 
doesn’t affect Apple Watch 
usage. The tip calculator in 
the universal app is downright 
ugly, so you probably won’t 
want to venture beyond 
watchOS anyway – and stay far, 
far away from the iPad version 
if you value your sanity.

One bright spot in the 
iPhone app is the handy 
satellite-based map view of 
nearby eateries, which works 

well when trying to find 
something nearby. But in 
general, this is an app with 
too many ideas, and few gel 
together the way we’d like.

the bottom line. Zane Tips 
makes a decent Apple Watch 
tip calculator, but the rest of 
the app is a mess. 
J.R. bookwalteR

Zane Tips

  Voice or text input

  Two numeric keypad sizes

  Ugly, ad-infested interface on iOS

   Apple Watch offers too many buttons 
for simple tasks

weak 

This one’s for  

Apple Watch 

Series 2 owners 

in the crowd:  

To check the  

time without the 

bother of raising 

your wrist, rotate 

the Digital Crown 

upwards with a 

finger to see the 

selected face fade 

into view. Be sure 

to enable General 

> Wake Screen > 

Wake Screen on 

Crown Up first. 

watch tiP

Time sneak peek
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The idea of watching 

videos on a tiny Apple 

Watch display may 

sound absurd, but as 

noted previously in 

these pages, it’s one 

developers continue 

to explore. The latest to make the effort 

is Video on Watch, which allows iPhone 

owners to transfer videos stored in the 

Camera Roll or iCloud Photo Library 

and play them back on Apple Watch.

The app works surprisingly well, and 

is easy to use. From the iPhone app, 

select a video in your Camera Roll, 

optionally trim the head and/or tail, 

then tap Choose to save an optimized 

version inside Video on Watch. Choose 

one or more videos to transfer, tap the 

Watch icon at the bottom, and within 

seconds they’re transferred, ready for 

playback on your wrist, even without a 

connected iPhone.

16:9 videos look tiny on Apple Watch, 

but double-tapping zooms the center 

to fill the screen. You can also control 

audio volume by turning the crown. 

the bottom line. It’s a crazy idea 

but by golly, it really works. 

J.R. bookwalteR

Here’s another 

attempt at gaming 

on a smartwatch that 

mostly gets it right, 

but again lacks in the 

audio department.

Bit Soccer works 

only on Apple Watch. The object is to 

dribble a soccer ball down the field, 

dodging opponents and picking up 

trophies along the way. To maneuver, 

simply turn the Digital Crown to move 

your player up or down, and a red 

exclamation point on the right edge of 

the screen gives you a heads-up when 

an opponent is coming, providing ample 

time for you to get out of the way and 

carry on running.

Bit Soccer is a fun way to kill a few 

minutes, and because the sound effects 

are limited to a simple three-tone 

melody whenever an opponent stops 

you in your tracks, it’s good for not 

disturbing those around you; we do 

wish there were a few more sounds 

to enjoy, though.

the bottom line. Bit Soccer is 

one of the better Apple Watch games 

we’ve seen, but could use a bit more 

audio. J.R. bookwalteR

Video on Watch
Video. On Watch. Any questions?
$0.99  Developer Davide Rossetto, daviderossetto.it

Platform watchOS, iPhone  Requirements iOS 9.0 or later

Bit Soccer
A soccer field in 92,480 pixels
$0.99  Developer Miguel Muñoz, lolaturtle.com

Platform iPhone, watchOS  Requirements iOS 9.3 or later

greaT 

good 

Get RewaRDeD 

Stocard makes it fast and 

easy to earn rewards from your 

favorite retailers. First, download 

the free iPhone app and start 

entering all your loyalty cards.

Flick YoUR wRiSt 

When a barcode appears 

on your Apple Watch’s screen, 

simply extend your arm, have it 

scanned, and start racking up big 

savings on future purchases.

watch wallet 

Once at the store and ready 

to check out, launch Stocard on 

Apple Watch and then select a 

retailer’s logo or name from the 

color-coded list.

how to

Display rewards 
cards on Watch
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G
oPro is a name that has become synonymous with folk who like to throw 

themselves off mountains at the weekend. However, a whole host of 

rivals has been attempting to muscle in on the extreme sports video 

camera market of late, thus the entire GoPro lineup has been refreshed; 

it now starts with the Hero Session, moves up to the Hero5 Session, and 

tops out with the high-spec Hero5 Black.

There are plenty of new features for “gnarly” types to sink their teeth into, 

including a rear touchscreen, voice activation and super-easy, one-button 

control; the overall experience has been revamped to make capturing the 

action as painless as possible. The Black still shoots 4K video at 30fps, 

snaps 12MP images, and offers ultra-smooth, super-slow-mo opportunities 

with 1080p video at 120fps. Stills can be taken in single, burst, and time-lapse 

mode, as well as saved as raw files for further editing. A new WDR (Wide 

Dynamic Range) mode – GoPro’s version of High Dynamic Range – makes 

shooting perfectly exposed still images much easier. This takes multiple shots 

at different exposures to nail the perfect image.

For the first time, the unit is waterproof to 33 ft, meaning the bulky plastic 

housing is only really required when filming in extremely deep, dusty, or dirty 

areas. The dual microphone setup now offers enhanced wind-noise reduction, 

too. Lone users can now bark commands, such as “GoPro, take a picture” and 

“GoPro, shoot burst,” to get the camera rolling. Voice activation, though, is 

successful maybe 70 percent of the time.

In most lighting conditions, GoPro footage is sharp, with particularly 

vibrant colors. The addition of video stabilization is also a big plus, as footage 

is much smoother than before. The camera isn’t without a few minor issues, 

the first being the rear touchscreen display; this is annoyingly unresponsive 

to wet or muddy fingers, and simply refuses to play ball when it’s raining. 

We also found that the lens started to steam up after a spell near water. 

the bottom line. This is a superb action cam – the best you can get, 

in fact. It’s a great evolution of the existing line. leon Poultney

GoPro Hero5 Black
Like things extreme? Take it up a notch, brah
$400  manufacturer GoPro, gopro.com

Features 4K 30fps/1440p 80fps/1080p 120fps video, voice activation, 
video stabilization, waterproof to 33ft

GoPro Hero5 
Black

   Voice-activated 
camera control

   Improved video 
and stills

   “Wide” dynamic 
range mode

   Fiddly rear touchscreen

Great 
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GoPro’s attempt to retake 
its crown with the Hero5 
Black is wholly successful.
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Distraction-free writing apps are becoming 
a big industry on Mac and iOS, meaning that 
any new ones need to do something very 
clever to stand out. Tabula (styled with a 
backtick ` before its name on the App Store) 
does that with its clever auto-formatting.

The idea is simple: you write a plain text 
document without worrying about breaking 
your flow to denote whether something is a 
list, or a link, or a headline, and so on. The 
app detects whether it thinks a line you’ve 
written should be styled that way, and  
automatically does so. When you eventually 

export the document, it will be professionally 

laid out, with no effort on your part – or at least, 

that’s the theory. 
Obviously, how well the app works 

depends entirely on how smart its detection 
is. In reality, you kind of need to know how 
to get it to trigger, which takes some trial 
and error. But it could still be preferable to 
having to reach for the extra symbols even 
of Markdown, which is really the simplest 
way to style plain text as it stands (and is 
supported by many distraction-free editors).

A heading, for example, must either be 
very short, or written in all capitals, or with 
a capital at the start of each word for Tabula 
to interpret it as such. Easy once you know, 

Tabula
No need for manual formatting <i>here</i>
$9.99  Developer Charles Imhoff, tabula.cpimhoff.com

Requirements OS X 10.10 or later

Tabula

   Write quickly,  
but using styles

  Creates different looks

   “Auto” styling requires 
a bit of learning

   Output options limited

GOOD 

but it took us a few attempts to confirm. 
Similarly, you can create two-column tables 
(a feature we particularly appreciate) by 
entering what should be in the first column 
using the style of a heading, followed by a 
dash, then writing the second half however 
you want. You can emphasize any text with 
the use of a backtick. One useful trick is that 
you can tell the styling engine to ignore a 
line by using a keyboard command, should it 
be adding some styling that you don’t want.

When it comes time to finish and export, 
you click the symbol in the top-right corner. 
You can choose from a range of different 
looks for your final document, each of which 
styles the various elements differently, and 
then export as PDF or HTML. These are fine, 
but we do wish we could get an RTF file or 
equivalent so the output could be used live 
in another document, or the fonts tweaked.

Tabula also has the now seemingly 
obligatory night mode, and a good set of 
customization options. There’s also an iOS 
app, which works essentially the same way.

the bottom line. Tabula makes it easy to 
turn a few notes into a styled, professional-
looking doc, but it takes some figuring out, 
and we want more flexibility. matt bolton 

Tabula includes support 
for a bunch of useful  
text-styling options.

Different output styles create a totally different vibe for 
your document, from the simple to the colorful and cool.

>>>Reviews

68   spring 2017  maclife.com



Time is money. But how much time equals how much 
money? AutoPrompt can help you answer that by logging 
how much time you spend on particular tasks. That data 
then enables you to predict how much time you’ll need to 
do those tasks in the future, and you can take the data into 
another app to invoice for billable hours if that’s the line 
of work you’re in.

AutoPrompt is small and simple, living in the menu bar 
until you invoke it or a preset time has passed. If it’s the 
former it asks what you’re doing and starts recording the 
time; if it’s a preset alarm, the app asks if you’re still doing 
the same task and if you need more time to complete it. 
You can specify your daily working hours and how often 
you should be prompted in the app’s preferences. 

At the end of the day you can then see exactly how long 
you’ve spent on each thing in hours, minutes and seconds, 
and you can go back to look at historical data too. You can 
print the day’s tasks, send the data as email, or export to a 
text file. And that’s pretty much it. You can’t run multiple 
timers concurrently or group tasks into projects, and 
there’s no financial component to calculate billable totals. 

the bottom line. A simple time tracker that’s probably 
too simple for most professionals’ needs. gary marshall

If you miss the convenience of tracking finances 

from Mint’s discontinued menu bar app, there’s an 

alternative. But prepare for sticker shock: While 

free to download, Balance requires a recurring 

subscription based on the number of accounts 

you want to monitor, from $4.99 per month.

Yes, it’s expensive, but the developers justify 

the cost by supporting more than 9,000 financial 

institutions. Balance gets most details right: You 

can search transactions, and create notification 

rules triggered when banks charge a fee, or if you 

spend more than a certain amount in a single 

transaction. The tabbed window enables fast, easy 

access to Accounts, Transactions, Notifications, 

and Insights – a peek into your spending habits.

Still, we couldn’t log into three different PayPal 

accounts (which complained about incorrect 

credentials), although other accounts like Chase, 

Capital One, Amex, and Discover worked great.

the bottom line. Balance is a handy menu 

bar app for keeping tabs on personal finances, but 

convenience comes at a price. J.r. bookwalter

AutoPrompt
Keeping track of your toil
$2.99

Developer Inspiring Life Technologies, inspiringlife.co

requirements OS X 10.10 or later

Balance
Want to see yours? It’ll cost
Free (subscription required)

Developer Balanced Software, balancemy.money

requirements OS X 10.10 or later

AutoPromPt

  It’s simple

  It’s cheap

   Only one timer at a time

   Tasks can’t be grouped

greAt 

BAlAnce

  Securely supports over 9,000 financial institutions

  View accounts, transactions, notifications, or insights

   Expensive

   Couldn’t log into three different PayPal accounts

good 

Tough testing, trusted ratings
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MacOS’s sound control in the menu bar gives 
you a reasonable degree of control over 
settings: a master volume slider, a list of 
available output devices, and, by holding Alt, 
input devices too. However, adjusting the 
volume of your microphone or system sound 
effects means going to the relevant tab in the 
Sound preferences pane.

SoundSource’s developer proclaims it to 

be “the sound control that should be built into 

macOS.” For starters, there’s no need to 
remember you can hold down a modifier key 
to switch to a different input device; the top 
three groups in the menu are for switching 
inputs and the destinations for master 
output and sound effects, each with their 
own volume slider. 

Controlling the volume of sound effects 
is an especially nice touch if you want to 
temporarily mute system alerts, for example, 
yet still want other sound to play – perhaps 
an ambient soundtrack in iTunes that helps 
you focus. This is a cinch with SoundSource, 
and we soon got into the habit of using its 
menu to toggle effects; doing it this way 
was less aggravating than having to dip into 
System Preferences.

The app also provides a Play-Thru window, 
where you can redirect an input to a specific 

SoundSource 3
A menu for control of almost all of your Mac’s audio
$10  Developer Rogue Amoeba, rogueamoeba.com

Requirements OS X 10.10 or later

SoundSource 
3.0.2

   Input, output and 
effects volume sliders

  All controls revealed

  A little expensive

  No AirPlay support

SoLId 

output device, and adjust the volume and 
channels used for each of those devices. You 
might use this to monitor an input through 
headphones, for example, though output is 
subject to a delay of a second or so.

SoundSource costs ten bucks, which looks 
a little costly when you think of how little it 
does. It would do more to justify its price if it 
complemented macOS’s built-in keyboard 
shortcuts for the master output volume with 
its own for input and sound effects, say, to 
save you opening its menu to adjust them.

Cost is a relatively minor gripe compared 
to an issue that’s outright disappointing if 
you’re heavily invested in Apple’s audio 
ecosystem. Although speakers and mics 
connected using a cable or over Bluetooth 
appear in SoundSource’s list of available 
outputs, AirPlay speakers and Apple TV units 
do not. If you send your Mac’s audio to that 
type of output, perhaps because you have 
wireless speakers in various rooms at home, 
you may find it better to stick with macOS’s 
built-in sound control.

the bottom line. A helpful controller 
for cabled or Bluetooth audio control, but 
useless for AirPlay. AlAn StonebRiDge

macOS is able to detect 
built-in, Bluetooth and 
AirPlay devices, but 
SoundSource ignores 
the latter entirely.

Play-Thru can redirect audio from and to your choices of 
input and output, or whatever the system has chosen.

>>>Reviews
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Heredis 2017 World is the latest Mac 
edition from a French developer with 
more than two decades of experience 
in the field of genealogy. The tool’s 
interface is comprehensive and highly 
customizable, but clearly leans toward 
those in the professional arena compared 
to MacFamilyTree, a more intuitive 
application which remains a better 
choice for novices.

With the 2017 release, Heredis 
attempts to curtail some of its complexity 
with the Dashboard, a widget-based 
information window that provides quick 
statistics on family members, births and 
deaths, events, surnames, and searches.

Despite its unwieldy interface, Heredis 
2017 World is immensely helpful in other 
ways, such as flagging entries that have 
potentially incorrect dates or other 
information. Little conveniences abound, 
such as a pop-up menu when entering 
countries for events; plus the ability to 
transfer footnotes or sources to Microsoft 
Word-formatted documents, create 

charts, or even print a book of your 
entire tree, complete with photos.

Other additions include combined smart 

search criteria for faster results, improved 

find/replace options, and the ability to share 

family tree files with iOS or Android devices. 
Although Wi-Fi sharing is quick and easy, 
Heredis lacks true two-way sync between 
desktop and mobile, so changes made on 
your iPhone or iPad aren’t automatically 
updated on the Mac side.

To facilitate genealogy searches, the 
software links directly to Heredis Online, 
the company’s web-based database where 
people can publish family trees to share 
with others, as well as conduct further 
ancestral research. Our first attempt to 
register for this free service was stymied 
by a validation email that never arrived 
in our iCloud email account, but a second 
attempt via Gmail worked fine.

the bottom line. Not as easy to use as 
MacFamilyTree, but Heredis 2017 World 
offers more comprehensive tools in a 
flexible interface. J.R. bookwalteR

Heredis 2017 World
Who do you think you are? Find out
$49.99  Developer BSD Concept, heredis.com

Requirements OS X 10.9 or later

Heredis 2017 
World

   Customizable 
Dashboard widgets 
for quick details at 
a glance

   Robust print and 
sharing options

   Less intuitive for 
novice users than 
MacFamilyTree

   Cumbersome sharing 
to mobile devices

good 

Family trees are better 
with visuals, and Heredis 
2017 World allows you to 
import images so that 
everyone looks better.

Tough testing, trusted ratings
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W
e were beginning to fall a little out of love with Logic Pro X. What used 

to be a lean, mean, music production machine had become sluggish 

and crashy, and we found ourselves dreading even simple tasks such 

as bouncing tracks, because they’d often take down Logic completely. But 

version 10.3 fixes that, and introduces some important improvements too.

The most obvious difference is the revised interface, which is flatter, 

lighter, and less likely to give you eye strain. With Advanced Tools turned off, 

the app looks more like GarageBand than ever, although pro users won’t see 

the fake woodgrain. If you’re a GarageBand for iOS user, you’ll love the new 

export feature: You can flatten your project, work on it in GarageBand, and 

then bring the amended version back in as a proper Logic project again. 

That’s great not just for mobile musicians, but for podcasters too: You can go 

out, record new audio and put it straight into your project even when you’re 

far from your Mac.

The other obvious new feature – if you have a new MacBook Pro – is Touch 

Bar support, which is very clever. You can use it to control track playback, to 

get quick access to key effect settings, or to navigate the timeline, and you 

can even use it to play software instruments or trigger drums. 

There are new tools for all other Macs too. You can now use the Fade tool 

to fade multiple tracks at once, and the new selection-based processing 

enables you to apply groups of effects and/or plugins to a selected region or 

regions. That’s particularly useful for fixing the odd fluffed note or unwanted 

plosive, but you can also use it to apply all kinds of things to a specific area. 

The new track alternatives capability enables you to store multiple versions 

of the same song in one project, so you can play with different arrangements. 

Under the hood, the summing engine has been upped to 64 bits – a kind 

of Retina for audio – and there’s support for up to 256 busses, genuine stereo 

panning, and music XML. Software instruments can now trigger sidechained 

plugins, and MIDI plugins can control other plugins’ parameters.

If you’re a GarageBand user, it’s never been easier to go pro with Logic: 

with is Advanced Tools off, Logic feels like a kind of GarageBand Pro.

the bottom line. Just when we thought we were out, Logic brings us 

back in again: 10.3 is rock solid, with useful new features. gary marshall

Logic Pro X 10.3
Touch Bar support – and much more
$200 (free for existing users)  Developer Apple, apple.com

requirements OS X 10.11 or later, 4GB RAM 

Logic Pro X 10.3

  Track alternatives

   Selection-based 
processing

  Touch Bar support

   No new Drummer 
genres

great 

>>>Reviews
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If you want to run Windows apps or games 
on your Mac, CrossOver offers a potentially 
elegant – and cost-effective – solution. You 
don’t need to buy a copy of Windows, and 
you don’t need the hassle of setting up Boot 
Camp or a full-blown virtual machine just 
to run one program. 
CrossOver is based on the open-source 

Wine project. You basically install Windows 
programs into self-contained “bottles,” 
which run a skeletal version of Windows – 
from 98 up to Windows 10. There’s no 
underlying desktop environment; instead, 
bottles can simply be accessed and run 
directly from your Mac desktop as if they 
were native apps.
The downside is that CrossOver isn’t 

guaranteed to work with all programs – and 
even those that are supported can be buggy, 
crashing or not behaving as you’d expect. 
This is why trying the 14-day trial before 
purchase is essential. If it’s a commercial 
title, you’ll probably need to provide the 
original installer disc (Remote Disc works 
well, if required). Even if a program isn’t 
listed in CrossOver, that doesn’t mean it 
won’t work; many simply haven’t been 
tested, while others require a bit more effort 
(with the caveat that they may not work). 

CrossOver Mac 16
A quick, cheap way to run Windows apps on your Mac
About $47  Developer Codeweavers, codeweavers.com

Requirements OS X 10.8 or later, optical drive for some program installations

Crossover 
MaC 16

   Integrates Windows 
programs with macOS

   Easy to use, yet flexible

  Excellent value

   Not all apps supported

great 

You can create your own bottles from 

scratch, add prerequisites for your program 

(such as the .NET Framework) and then attempt 

to install apps yourself. You can tweak bottles 
too, to try to improve performance, boost 
compatibility, or simply integrate them 
better with your Mac desktop. In version 16, 
the underlying engine has been updated to 
Wine 2.0, plus there’s now support for Office 
2013 and 64-bit bottles – the latter should 
improve performance and compatibility.
CrossOver has always sold itself as a more 

user-friendly front-end for Wine; version 15 
added a redesigned wizard to make verifying 
and installing any of the 13,000 or so 
programs in its database as easy as possible, 
and there’s also a much-improved bottle 
management page for viewing, launching, 
and editing your Windows apps.
Crossover will ultimately be judged on its 

results, but if you can get them working, 
you’ll find it’s the most elegant solution for 
integrating old Windows apps and games. 
We recommend you pay a bit extra for the 
$60 package, which comes with one year’s 
free updates and support, in which time 
more apps should become compatible.

the bottom line. A smart, effective 
and great way to run selected Windows 
apps on your Mac. nick PeeRs

CrossOver is cheaper, 
quicker, and more elegant 
than using a full-blown 
virtualization solution.

CrossOver allows you to configure your “bottles” 
to fine-tune program performance and stability.

>>>Reviews
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One thing Microsoft Windows still does better than macOS 
is to provide shortcuts that quickly snap windows to preset 
areas of the desktop. Magnet adds something similar to 
your Mac, so you can make a window fill a half, quarter, or 
– new in this version – columnar thirds by dragging to a 
screen edge or corner.

A gray overlay indicates the area a window should fill 
when you let go of it. If it needs more space, another overlay 
tells you why. Some apps require minimum widths, which 
can mean snapping to thirds of a screen’s width is more 
useful on large desktops than on a MacBook; sadly, there’s 
no way to divide the screen into a finer grid.

Helpfully, Magnet memorizes the previous dimensions of 
a window and restores these when you drag a window away 
from its snapped position. One thing we’d like to be refined 
is the ability to fill the desktop by dragging toward the 
screen’s top edge; there are only a few rows of pixels 
between triggering that or the Mission Control shortcut.

the bottom line. Magnet’s new features work best with 
a big desktop. Though more powerful options exist, this one 
is a natural-feeling Mac enhancement. AlAn Stonebridge

This tiny utility adds an icon to the menu bar that 

enables you to connect or disconnect a particular 

Bluetooth device from your Mac with a single click. 

You choose which device from your Mac’s list of 

Bluetooth devices, and you can set a global 

shortcut, so you don’t even need the menu icon.

It’s designed for AirPods, really: any other 

Bluetooth audio device must be actively 

disconnected from any other devices it’s working 

with before you can connect it from your Mac. 

Apple’s smarter wireless tech in the AirPods 

doesn’t require this, and can switch seamlessly as 

soon as you click Tooth Fairy’s icon – and it works 

great for this, enabling connections in fewer clicks 

than the Bluetooth menu.

It’s still kind of useful (if less instant and 

convenient) for other Bluetooth headphones and 

speakers. But it’s very limited – being able to have 

icons/shortcuts for more than one device would 

be good – and we encountered a stability problem 

when changing which device it worked with.

the bottom line. Good for AirPods users, 

middling for others. But cheap! mAtt bolton

Magnet 2.0
A wonderful window-snapping add-on
$4.99  developer CrowdCafé, magnet.crowdcafe.com

requirements OS X 10.9 or later

Tooth Fairy
Ideal for AirPods
$0.99  developer Robin Lu, robin.github.io

requirements OS X 10.11 or later

Magnet 2

  Simple, intuitive actions

  Snapping to thirds is well implemented

  Logical predefined keyboard shortcuts

   The maximize action remains awkward

excellent 

tooth Fairy

  Connect and disconnect in one click

  Set menu bar icon or global hot key

  Only works with one device

   Bluetooth limitations hamper non-W1 devices

good 

Tough testing, trusted ratings
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B
ragi came on the scene in 2014 with 

a bold Kickstarter campaign to launch 

The Dash, a pair of wireless earbuds. 

Now it’s back with The Headphone… and, 

fortunately, the hardware is nowhere 

near as clunky as that name.

Wireless headphones complement a life full 

of sound on the go in ways you may not have 

realized. These earpieces are light, fit snugly 

and after a while you fail to notice they’re 

even there. The look of The Headphone is 

simple and unflashy – essentially, black plugs 

that cover the entire ear canal. Wear the 

right hat, and no one could tell you have 

them in at all, as opposed to the relative 

ostentation of Apple’s AirPods. In addition, 

they use the intricate architecture of the ear 

to hold them in place, making you feel quite 

secure about them staying in.

They also offer Audio Transparency, which 

filters through the ambient noise of the city 

and places the music as a backdrop – or you 

can stick with the regular full-on sound. The 

Headphone leaves you feeling as though 

you’re in a world of your own choice of sound. 

And very little gets in the way – even getting 

home and needing to remove your sweater 

is now issue-free, as opposed to a previous 

wired life where this simple action could 

leave you horribly contorted and entangled.

The controls are simple. Three buttons on 

the right earbud cover everything you need: 

power, connect Bluetooth, adjust volume, 

skip a track, or queue up Siri. As these are 

rubber-covered, this initially resulted in us 

prodding and squidging them far too hard; 

in fact, they’re sensitive enough that just a 

slight pressure is sufficient to operate them. 

The audio stops when you remove the right 

earbud and restarts when you replace it, 

but we had issues with them restarting the 

music (and thus draining the battery) when 

not in our ears.

However, there are few drawbacks to 

The Headphone. The batteries last well, 

the sound is great, they do the job without 

drawing attention to themselves – but 

they cost $150. In a way, that’s inevitable: 

they’re simply at the head of the line for 

wireless headphones.

the bottom line. If you’re happy to pay 

the price, you won’t be disappointed with The 

Headphone – but you may stumble over that 

name a few times. Simon Kirrane

Bragi The Headphone
Wireless earplugs from the Kickstarter kings
$149  manufacturer Bragi, bragi.com

Features Bluetooth 4.0 A2DP, Audio Transparency, six hours’ play time, passive noise isolation

Bragi The 
headphone

   Simple to use

   They make  
listening fun!

   Some problems with 
music restarting

  Expensive

greaT 

>>>Reviews
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T
his is a router with few style pretensions. 

It looks like a piece of kit that would be more 

at home in a small-to-medium sized office 

than a stylish San Francisco apartment, but its 

big, brash design enables Linksys to pack in 

some pretty meaty hardware.

The WRT3200ACM boasts MU-MIMO that 

allows for simultaneous streaming, file sharing, 

and gaming on multiple devices over the AC 

band. It also includes “Tri-Stream 160” 

technology, which doubles the available 

bandwidth for each channel from 80MHz to 

160MHz; in other words, it can handle more 

data, more quickly.

Also impressive is how readily the 3200 

embraces custom open-source firmware such as  

OpenWRT. This allows you to install an entirely 

different OS to the default, giving you almost 

complete control over the features and functions 

of this router down to a very low level of 

hardware. It’s an advanced technical feature for 

sure, and the built-in software is perfectly fine as 

it is, but the option is there for technical users.

So how does it perform in practice? With our 

wireless device connected to the 5GHz network, 

we recorded a speed of 133Mb/s and 13ms ping 

when close to the router. Testing from around 

30 feet away, we got even better results with 

159.73Mb/s and 13ms.

However, once we started putting walls 

between us and the router, performance dropped 

off, with the device sometimes struggling to 

keep a WI-Fi connection. With one wall, speeds 

dropped to 67.29Mb/s with a ping of 8ms. With 

two walls between, they dropped even more 

dramatically to 3.97Mb/s.

This is a surprise – we had high hopes for this 

router in terms of Wi-Fi performance. If you have 

a large house or office, and rely on consistent 

and fast Wi-Fi, you’re going to need to look at 

extenders, or carefully consider the position 

and antenna arrangement of the 3200.

the bottom line. This is an excellent 

router that’s packed full of features at a good 

price. Sadly, though, Wi-Fi coverage isn’t as 

impressive as we had hoped. matt hanson

Linksys WRT3200ACM
A powerful router with open-source compatibility
$249.99  manufacturer Linksys, linksys.com

Features 1.8GHz dual-core CPU, MU-MIMO, 2.4/5GHz bands, Tri-Stream 160, open-source ready

Linksys 
WRT3200ACM

   Open-source  
firmware support

  Excellent features

   Bandwidth-widening 
options

   Spotty Wi-Fi coverage

good 

>>>Reviews
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Having ports on the back of Mac desktops makes them look 
good, but it’s not always the most convenient thing. This 
hub borrows the styling of Apple’s Magic Trackpad and 
keyboard (though, slightly awkwardly, the last generation 
of them, rather than the currrent style), and gives you three 
USB 3.0 ports, an SD card reader, and a microSD card reader, 
with a single USB Type-A cable that connects to your Mac. 

Mostly, it works great. With two drives connected 
through it, data rates were almost exactly the same as with 
the drives connected to the Mac directly. It also pushes 
enough power to charge an iPad. However, be warned that 
if you connect too many things at once, you may overload 
its power capabilities – our two drives stopped transferring 
once we connected the iPad. (Your Mac will warn you if this 
is the case.) Personally we’d have liked a fourth USB over 
the microSD reader, but it’s still great.

the bottom line. An excellent, useful USB hub. It’s fast, 
looks good, and has a great price. matt bolton

A big draw of Apple’s newest notebooks is that 

they’re more portable – but their power adapters 

are still the same bricks, mostly. The FINsix 

DART-C fixes that for 12-inch MacBooks and 

13-inch MacBook Pros (it’s rated at 65W, enough 

for those two, but the 15-inch model’s adaptor is 

87W, so you could only slow-charge it). It’s a small, 

light power adapter with a 6-foot USB-C cable 

which works great: It charged a 12-inch MacBook 

from dead to 100% in two hours, without getting 

overly hot (just warm).

The potential downside is that it uses its own 

proprietary cable, but that fact does give it one 

more trick up its sleeve: The cable has a female 

USB connector, so you can charge your iPhone 

(or another device) from it while charging your 

notebook. However, while this is rated high enough 

for iPads, our 9.7-inch iPad Pro didn’t get any 

charge from it in practice. The DART-C also comes 

with a Velcro cable wrap, microfiber bag, and is 

rated for worldwide use.

the bottom line. A great, travel-friendly 

MacBook charger. matt bolton

Satechi Aluminum USB 
3.0 Hub & Card Reader
More (or easier) ports for your Mac
$29.99  manufacturer Satechi, satechi.net

Features Three USB 3.0 ports, SD and microSD card reader

FINsix DART-C
A smaller MacBook charger
$99.99  manufacturer FINsix, finsix.com

Features 65W, USB-C male, USB-A female

Satechi aluminum uSB 3.0 huB & card reader

  Fast multi-USB connectivity 

  Looks smart and Mac-like

  Passes through enough power to charge iPad

   Is microSD the best use of space?

excellent 

FinSix dart-c

  Very small and portable

  Generous 6-foot cable

  Extra USB charging connector

   No standard USB-C cable support

Great 

Tough testing, trusted ratings
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S
hould your experiments with the likes of GarageBand and Logic 

have moved into more serious music production territory, you 

may find yourself ditching desktop speakers in favour of a pair 

of proper monitors. While regular speakers are great for listening 

to professionally recorded music, they’re not designed for mixing 

your own. That’s where monitors come in: rather than prettifying 

music with overemphasized frequencies, they offer an honest, 

uncolored representation of the sound, which helps to make the 

finished mix sound great on a range of playback devices, from 

soundbars to headphones and car stereos.

The problem with most monitors is their size: they’re not exactly 

practical for regular desks, and are often overpowered for small 

rooms. Hence the iLoud Micro Monitor system from music-making 

experts IK Multimedia. As their name suggests, these speakers 

are smaller than average for monitors and more akin to standard 

desktop sets, yet still pack a healthy 50W output, thanks to a pair of 

3-inch woofers, 3/4-inch tweeters and bass reflex ports. They come 

with standard RCA connectors to hook up to your audio interface, 

as well as a 3.5mm cable for other devices, while Bluetooth 

connectivity is also thrown into the mix.

As you’d hope, the iLoud delivers the flat frequency response 

you need for recording and mixing, with smooth, rounded highs 

and robust but not overbearing bass – a built-in tilt stand allows 

you to optimize the sound direction, too. Versatility comes via a trio 

of switches around the rear, which allow you to tweak the speakers’ 

EQ response. Not only do these help to adjust the system to your 

music-making environment, but they can tailor your music-listening 

experience as well. That’s particularly handy given the onboard 

Bluetooth connectivity, which is hardly an essential feature for 

pro music production, but a welcome addition nonetheless. Less 

welcome is the rearward positioning of the speakers’ power switch.

IK Multimedia has really hit the nail on the head with the Micro 

Monitor: it provides a convincing compact setup for budding 

production types or music-makers on the move. There are cheaper 

monitors out there, but none that can match the level of audio 

quality from this kind of physical size.

the bottom line. A practical and portable monitoring setup 

for newcomers and seasoned pros alike. michael astley-brown

iLoud Micro Monitor
Compact monitors for music-makers
$299  manufacturer IK Multimedia, ikmultimedia.com

Features 50W output, RCA/3.5mm inputs, Bluetooth, 3x EQ sliders

IK MultIMedIa 
iloud MIcro 
MonItor

   Excellent sound from 
a small size

    EQ sliders offer 
versatility

   Bluetooth is always 
welcome

   On/off control is a little 
tricky to access

excellent 
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W
acom’s Intuos 3D is essentially a bundle to 

get you up and running with 3D sculpting. 

The box comes with a download code for 

the powerful ZBrushCore from Pixologic, a more 

newbie-friendly version of its industry-leading 

3D sculpting software. Also included is time-

limited access to ZBrush training videos that 

will be particularly useful if you’re a newcomer.

The plastics used for the Intuos 3D are hard 

and brittle-feeling; everything feels a little 

cheap, including the stylus and the buttons on 

the tablet itself. However, interacting with it is 

very positive and feels good in extended use, 

which is important as this kind of tool often 

supersedes the use of a mouse. The button 

clicks, on both tablet and stylus, feel responsive, 

with buttons programmed out of the box with 

ZBrushCore commands, making for less time 

spent hunting round menus.

The most important element of using a tablet 

is how the nib feels on the active surface; while 

you might expect this to match the hard, brittle 

feeling elsewhere, it’s a pleasant experience. 

If the stylus had the soft rubber grips of other 

Wacom styluses, this would be a real joy. As it 

is, drawing and sculpting feels good. The nib 

runs smoothly over the surface and is also 

replaceable, though not with the variety of nib 

types the Intuos Pro offers. You may appreciate 

the grid of dots on the tablet’s active area, but 

they could prove to be a distraction. Either way, 

they don’t interfere with its operation at all.

For traveling, the stylus can be stored in a 

handy fabric loop at the top of the tablet and 

the USB cable can be detached. There’s also an 

option for a wireless kit, similar to other Wacom 

devices, with a small dongle that plugs in 

unobtrusively. Wacom also offers fitted cases.

The overall experience with the Intuos 3D is a 

good one. It’s a fantastic value bundle and would 

be worth shortlisting simply for the device alone. 

Admittedly, some of the materials don’t feel the 

best, but you soon forget that.

the bottom line. This is an excellent 

choice if you’re looking to delve into 3D, or 

want your first tablet. Rob Redman

Wacom Intuos 3D
The tablet giant introduces an interesting new format
$200  manufacturer Wacom, wacom.com

Requirements USB port, internet connection, CD/DVD-ROM drive, OS X 10.8.5 or later

Wacom Intuos 3D

  Excellent accuracy

  No lag

   Great introduction 
to 3D sculpting

   Plastics feel cheap

great 
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The HD60 S looks and works almost exactly like its HD60 
predecessor. It takes an HDMI input from a game console, 
for example, and passes it through to a TV (with no latency 
that we could detect) and also over USB to its app on your 
Mac. There you can record it, or broadcast live – with 
optional overlays and a voiceover – to services such as 
Twitch and Ustream.

Its key feature is Instant Gameview. This reduces the 
latency seen in the preview on your Mac from the two 
to three seconds that previous models suffered to a tiny 
duration. This isn’t designed so you can play on your 
Mac’s screen, but to make life easier and your broadcasts 
potentially more professional by reducing the disconnect 
between screen and stream.

The need for a fourth-gen or better Core i5 processor 
and an AMD or Nvidia GPU may exclude your Mac from 
compatibility; it worked well on our MacBook Pro, though 
even that couldn’t deal with the app’s 60fps preview. Note 
that the frame rate on recordings is unaffected by this.

the bottom line. A good tool if you’re serious about 
broadcasting your gaming. AlAn Stonebridge

Plug this dongle into your parked car’s cigarette 

lighter port (with the engine on), sync it to your 

iPhone using the Zus app, and its map will guide 

you back when you need to retrieve your car. 

The app has some nifty features. Set up a 

parking alarm and it’ll buzz you 10 minutes before 

your time is up. Share your location with select 

contacts so lift-sharers can find you. The dongle 

has two built-in USB ports that can charge two 

iPad Pros simultaneously, and can even monitor 

your car’s battery health and calculate trip costs. 

But do you need it? You can already mark, 

track, and share locations with Maps, and set up 

parking alerts in Reminders and Siri. Zus gives  

you the convenience of that bundled into one app, 

but it won’t work in covered locations like an 

underground parking garage. 

the bottom line. The Zus offers plenty of 

useful features, but you’ve already got many of 

them on your iPhone. Alex blAke

Game Capture HD60 S
Boost your gaming broadcasts
$179.95  manufacturer Elgato, elgato.com

Features USB 3.0 (Type-C to Type-A) cable, 2m HDMI cable

Nonda Zus Smart 
Car Charger
But is it smart enough?
$29.99  manufacturer Nonda, nonda.co

Features 2x USB ports (4.8A), Bluetooth

elgato game Capture HD60 S

  Miniscule latency

  Capable of 1080p, 60fps recording

  Live Commentary features

   Demanding Mac system requirements

exCellent 

nonDa ZuS Smart Car CHarger

  Fast charger for mobile devices

  Useful app and device

   GPS limitations for car locator

   Expensive for its primary use as a charger

SoliD 
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Owlboy asks a simple question: how would 
2D, side-scrolling platform games change 
if the protagonist could fly instead of merely 
jump? You play as Otus, a mute owlet 
apprentice, thrown into a violent conflict. 
when robot sky-pirates attack his village. 

The caverns that compose Owlboy’s 
airborne world are vast and winding, full 
of loops and switchbacks, branching chutes 
that double back on themselves. There’s 
no aimless wandering through these 
underground waterfalls or volcanic ruins, 
however: puzzles are often contained to a 
single room, and each dungeon has a central 
theme. One early set of puzzles, for example, 
requires wringing out a rain-heavy cloud to 
flood certain nooks and crannies. 

The combat, too, has an appreciable 
rhythm. Otus is rather defenseless on his 
own, but his signature move is to call in his 
ragtag compatriots: anti-aircraft gunner 
Geddy and Alphonse, a gallant newcomer. 
With the click of a button, Otus can grab a 
teammate by the shoulders and dive into 

Owlboy
Don’t let enemies ruffle your feathers – rule the roost
$24.99  Developer D-Pad Studio, dpadstudio.com

Requirements OS X 10.7.5 or later, dual-core processor, 2GB RAM, OpenGL 3.0 support 

owlboy

   Colorful, expressive 
pixel art

   Tight combat and 
clever puzzles mix well 

   Endearing characters 
and dialog

   Plot leans slightly  
too heavily on lore  
and exposition

excellent 

battle, darting to and fro while Geddy 
takes potshots with a long-range pistol, or 
swooping in close for a blast from Alphonse’s 
combination flamethrower-shotgun. With 
swarming insects and rock-hurling cavemen 
at every turn, Owlboy has the sensibility of 
a twin-stick shooter. 

Neither Owlboy’s dungeon structure 
nor shooting combat are particularly 
groundbreaking, but rather remixed and 
recontextualized. The developer stretches its 
chosen genre far enough to develop a unique 
identity, but not so far that its lineage is 
unrecognizable. Skirmishes and puzzle-solving 

are woven together deftly, and each dungeon has 

a sense of spatial awareness and momentum not 

seen in traditionally grounded platformers.

The plot also moves apace for the most 
part, steadily introducing new puzzle 
concepts or setpieces: a stealth section here, 
a chase scene there. Even when predictability 
or exposition bogs down the plot, Owlboy’s 
sharply drawn characters push it forward.  
This is where D-Pad’s tightknit pixel art 
works best: not as a retro signifier, but as a 
complement to the warmth and earnestness 
of its cast.

the bottom line. Owlboy takes hoary 
genre standards and infuses them with new 
ideas and charming, memorable characters. 
Joseph leRay

Concentric rings provide 
coins, which can be used 
to buy upgrades in town.

Even when you’re in the belly of the beast, robot pirates 
can’t hit what they can’t see.

>>>Reviews
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Poi is the debut project from two-man 
developer PolyKid. This 3D platformer, 
spread across four distinctive worlds and 
populated by goofy archeologists, retired 
adventurers, and raccoon traders is vivid, 
vibrant, and infused with charm.

Unsurprisingly, the goal of Poi is 
to collect: medallions, coins, fossils, 
gears, keys, photographs, stones, baby 
penguins… Amassing knickknacks unlocks 

a steady drip of new areas and mini-games, 

and Poi’s deliberate pacing keeps it from 

getting stale too quickly. Its rhythm and 
structure are familiar bordering on 
predictable, but the action is sustained 
by sharp controls and clever level design.

Aspiring adventurers come with an 
arsenal of responsive double-jumps, 
lunges, and somersaults; Poi is never 
hard, but zipping through its densely 
layered obstacles is fun in its own right. 
Each world is big enough to provide 
a sense of exploration, but not so 

scattershot that hunting down a specific 
relic or hidden room becomes a chore.

While its broad strokes are derivative, 
there is creativity in Poi’s details. Each 
level is connected to an airborne hub, for 
example, a central area of merchants and 
mechanics flying in a ragtag steampunk 
armada. To get from ship to ship, simply 
walk off the gangplank and a parasail 
does the rest.

A society of airships, floating islands, 
and unmoored mountains may have been 
more interesting than Poi’s by-the-
numbers forest, desert, and volcano 
areas. On the other hand, each winking 
joke and Easter egg is a reminder that Poi 
was made by a tiny team expressing its 
genuine fondness for a quirky genre.

the bottom line. Poi is content to be 
a pleasant homage to the more ambitious 
platformers of the mid-’90s. Anyone 
looking for a joyful, rose-tinted adventure 
will find satisfaction here. Joseph leray

Poi
There’s more than one point of interest in this retrofest
$14.99  Developer PolyKid, poi-game.com

requirements OS X 10.7 or later, Intel Core 2 Duo, 2GB RAM, NVIDIA GeForce GT 650M or better

Poi

   Fluid controls and 
breezy action

   Dense levels packed 
with collectibles

   Cel-shaded art and 
a rousing soundtrack

   Lacks a standout idea 
and relies too heavily 
on fondness for retro

good 

Not pictured: a giant pit 
of quicksand directly 
below this scaffolding.
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Security 
cameraS

here’s no doubt that we see more 
information about security cameras 
here at Home Life than any other 
type of smart-home product. 

Browsing the website of one electronics store 
recently revealed no less than 68 different 
cameras, with the majority falling into the 
$100-$200 price range. Having such a wide 
range of products can make it difficult to choose, 
but whichever brand or manufacturer you go 
with, there are a number of key features and 
technologies it’s worth thinking about when  
you buy your first security camera.

Top of the list for any camera, of course, is 
image quality. We’ve all seen news reports on 
TV with video footage that is so blurry you end 
up wondering why they bothered spending any 
money on a CCTV system in the first place.

Most manufacturers provide affordable, 
entry-level security cameras with 720p 
resolution (1280x720 pixels) for around $100, 

and we’d certainly recommend that quality as 
the minimum requirement for a decent security 
camera. Ideally, though, it’s worth stepping 
up to a model that provides full 1080p HD video 
(1920x1080 pixels). Netgear’s Arlo Q is one of the 
most affordable 1080p cameras, at around $160, 

although most cameras designed for indoor 
use seem to go for around $200. These will 
provide much better image quality if you ever 
need to use your video footage as evidence in 
the unfortunate event of a crime. A good 
camera in this price range should also provide 

> get started with…

The latest smart security cameras include 
sophisticated audio and video technologies

t

t h e  l at e S t  S ec u r i t y 

c a m e r a S  a r e  n e at, 

D i S c r e e t  a n D  v e ry 

S m a r t  i n D e e D …

By cliFF JOSePh
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a “night-vision” mode for low-light conditions.
The first generation of smart security cameras 

was pretty straightforward, relying on simple 
motion-detection software to keep an eye on things 
while you were away from home. If the camera 
detected any movement while you were out, it 
would automatically start to record video footage 
and send an alert to your iPhone. However, the 
latest cameras are starting to use sophisticated 
artificial intelligence techniques that provide even 
more advanced features. 

Netatmo’s Welcome camera ($199) was one of 
the first to use face-recognition technology to tell 
the difference between a burglar and your kids 
coming home from school, and its new Presence 
camera goes even further. It’s more expensive, 
at $300, but that’s because it’s weatherproof for 
outdoor use and also includes a powerful floodlight. 
The Presence is designed to monitor activity outside 
your home or office; Netatmo has developed new 
software that claims to tell the difference between 

Not only has the tech got better, 
security cameras look a lot nicer, too.

Is it a camera? 
Is it a bulb? The 
Sengled Snap is 
actually both!

people, pets and passing cars. The Arlo Pro from 
Netgear – another weatherproof outdoor camera 
system, starting at $250 – even claims to recognize 
trees swaying in the breeze, so that it doesn’t keep 
sending you false alarms on a windy day.

Logitech’s indoor Circle camera ($150) is getting 
a “people recognition” feature, so that it only 
reacts to human intruders, rather than pets 
wandering by. And we’re looking forward to seeing 
the new Home Plus from Withings ($199), and an 
unnamed camera from D-Link, which will be the 
first security cameras to support Apple’s HomeKit. 
That will allow you to control the cameras with Siri 
voice commands, and to use the Home app in iOS 10 
to link the cameras to other devices – such as lights 
and thermostats – that also use HomeKit.

SOunD anD viSiOn

Artificial intelligence is advancing in other areas 
too. Most security cameras include a mic so that 
they can record both sound and video, but Swann’s 
SoundView camera ($110 – but see our discussion of 
subscription fees later) can actually listen out for 
specific types of sound, such as breaking glass, that 
might warn you of a possible crime.

However, the most advanced sound technology 
we’ve seen so far comes from a camera called 
Cocoon ($219). Originally launched on the 
Indiegogo crowdfunding site, the Cocoon uses an 
innovative “Subsound” technology that can pick up 
faint sounds and vibrations from all around your 
home – not just in the one room where the camera 
is located. It can detect sounds such as creaking 
floorboards, and claims to be smart enough to tell 
the difference between your kids charging up and 
down the stairs and a burglar tiptoeing in at night.

>>>Home Life
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Friend or foe? The 
Logitech Circle can 
differentiate between 
pets and prowlers.

Check in on your 
home from your 
security camera’s 
mobile app.

The Swann 
SoundView 
alerts you 
to specific 

noises.

t h e  l at e S t  S ec u r i t y 

c a m e r a S  n O w  u S e 

S O P h i S t i c at e D  a r t i F i c i a l 

i n t e l l i g e n c e  tO  P r Ov i D e 

m O r e  a Dva n c e D  F e at u r e S

There are some other weird and wonderful 
variations on the security camera theme, too. 
Sengled’s Snap ($105) sneakily hides a 1080p 
camera inside a power-efficient LED bulb, so that 
you can monitor areas such as hallways or stairs 
without revealing the presence of the camera. 
We also like the Canary camera ($150), which 
combines a 1080p camera with a honkingly loud 
siren, and even has an air monitor that can check 
humidity and air-quality levels in your home. 

While security cameras are often the first 
smart-home device that many of us buy, a lot of 
cameras are also designed to be used in conjunction 
with other security devices, such as motion sensors 
and contact sensors that can be attached to doors 
and windows around your home. Get started with 
one of the cameras that we cover here, and in a few 
issues we’ll come back and explore some of the 
other security devices that can provide extra 
protection for your home.

Security cameras
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Five of the smartest security cameras for your home

lOgitech circle

$150

logitech.com

> There are more advanced 

cameras available, but we 

like the Circle’s ease of use 

and semi-portable design. 

The Circle will spend most 

of its time sitting in its 

powered dock, but it also 

has a rechargeable battery 

that enables you to move 

it around – perhaps into a 

child’s bedroom – for up 

to 12 hours.

1 2 3 4
netgear arlO Q

$160

arlo.com

> The Arlo Q is an 

affordable 1080p camera 

with two-way audio and 

night vision. But the best 

thing about the Arlo 

cameras is that they 

allow you to store the 

last seven days of video 

footage online for free, 

with no need to pay for 

a monthly subscription.

cOcOOn

$219

cocoon.life

> Together with a 1080p 

camera and night-vision 

mode, this crowdfunding 

success story uses an 

innovative “Subsound” 

technology to detect sound 

and vibrations throughout 

your entire home – not 

just one room. As well as 

sending alarms to your 

iPhone, it also has a 

seriously loud 90db siren.

netatmO PreSence

$300

netatmo.com

> It’s expensive, but the 

Presence is one of the best 

outdoor cameras available. 

This weatherproof camera 

provides 1080p resolution 

with night vision, plus 

there’s a floodlight to 

scare intruders away. 

There’s no online storage, 

but you can link it to a 

Dropbox account or store 

video on an SD card.

 Five OF 
the BeSt

>>>Home Life
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hen your camera 
detects an intruder, 
it will send an alarm 
to your iPhone and 

stream the live video image so that 
you can see what’s going on back 
home. However, there may be 
times when you need to store your 
recordings for longer – perhaps as 
evidence of a crime.

Netatmo’s Welcome and 
Presence cameras are unusual, as 
they include a memory card that 
lets you store video directly on the 
camera itself. Most manufacturers 
opt for online storage instead – 

and this is where you need to 
watch out for hidden extra costs.

Netgear’s Arlo cameras allow 
you to store your video footage 
online for seven days for free – 
enough for most people – 
but then charge a monthly 
subscription of $9.99 to store 
recordings for 30 days. Logitech’s 
Circle stores video for 24 hours for 
free, before charging $3.99 per 
month, per camera, for 14 days of 
storage. Frustratingly, Swann’s 
SoundView and the Sengled Snap 
only provide live streaming, with 
no free online storage at all.

w

StOring 
yOur camera 
FOOtage

> what else should i think about…

You can view live video for free, but other 
features such as archiving may cost extra

withingS hOme PluS

$199

withings.com 

> We haven’t gotten our 

hands on the Home Plus 

yet, but it’s essentially an 

updated version of the 

popular Home camera 

which adds support for 

Apple’s HomeKit – the 

first security camera to 

do so. You can even check 

in with the camera’s video 

on your Apple Watch or 

Apple TV too.

5

Netatmo cameras 
include a microSD 

card for storing 
your videos.
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hOw tO

uSe the netatmO welcOme 

stranger danger
If the Welcome spots a face that it 

doesn’t recognize – such as this delivery driver 

– it will automatically start recording video and 

send an alert to your iPhone. It will also take a 

snapshot so that you can add that person to 

the app if you want.

home and away
Like most security cameras, Netatmo’s 

Welcome can track your location through its 

app on your iPhone. You can link the Welcome 

to the phones of other family members too, so 

it knows when the house is empty and it needs 

to keep a close eye on things.

Face to face
The Welcome was one of the first 

security cameras to use face-recognition 

technology. As soon as you turn the camera 

on it starts to make a note of each new face 

that it spots. Tap and hold on each face in 

order to identify that person.

the spying game
You don’t need to worry about family 

members, but if there are people who only 

come to visit occasionally you can tell the 

Welcome how to react. You can tell it to 

record one video on arrival – or to keep 

an eye on them the whole time.

 
jargon buster

Most security cameras 
run off batteries or 

mains power, but some 
can use POE (Power Over 
Ethernet). This allows the 
camera to get both power 
and internet access from 

a single cable, and can be 
really useful if you want to 

install several cameras 
around your home or 

business premises.

 
storage

 
The Netatmo Welcome 

includes an 8GB memory 
card for local storage, but 
doesn’t provide an option 

for online storage. You 
can, however, link it to 

a Dropbox account to 
store your videos online.

>>>Home Life
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LG Hub Robot
lg.com
TBA

>>> Although LG is a huge and 

successful electronics company, 

it has never really had the sort of 

reputation for leading-edge 

innovation enjoyed by rivals such 

as Apple and Samsung. That could 

change, though, if its barrage of 

high-tech product launches at this 

year’s CES show are any indication.

The real showstopper was 

LG’s Hub Robot, a cute little 

voice-controlled home assistant, 

complete with blinking digital eyes. 

It’s based on the Alexa voice-

recognition technology used in the 

Amazon Echo, and can play music 

or check the weather forecast, just 

like Alexa. However, LG has taken 

things further by including features 

such as face recognition, so that 

it knows when individual family 

members leave or arrive home. 

It can even remember different 

greetings for each member of 

your family.

LG is developing other versions 

of the Hub Robot that can perform 

a variety of different tasks. There 

will be smaller “mini-bots” that you 

keep in individual rooms to work 

in conjunction with the main Hub 

Robot, as well as a lawnmower 

robot for the garden. Well, that’s 

the plan, at least, but then we’ve 

been promised robot slaves for 

so long now…

>>>Home Life Better living through smarter tech
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Griffin 
Connected 
Toaster

griffintechnology.com
$100

>>> If you were worried 

by recent news reports 

about certain burnt 

foods being carcinogenic, 

then Griffin has the 

solution – in the form of 

its Connected Toaster. 

The toaster uses 

Bluetooth to talk to its 

app on your iPhone, and 

can store personalized 

toast settings for 

different members of 

your family, or different 

types of bread. Griffin’s 

got a smart coffee 

machine coming up as 

well, so you can link them 

together for the perfect 

smart breakfast.

Koogeek LB1
koogeek.com
TBA

>>> Koogeek might not 

be the biggest name in 

smart home technology, 

but it does a neat range 

of smart scales and 

fitness products – and 

its latest venture is this 

Wi-Fi-enabled smart LED 

bulb. HomeKit support is 

built right in, so you can 

use Siri voice commands 

to adjust the brightness, 

or select any of its 16 

million different colors 

to suit your mood. The 

company is also about to 

release a “smart socket” 

that supports HomeKit – 

which would allow you to 

upgrade your existing 

light fittings with 

HomeKit support.

>>> I am notoriously bad at keeping 

gadgets charged. All of my phone 

conversations start with “SEVEN 

PERCENT BATTERY, GO!” and end with 

muffled cursing and abrupt silence. 

So now, in an effort to be a reliable, 

contactable member of my family, I’ve 

positioned our Ikea wireless charging 

furniture at strategic points in our 

home: the Selje side table by the front 

door and the Riggad lamp on the 

kitchen counter.

Hooray! Now I can set down the 

iPhone, in its Incipio Ghost Qi case, 

for a mini-charge when I load the 

dishwasher or when I come home, 

and I can even set the case on the 

Nordmärke charger on my nightstand, 

for when I fall asleep Netflixing.

In practice, though, it turns out that 

wireless charging stations are intended 

for those with basic spatial perception 

skills. Twice this week I’ve chucked my 

phone down on the charging pad and 

found, hours later, the battery is dead.

“Look, you just need to put it on 

straight,” says my husband, infuriated.

“It’s… it’s a circular charging pad. 

There is no straight.” I am honestly 

bewildered by this.

“Just – like this.” He drops the phone 

onto the table, and the charging light 

flicks on. I try, but it stays dark. “Look, 

it’s off at an angle! Place it centrally.”

I still haven’t mastered it. It occurs to 

me that perhaps I’ve reached a tipping 

point in life; a technology that I’ll never 

grasp. This is my Old Lady Thing: I will 

need charging cables forever, because 

I have no hand-eye coordination.

Wait, FOUR PERCENT BATTERY WHY 

GOD WH–

Wireless technology is 
effortless – unless you’re 
JennIfeR PHIn, that is 

>SmaRT 
Home 
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Once a staple of newsstand 
humor back in the heyday of print 
magazines, Cracked magazine 

hasn’t been published for nearly a decade, but 
continues to maintain an online presence as 
a portal for the same brand of biting satire it 
helped introduce in 1958.

Rather than feature goofy illustrated parodies 
and Sylvester P. Smythe covers, Cracked TV has 
become a portal for writer/performers to riff on 
pop culture in videos like “The Archie Comics 
Sex Reboot No One Asked For” and “The Most 
Expensive Movie You’ve Never Heard Of,” as 
well as original shows from Cracked Studios.

Now all this insightful, thought-provoking 
silliness is available from the comfort of your 
living room, thanks to the free Apple TV app. 
Claiming to “always give you a lot to think about 
while you laugh and learn at the same time,” 
the content is free of ads and no subscription 
is necessary. J.R. BookwalteR

Cracked TV
Laugh and learn
Free

Kelley Blue Book TV
Expert auto advice - in high res
Free

Kelley comes to your Apple TV, so now you can watch as well as 
read about all the dream vehicles you’ll never be able to afford.

Cracked: offering plenty of those “Hey, they’re right, 
I never noticed that before” moments. With extra laughs.

Used or new, 

when it comes to 

buying or selling 

cars most everyone knows it’s 

best to first let their fingers 

do the walking through the 

automotive bible that is the 

Kelley Blue Book. If printed 

books aren’t your thing, 

prospective buyers and sellers 

can go traipsing through the 

pages of KBB.com or one of the 

mobile apps instead — and now 

they have a fourth option 

available in the living room.

Kelley Blue Book TV is an 

Apple TV video portal that 

provides up-close and personal 

looks at the latest new cars, as 

well as exclusive “unscripted 

adventures,” head-to-head 

comparison reviews from 

experts, and behind-the-scenes 

footage from auto shows all 

over the world. Naturally, KBB 

offers only unbiased, detailed 

content to satisfy car lovers 

from all walks of life.

No matter if you’re into 

performance cars, sedans 

and hatchbacks, luxury cars or 

SUVs, trucks and vans, coupés 

and convertibles, alternative-

fuel cars, or even race cars, 

they’re all right here on the 

free Kelley Blue Book TV app in 

glorious 1080p high resolution. 

J.R. BookwalteR

>>>Home Life

The laTesT tvOs apps and The hOTTesT hardware
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If today’s movie deal doesn’t tempt, you only 
have to wait until tomorrow for another.

When a game can’t even get its own title 
right, the gameplay doesn’t hold much hope.

Panasonic tX-50eX750

$TBC  pANASoNIC.Com

Blu-ray lovers are mourning 
the death of 3D televisions in 
2017, but Panasonic’s latest 

EX750 LED models – available 
in 50-, 58-, 65-, and 75-inches 

– keep the dream alive with  
an active shutter system plus 
edge-lit LCD, HDR10, swivel/

lift design, and the same 
Studio Color HCX2 processor 

of the OLED models.

Fintie PRotective case

$19.99  fINTIE.Com

Available in a rainbow of 
nearly a dozen colors, this 

silicone cover for Siri Remote 
features a unique honeycomb 
design on the back that’s as 
practical as it is attractive.  

The ergonomic side grips make 
the remote easier to hold, 
while adding a raised bezel  
and extra bulk that doesn’t 

interfere with the touch pad.

make the most of 
home entertainmentfor those who have 

shifted from packaged 

media to iTunes, there 

are plenty of great deals to be had — 

if you know where to look.

Recently making the leap to Apple 

TV is movie of the Day!, an app with 

the singular purpose of offering a new 

discounted title from the fox Digital 

Entertainment catalog every day of the 

week. With deals as low as $4.99 on 

high-definition Hollywood blockbusters 

normally costing $14.99, this is a great 

way to bulk up your iTunes library.

While not every title is a critically 

acclaimed hit, past offerings have 

included fan favorites like X-men: Days 

of future past, Rio 2, and fight Club. 

Each title includes artwork and a trailer 

to help make your buying decision, 

and even if you pass on today’s deal, 

chances are it will come back around 

again eventually. J.R. BookwalteR

Despite the incorrect 

spelling of the word 

“Antarctic” in the title, 

Antartic Adventure is an otherwise 

entertaining endless platform-running 

game. Although the graphics are 

appropriately cute and cartoonish, 

the gameplay itself tends to be a little 

maddening — but not for the reasons 

you might think.

The game’s user interface is an 

exercise in sheer lunacy, with highlights 

that appear on the wrong buttons – so 

no matter which one you press, you’re 

bound to wind up somewhere other 

than where you intended. When it 

comes to actual gameplay, controlling 

your penguin’s movements is equally 

futile. You might manage to pick up a 

few coins before you crash and burn, 

and if that doesn’t cause enough 

frustration, the endlessly looping music 

certainly will. J.R. BookwalteR

Movie of the Day!
New movies daily, at a bargain price
Free

Antartic Adventure
Run, penguin, run! (Away from this game)
Free

Better living through smarter tech
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Odd display effects at shutdown can 

be an early sign of graphics card 

problems. Disconnect all peripherals 

apart from keyboard, mouse, and 

network connection, and hook up 

your keyboard and mouse to USB 

ports. Shut the iMac down, wait a few 

seconds, and hold D as you start up 

shouldn’t be seeing the beach ball so 

often; Activity Monitor and EtreCheck 

(Free, etrecheck.com) can provide 

clues. Another trick is to download 

and install the latest macOS Sierra 

Combo update from Apple’s site 

(apple.co/2k2hNJV) over the top of 

your existing installation. After that, 

you may need to force your Mac to 

check for later security data: in System 

Preferences, click the App Store icon, 

disable “Automatically check for 

updates,” then enable it again. 

Multiple menu bars
How can I get a menu bar on both 

of my displays? 

On a Mac running Mavericks or later, 

go to System Preferences’ Displays 

pane and clear the checkbox labeled 

Mirror Displays; each display will have 

its own menu bar. On earlier versions 

of OS X, only the primary display had a 

menu bar. Move it to the one you want 

by dragging it from one to another in 

the layout preview shown in the 

Arrangement tab. 

Not so magic
Why is my Magic Keyboard 

not working? 

Connect it to a USB port on 

your Mac using its Lightning cable. 

If it still doesn’t work over a cable, it 

has failed, so contact Apple Support. 

Otherwise, in Bluetooth preferences 

turn on the menu bar icon; use it to 

check the keyboard’s battery level. 

Fully charge it. The keyboard should 

then work without the cable.  

Colorimeter with Sierra? 
I spent five hours failing to install 

software to support a ColorMunki 

Design colorimeter on my new iMac, 

which runs Sierra. Is it compatible? 

If not, what are the alternatives?

X-Rite (xrite.com) hasn’t updated 

the software for its ColorMunki devices 

for two years. It won’t install in Sierra, 

and appears to be incompatible. This is 

a shame, as they’re still on sale, and 

work well when their software does. 

I replaced my old 27-inch iMac (Late 2012) with a late 2015 
model of the same size. Its performance seems inferior to 
my old iMac, although that had a Fusion Drive, unlike the 
new one. It often shows the spinning beach ball, and prior 
to shutting down it shows a screen with color patterns. 
Is there something wrong with it?

My NeW MaC ruNS SloWer

the Mac again to run Apple 

Diagnostics. If its tests record an 

error, contact Apple Support or 

take the Mac to a Genius Bar. 

Check the Mac thoroughly for old 

software, particularly extensions and 

persistent services which might have 

migrated from your old iMac. You 

TECH SUPPORT & TECHSPLANATIONS
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X-Rite also offers a considerably more 

expensive and capable system in its 

i1Photo Pro 2, which costs about 

$1,240. X-Rite lists Sierra among the 

compatible operating systems, along 

with older versions of OS X all the way 

back to 10.8. Datacolor’s Spyder5 

series offers a more affordable 

alternative. System requirements for 

all four models – Express (around 

$125), Pro, Elite, and Studio – list 

compatibility with Sierra. 

add my old printer, a Canon MP640, 

for which there doesn’t seem to be 

a driver. Canon support has told me 

that I have two options: buy a new 

printer, or downgrade to el Capitan. 

What can I do? 

Oddly, Apple lists your printer as 

being supported in Sierra using its 

existing driver, although Canon reports 

that it isn’t supported. You have three 

options: replace the printer, try the old 

printer driver, or try Gutenprint. 

Provided that you’ve updated Sierra 

to at least version 10.12.1, you may be 

Some years ago, I bought 

an apple uSB SuperDrive 

to connect to my 2013 

iMac. Since upgrading to 

oS X el Capitan, the 

drive stopped playing 

DVD video discs, 

although it still works 

with DVD and CD data, 

and CD audio discs. I’ve 

tried various solutions, 

including resetting the 

SMC and NVraM, but 

all to no avail.

This depends on exactly 

which model of iMac you 

have. OS X and macOS 

Sierra are configured to 

support the SuperDrive 

only if that model wasn’t 

offered with an internal 

SuperDrive. Apple 

stopped including an 

internal SuperDrive 

starting with the late 2012 

iMac range. On a model 

that doesn’t include a 

SuperDrive, your external 

one should work fine 

when connected to a USB 

port on the Mac; avoid 

connecting it through a 

hub. (On older Macs with 

an internal SuperDrive, 

Apple annoyingly disables 

the capability to use its 

USB SuperDrive.) 

Upgrading to Sierra 

might fix things, although 

that’s unpredictable. It’s 

drastic too, and perhaps 

unfeasible if you have 

hardware or apps that 

are incompatible with it. 

We’ve found forum posts 

on Apple’s site in which 

others have complained 

about the same issue. 

If someone you know 

has a third-party USB 

DVD drive, ask if you may 

borrow it to see whether 

it eliminates the problem. 

If so, you might consider 

buying a third-party drive 

– they’re affordable, and 

more likely to work with 

a wide range of different 

Macs. However, before 

you spend any money, 

it’s worth calling Apple 

Support (support.apple.

com) to see if it can shed 

light on the root cause 

of this problem.

> USB SuperDrive can’t play DVDs

able to get the last (2015) version of 

the driver from Canon’s support site 

to install and work properly, as Apple 

says you should. If that doesn’t work, 

you’ll have to uninstall the driver and 

pick another option. 

Gutenprint (bit.ly/2jaemlh), 

supports many older printers, and 

we’ve found reports online that 

version 5.2.11, the latest stable one, 

works with Sierra. That website has 

instructions on installing it. For recent 

printers, it often works as well as their 

original drivers did. 

X-Rite’s i1Photo Pro 2 is a cutting-edge 
colorimeter and is compatible with Sierra.

Not so magic again
Why do letters duplicate on my 

Magic Keyboard?

This appears to be a persistent bug, 

probably in El Capitan and Sierra’s 

Bluetooth drivers. It occurs in letters 

that can’t ordinarily repeat. Sadly, 

slowing down the Key Repeat setting 

in Keyboard preferences has no effect. 

Try unpairing the keyboard from your 

Mac and then pair it again. 

Charging options
Can I use a Mac’s uSB-C adapter 

to charge other stuff? 

Apple and compatible USB-C 

chargers can be used to directly 

charge iOS devices, as well as the 

Magic TrackPad 2, Mouse 2, and 

Keyboard. This requires a USB-C to 

Lightning cable. Apple’s own cable 

comes in 1m ($19) and 2m ($29) 

lengths. This can prove invaluable for 

traveling with a Mac with USB-C. 

Sierra support for old printer 
I’ve upgraded my MacBook Pro to 

Sierra, but discovered that it won’t 

Tech Support & Techsplanations
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>>> If neither works, someone using an 

older system may get good use out of 

your MP640, and it would be sensible 

for you to replace it. 

Sync stop
iTunes stopped syncing my iPod 

classic. Why? 

Officially, the current version still 

supports your iPod, and should work. 

Apple provides detailed guidelines at 

apple.co/1DaXjwQ on such issues. 

Given your iPod’s age, if the advice on 

that page doesn’t bring resolution, it’s 

perhaps time to retire the device as it 

may well have a hardware fault. 

photos, Lightroom, 
pixelmator?
When I switched from iPhoto to 

Photos, all my pictures migrated 

correctly, and Photos has worked 

great since. Now I want to get 

more creative, and have bought 

Pixelmator and adobe Photoshop 

lightroom to explore. They seem to 

import my old iPhoto pictures, but 

stop at 2014, so I’ve had to import 

subsequent photos manually. How 

can I resolve this? 

Once you’ve migrated your iPhoto 

library to Photos, the latter app should 

appear as a source in the pop-up menu 

able to print as JPEG in the Print 

dialog. As to the cause, it may be a 

conflict with Sierra, and we haven’t 

heard of it affecting rival products. 

New library
Can I make a new Photos library 

for a project?

Yes. Though the app makes albums 

for things like screenshots, it’s good 

sense to put some images in a 

separate library – a specific project 

like yours, or pics you want to exclude 

from iCloud Photo Library. Open a 

Finder window, browse to the Photos 

app, then hold Alt and double-click the 

app. It’ll start with a dialog offering 

to create a new library, or to pick 

which library to open. 

Calendar prints
Can I control the order of printing 

all-day items? 

Calendar offers only rudimentary 

controls for printing, which normally 

means all-day items are printed in the 

order in which they’re entered. You 

can’t alter that except by changing 

from all-day to timed scheduled 

events. You might be able to force the 

app to ignore entry order by hiding 

and then showing calendars.

play, not rip
How can I simply play rather than 

rip audio CDs?

Insert the disc and decline iTunes’ 

offer to import it. When the track list 

appears, click the play button. You can 

in Pixelmator’s Photo Browser (choose 

View > Show Photo Browser to show 

it). There is no similar browser built 

into Lightroom for accessing the 

contents of Photos’ library, so you 

have to export images to a folder, edit 

those copies, and optionally import 

them back into Photos. 

In Pixelmator’s Photo Browser, the 

pop-up menu at the top of the window 

should list the Pictures folder, your 

Photos library, and, it seems, your 

old iPhoto library. However, even 

with Photos selected there, you may 

still have trouble accessing all of its 

library’s contents, depending on 

whether you have enabled iCloud 

Photo Library in Photos’ preferences 

and subsequently selected Optimize 

Mac Storage. Read apple.co/2k2oTuS 

for more info and how to work around 

it; make sure you read the note at the 

bottom for an ongoing (yet storage-

intensive) solution. 

Acrobat reader DC
Why won’t acrobat reader DC 

print my documents?

Some people find that printing PDFs 

causes an error stating there are no 

pages selected to print. This may fix 

itself if you disable Enhanced Security 

in the app’s preferences. You should be 

Pixelmator’s Photo Browser should list the Pictures folder, Photos library and your old iPhoto library.

Calendar is a useful app, but its facility for 
printing your schedule is pretty limited.

>>>Ask
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Following a recent ioS 

upgrade, notifications 

on my and my wife’s 

iPhones have changed. 

When a message arrives, 

we normally get a tone 

and vibration, but once 

we’ve replied, subsequent 

incoming messages don’t 

result in either. We don’t 

appear to have changed 

any settings, so how can 

we correct this?

So many people have 

experienced this after 

recent updates that it’s 

hard to know whether it’s 

intentional or a common 

bug. There certainly 

doesn’t seem to be an 

option to control it, unless 

it occurs only when Do 

Not Disturb is switched 

on. In that case, go to 

Settings > Do Not Disturb 

and check that repeated 

Calls is switched on, so 

that a second call or 

message from the same 

person within three 

minutes still should result 

in an audible notification. 

This problem gets worse 

when you have multiple 

devices, such as Macs 

and ipads, all using the 

same Apple ID. In theory, 

all should tell you about 

incoming messages, 

but you may be notified 

only on an inappropriate 

device you aren’t using, 

such as your home Mac 

when you’re at work. 

Some people have found 

that a “soft” reset of their 

iphone restores normal 

behavior. To do that, hold 

down the Sleep/Wake 

and Home buttons at the 

same time (on iphone 7, 

use the volume down 

button in Home’s place), 

for at least 10 seconds, 

until you see the Apple 

logo appear. 

Apple Watch seems to 

be the most reliable Apple 

device for notifications 

right now, but it’s a high 

price to pay just to work 

around this. 

> Unreliable notifications

play discs by default: in iTunes’ General 

preferences, set the “When a CD is 

inserted” item to Play CD. 

AutoFill is confused 
Something’s gone wrong with 

Safari’s autoFill feature on my Mac. 

It used to use the correct info from 

my Contacts card, but now it uses 

that from my wife’s card. I cannot 

seem to get it to switch back and 

stay there. What’s wrong?

Normally it’s simple to correct 

AutoFill errors like this: the Contacts 

card that’s set as your identity has 

been changed. In Safari’s preferences, 

click the AutoFill tab. Click Edit to the 

right of the option labeled “Using info 

from my contacts” to view and edit the 

card in Contacts from which Safari is 

pulling information. 

If that’s set correctly, nothing else in 

macOS should alter that. But if you’re 

signed into iCloud on your Mac and 

another device, using the same Apple 

ID on each, the second one can change 

the Contacts card that’s used. 

If your wife is sharing your Apple ID, 

using it to sign in to iCloud on her Mac 

or iOS device, and both of you have 

iCloud Keychain enabled, she may be 

undoing your choice by changing 

AutoFill to use her card; iCloud 

Keychain will cause it to change for 

you too. She should use her own 

Apple ID to avoid this sort of conflict. 

Safari beach ball 
after updating Sierra to 10.12.2, 

Safari has become unusable, as it 

quickly gets stuck with a spinning 

beach ball and I have to force it to 

quit. When the browser is not 

running, etreCheck says everything 

is fine, but when Safari is open 

performance is “poor,” and the 

browser uses 99% of the CPu.  

Can I reset Safari, or would another 

browser work better? 

The most likely causes of this are 

malware, an incomplete update, or an 

incompatible extension/plugin. Run 

the latest version of Malwarebytes 

(malwarebytes.com) to look for the 

former, and download and install the 

latest Sierra Combo Update from 

Apple to fix the latter. Old plugins and 

extensions, particularly ad blockers, 

can also cause this. Check the folders /

Library/Internet Plug-ins, ~/Library/

Internet Plug-ins, and ~/Library/Safari/ 

Extensions for those, and remove them 

unless you’re confident that they’re up 

to date, stable, and compatible with 

Sierra 10.12.2. 

It’s worth trying Safari Technology 

Preview (Free, apple.co/2jzT0rM); it 

shares some minor preferences with 

Safari, but maintains its own for things 

like active extensions. If it’s affected as 

well, try Firefox, Chrome or Opera. 
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Turn on iCloud Keychain
If you didn’t set up iCloud Keychain 

when you originally installed macOS Sierra, 

no problem: go to System Preferences > iCloud 

and select Keychain. Then enter your Apple 

ID’s password in the dialog box to begin.

Add a security code
You’ll be asked to set a security code, 

which allows other devices to access the 

information in your iCloud Keychain. Entering 

the security code wrongly too many times will 

wipe your keychain from Apple’s servers.

modern life requires us to 
memorize more information 
than ever before. No wonder, 
then, that so many of us pick 

a single password and use it across 
everything from webmail to online stores.

While that might make your life easier, 
it certainly doesn’t make it secure, as a 
breach of any one of those systems leaves 
every site you sign in to – as well as your 
Mac – potentially vulnerable.

Fortunately, iCloud Keychain can help. 
Built into macOS and iOS, it syncs your 
account credentials between each of your 
Apple devices, so you can set obscure, less 
memorable passwords that are unique to 

Sign in with iCloud Keychain
Make your online life easier to manage across all of your Apple devices

every website you use, and have Safari 
fill in the details for you when they’re 
required. Handily, iCloud Keychain can 
store your credit card, email account and 
Wi-Fi network info too. Turning it on 
automatically moves details you’ve 
already saved to your Mac or iOS device 
to iCloud, and any new additions or 
amendments that you make are added 
to your online keychain over time.

Once you’ve set up your iCloud 
Keychain, you can largely forget about 
it, provided you keep three elements 
secure: your password, your trusted 
devices, and the Recovery Key for your 
iCloud account. rob mead-green

 
safety first

To keep your iCloud 
Keychain data safe, 
Apple uses 256-bit  

AES encryption and 
scrambles the data in 

transit using a complex 
piece of algebra – based 
not on numbers, but on 

imaginary points on  
an elliptical shape.

reQUires
macOS Sierra, iOS 10

yoU will learn
How to sync your 

passwords and other 
important details

it will taKe
20 minutes

How to Set up and use iCloud Keychain

HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD
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Where is your data?
Your site accounts, Wi-Fi networks, and 

internet accounts will be uploaded to iCloud 

and, from there, to any other devices you own 

which use the same iCloud account. Manage 

your data under Passwords in Safari’s prefs.

Add credit card details
Safari offers to save your credit and 

debit card numbers when you enter them into 

online forms. To add others, open Safari’s 

preferences, click AutoFill, then Edit beside 

Credit Cards, and then Add.

permit the new device
If you opted to authorize from another 

device, a notification will pop up on it. Click or 

tap the notification, then select Continue. 

Enter your Apple ID password to grant the new 

device access to your iCloud Keychain.

Keep Keychain local
If you have opted not to set a security 

code, data you add to your keychain is stored 

only on the device you’re using (whether Mac 

or iOS), but isn’t updated on your other devices 

since it won’t be stored in iCloud. 

set up Keychain on iOs
On your iOS device, go to Settings > 

iCloud > Keychain and turn it on. Enter your 

Apple ID password when prompted, then opt to 

authorize from another device, or tap “Approve 

with your Security Code.”

Maintain security code
If you opted to use a security code, 

confirm the phone number then watch for an 

SMS containing a six-digit code. Enter this code 

into the dialog on the iOS device to complete 

the authorization process.

 
delete it!

To clear your keychain 
data from iCloud, go to 
System Preferences’ 
iCloud pane, click Options 
next to Keychain, then 
clear the box next to 
“Allow approving with 
security code.” Finally,  
on each of your devices, 
turn off iCloud Keychain.

 
GeniUs tip

To change your Security 
Code, go to System 
Preferences > iCloud and 
click iCloud Keychain’s 
Options button. In the 
Keychain Options sheet 
that appears, select 
Change Security Code.  
To create a longer code, 
select Advanced, then 
choose either “Use  
a complex security code” 
or “Get a random security 
code.” If you don’t want  
one at all, select “Don’t 
create security code.”

How to do anything on your Mac, iPhone & iPad
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Resize a window
The basic method of resizing 

a window is to position the pointer 

over a corner or edge so the cursor 

changes to a double-headed arrow, 

then hold and drag in the direction you 

want the window to grow or shrink.

A trackpad trick
To resize by moving three 

fingers on the trackpad, go to System 

Preferences’ Accessibility pane, select 

Mouse & Trackpad, click Trackpad 

Options and set “Enable dragging” 

to “three finger drag.”

Resize in 
two directions

You can resize a window so that the 

opposite edge or corner mirrors the 

movement of the one you drag: hold 

Alt while dragging an edge or corner. 

Great for making a window wider.

Sadly, macOS doesn’t have 
an equivalent to Microsoft’s 
Window Snap feature to enable 
you to quickly make a window 

fill the left or right half of the desktop. 
However, it has some hidden shortcuts 
that are more powerful. Over these two 
pages you’ll learn techniques that will 
help you to wrangle windows more 
efficiently, so you can quickly get on 
with more pressing tasks. Not all of them 
are obvious, and some are the sort of 
thing that even veteran Mac users might 
be surprised to discover.

Some of these shortcuts have been part 
of the Mac operating system for years, so 
you can benefit from them even if you 
have no choice but to run an old version. 
For example, OS X Lion was the first 
version to enable resizing from any 
window edge or corner – which you can 
combine with holding one or two modifier 
keys to resize a window in two directions 
at once, for example.

If your Mac is running Sierra, though, 
you’ll discover plenty more features that 
Apple has added. The great news here, 

Take control of windows
Discover techniques to tame your workspace, including Sierra’s new tricks

especially if you’ve switched from a 
Windows PC, is that there’s at last an 
equivalent to the Maximize command 
found in Microsoft’s operating system, 
so you can make a window fill the desktop 
with a double-click. Related to that, you 
can instantly snap a window’s edge or 
corner to the same position of the overall 
desktop – no dragging required!

If yOu need even mOre cOnTrOl…

Earlier, we mentioned Windows Snap. 
After reading these tips, you may find 
yourself pining for something more like 
it, especially if you’ve recently switched 
from a PC. One of the following third-
party tools will help you out.

The simpler option is Magnet ($4.99, 
Mac App Store). It enables you to drag a 
window or press a key combo to make the 
window fill a specific quarter or half of the 
desktop, or even the whole screen. Your 
more powerful option is Moom ($9.99, 
Mac App Store). A highlight is its ability 
to save and restore window layouts in an 
instant by pressing a keyboard shortcut. 
alan STOnebrIdge

REQUIRES
macOS Sierra (though 
many tips work as far 

back as OS X Lion)

yoU wIll lEaRn
How to resize and 

reposition windows 
quickly and precisely 

IT wIll TaKE
10 minutes

HOw TO Quickly and comfortably resize a window
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The Zoom 
command

In a Mac app’s Window menu, Zoom 

expands a window to fill what’s thought 

to be the best fit for its content. As a 

shortcut, you can hold Alt and click on 

a window’s green button.

Keep proportions
Hold ß while resizing a window 

and its relative width and height will be 

kept the same. The window is anchored 

at the point opposite to the one you 

drag from. The proportions may be 

overridden below a minimum setting.

Fill the desktop
On pre-Sierra systems, you can 

expand a window to fill the desktop by 

holding Alt and then dragging from 

whichever of the window’s corners is 

furthest from a screen corner; the 

window grows outwards.

Combine the keys
By holding both ß and Alt and 

then dragging from a corner or edge, 

the resizing operation is anchored at 

the center of the window and you end 

up moving all four of the window’s 

edges inwards or outwards in unison.

A shortcut in Sierra
Filling the desktop is much 

easier in Sierra. Hold Alt and double-

click any window corner. This works in 

many built-in and third-party apps, an 

exception being iTunes – for that, use 

either method described to the left.

picture-in-picture 
floating video

This feature, available in Safari, iTunes 

and other apps in Sierra, pops a video 

into its own window that snaps to a 

screen corner and stays there even if 

you switch to a full-screen app. 

> vIew TwO appS SIde by SIde

Full-screen mode isn’t just for focusing on one app

Split View (OS X 10.11 or higher) quickly puts two apps alongside each other, if they 

both support full-screen mode. In Mission Control (see apple.co/2lsgjoC), drag a 

window to an empty spot on the top bar, then drag another onto the space that 

created. In that space, drag the divider to adjust the screen split. To exit, put the 

pointer over the space in Mission Control and click the arrows that appear. Note: 

two apps may not combine if the screen resolution is too low; on a Retina display, 

picking a higher “Looks like” resolution in the Displays pane may overcome this.

HOw TO Make a window fill the desktop

HOw TO Make big changes even more quickly
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Apple’s commitment to its 
networking hardware seems to 
be at a halt, to the point that 
its AirPort team was recently 

rumored to have been disbanded. With 
the future of AirPort Extreme and Time 
Capsule routers apparently under threat, 
you may be looking elsewhere for a device 
to centralize Time Machine backups for all 
the Macs in your home. Many third-party 
network drives come with Time Machine 
support, but you could press an older Mac 
into service instead.

The advantages of this are numerous. 
Firstly, you can plug in/swap out external 
storage. Secondly, a USB drive represents 
much better value than a Time Capsule. 
Thirdly, external drives perform much 
quicker when plugged directly into a Mac 
(particularly if it has USB 3.0) rather than 
going through the slower USB 2.0 port on 
an AirPort Extreme or Time Capsule.

To do this, you’ll need to purchase 

Add a server to your home
Reuse a spare Mac for networked backups and to speed up iCloud Drive

macOS Server ($19.99, Mac App Store). 
This installs as an app within an existing 
version of macOS, and it comes with 
additional benefits too, from setting up 
centralized folder sharing to the caching 
of iCloud Drive data, which can save you 
time and potentially money if you’re on 
a metered internet connection.

Your Mac will need to be running OS X 
10.11.6 or later to run the latest version 
of macOS Server, which might not be 
practical if you’re using an older Mac. 
The trouble is, Apple has made it difficult 
– but not impossible – to buy and install 
an older version of the app (which used to 
be more simply dubbed “Server”).

We’re going to focus on Macs running 
OS X 10.8 Mountain Lion or later, because 
that’s the point where Server changed 
from being sold as a complete operating 
system to an app that runs on top of the 
regular one. If your old Mac is running 
either OS X 10.8 or OS X 10.9 (Mavericks), 

REQUIRES
macOS Server

yoU wIll lEaRn 
How to configure 

macOS Server and its 
Time Machine and 
Caching features

IT wIll TaKE
1 hour
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go to apple.co/2lSUSgR and click the 
relevant link. This will open the Mac App 
Store and show you the correct version of 
Server for your system (2.2.5 for Mountain 
Lion; 3.2.2 for Mavericks) for you to buy, 
or redownload if bought previously.  
Note that certain features – like caching 
personal data from iCloud Drive – aren’t 
available in earlier releases.

If you’re running Yosemite, search the 
Mac App Store for “macOS Server,” then 
purchase it – you’ll be told the current 
version isn’t compatible and instead be 
offered the most recent version that will 
work. Accept this, and it’ll download and 
install on your soon-to-be server.

Once the Server app is installed, you’ll 
find it in the Applications folder. Before 
opening it, make sure the Mac’s network 
connection is configured properly. First, 
we strongly recommend you connect the 
server to your router using an Ethernet 
cable; while you can use Wi-Fi, Ethernet 
offers faster performance and a more 
stable connection.

Second, assign the server a static IP 
address on your network, so that it has a 
permanent identity that makes it easier 
for other Macs to locate and connect to it. 

To do this, go to System Preferences > 
Network, select the Ethernet connection 
if necessary, then change the “Configure 
iPv4” pop-up menu to “Using DHCP with 
manual address.” Next, give the Mac a 
static IP address; check the range from 
which your router allocates addresses – 
often 192.168.0.x, where x is a number 
between 0 and 255 that isn’t assigned to 
another device on that network. When 
you’ve done that, click Apply.

A little bit of bAsic setup

Server works best when you limit access 
to specific users and groups. Open the app 
and click Continue to set it up. Once done, 
you’ll see its main screen, which gives 
an overview of the computer, and lists 
available services in the sidebar. Select 
Users under the Accounts heading on the 
left. You’ll see your own user account has 
already been added. Click + to add other 
members of your household.

You’ll want to create accounts that 
match the ones on your household’s 
Macs, so you may need family members to 
provide their account name and password 
– though not mandatory to match what 
they use on their own Mac, that simplifies 

Running macOS Server may seem intimidating, but it offers a couple of features that are easy to set up and beneficial even in a home setting.

 
JaRGon BUSTER

A cache is an area of 
storage that holds data 
that’s used often, by 
several devices, or both, 
primarily to provide 
a faster means of 
accessing that data.

 
fIlE ShaRInG

Select File Sharing in 
Server’s sidebar to set up 
shared folders. By default, 
guest access should 
be disabled, but open 
a folder’s settings 
preferences to be sure.
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explAined… macOS Server’s Caching feature

PERmISSIonS
By default, the cache 

works only for devices  
on your network; it’s  

best, then, to leave  
these settings alone.

CaChE SIzE
If space is an issue, 
use this slider to limit 
the cache’s size. Clicking 
Reset will clear the 
entire cache.

iCloUd daTa 
If you use iCloud Drive, 

check this box in order to 
speed up syncing its data 

among all your devices.

CaChE loCaTIon
This setting enables you 
to pick an external drive 
with more space to store 
cached data.

matters. Make sure Home Folder is set to 
“None – Services only.” We also suggest 
leaving the “Allow user to administer this 
server” box unchecked, so you are the 
only person in control of your server.

Click Create. By default, a new user will 
have access to all enabled services. If you 
want to restrict access, ≈-click a 
username, choose Edit Access to Services 
and then clear the checkbox next to any 
service you don’t want that person to use. 
You can hold ç to select multiple users, 
then ≈-click one of them and choose 
Edit Access to Services to apply the same 
rights to all of them at once.

Follow the walkthrough opposite to set 
your server as Time Machine’s target for 
Macs on your network. After that, your 
next task is to use Server’s caching 
capabilities; macOS Sierra can put your 
Desktop and Documents folders in iCloud 
Drive to make it available on all your 
devices. If you’ve switched this on, you’ll 
want to use iCloud caching to speed up 
syncing and cut internet bandwidth usage 
– crucial if on a metered connection.

The trick is to leave your server 
switched on 24/7, so whenever your other 
devices are connected to your network, 

any changes they make to your iCloud 
Drive are cached on the server as well as 
uploaded to iCloud, and other devices on 
your network retrieve them from the 
cache rather than downloading them 
from the internet. When a device is away 
from your own network, or if your server 
isn’t running, files will still sync with 
iCloud as normal.

The annotation above shows how easy 
it is to set up the Caching feature. It also 
works for app purchases, iBooks, system 
updates and more (apple.co/2mb6i0g), 
which can lead to further bandwidth 
savings and improved performance when 
your devices are able to retrieve data from 
the cache on your network.

Server is primarily aimed at businesses, 
yet it has other uses that may interest you 
at home or in a small business: creating 
wikis, centralizing shared folders, and 
using a virtual private network (VPN) to 
provide an encrypted connection to home 
over the internet. Even if you only want 
to back up your Macs wirelessly, and you 
have a spare one to run the app, the cost 
of Server and a hard drive saves you lots 
of money compared to an AirPort Extreme 
or a Time Capsule. nick peers

 
SEPaRaTE dISKS

Limit the impact of 
a failed hard drive by 

configuring Server 
to store your Time 

Machine backups and 
cache on separate disks.

 
JaRGon BUSTER

A VPN (virtual private 
network) gives access 

to a private network 
while connected to 
another one over a 

secure and encrypted 
connection back to it.
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restrict user access
Another way to manage Time Machine 

is to limit which users can access it. Click Edit 

Permissions, select “only some users” and click 

OK. Click + to add names – start typing, then 

select a user from the suggestions that appear.

Choose backup drive
Select Time Machine in Server’s sidebar 

and turn on the switch (top right). You’ll be 

asked to pick a destination in which to store 

backups of your other Macs. Click Choose 

and select a folder on any connected drive.

Connect from  
other Macs

In System Preferences > Time Machine on 

another Mac, click Select Disk, select your 

server from the list of destinations, click Use 

Disk, and enter the username and password 

of the corresponding person’s account.

Add more storage
Alternatively, if you start to run out of 

space, purchase another drive, connect it to 

your server and then click + under Backup 

Destinations to add its space, which will be 

used once the original drive is full.

set storage limits
If the server is using OS X 10.9 or later, 

you can cap the space available to each user. 

Check “Limit each backup to” and enter 

a value; the lower it is, the fewer backups a 

Mac can keep before old ones are removed.

Monitor your  
backup usage

In macOS Server, select Time Machine, then 

click the Backups tab. A list of connected Macs 

and any ongoing or completed backups will be 

listed. Double-click one to reveal details, such 

as its history, or to delete backups.

How to Set up Time Machine backups  
JaRGon BUSTER

DHCP (Dynamic Host 
Configuration Protocol) 
is used by your router 
to hand out IP (Internet 
Protocol) addresses to 
each of your devices to 
uniquely identify them.

 
UPdaTES

Server’s Software 
Update feature enables 
you to manage which 
updates from Apple 
are available for your 
other Macs to install.
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Protected by 
cyberGhost

In Settings > Wi-Fi this 
status under a network 
confirms it’s protected 

by CyberGhost’s VPN.

VPN serVer
The app shows the 
location of the server 
you’re using – close 
by is generally better.

VPN actiVe
You’ll know when 

you’re connected to 
the VPN due to this 

symbol in the top bar.

your iP  
address
Every online device 
has a unique address. 
CyberGhost hides your 
real IP address to provide 
you with anonymity online.

If you want to keep data 
secure, you should use a 
Virtual Private Network (VPN). 
This is a method by which 

internet-connected devices can encrypt 
communications when using an untrusted 
public network. A VPN encrypts the links 
between your device and a website’s 
server, so your Internet Service Provider 
(ISP) can’t see the websites you’ve visited. 

This gives a level of anonymity over 
your IP address, as well as protection 
against hackers looking to gain access to 
your data, especially when you’re using a 
public Wi-Fi network – but be warned, if 
you’re using an unencrypted connection 
your details can still be vulnerable. 

VPNs can also get around governmental 
blocks on the internet; in some countries, 
however, such as the United Arab 
Emirates, using a VPN is illegal. So, if 
you’re going to be traveling abroad, make 
sure you read up on local laws ahead of 

Stay secure on public wi-fi
Use a virtual private network to encrypt your traffic and hide where you are

time so that you know where you stand 
– and stay up to date if you make repeat 
visits, in case encryption laws change.

There are many VPN tools. Hotspot 
Shield and the premium NordVPN are 
popular, the latter especially since it 
claims its US and Canada-based servers 
are fast enough for video streaming.

In this tutorial, though, you’ll learn 
about CyberGhost, which offers a service 
for iOS devices priced at $2.99 per month. 
The company publishes annual 
transparency reports; whichever VPN 
you choose, it’s vital that it’s with a 
company you trust – if you can justify 
it, go for a premium product.

As you’ll see in the walkthrough,  
trying out a VPN adds its configuration 
profile to your iOS device, which you can 
see in Settings > General > VPN. If you 
remove the CyberGhost app from your 
device, its configuration profile is 
removed along with it. adam SmIth

reQuires
CyberGhost,  

iOS 9 or later

you will learN
What a VPN can do for 
you, and the settings 

you should be using

it will taKe
30 minutes
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Block tracking
Tracking by sites is blocked by default. 

If a site doesn’t like this, access to it will be 

entirely blocked. Virus-Protection is also 

normally on; if CyberGhost detect known 

and potential malware on a site, it’ll block 

access to that site.

get started
CyberGhost asks to add a VPN 

configuration to your device. Once done, 

choose whether to allow the app to show you 

notifications. At the page with five dots under 

it, swipe left till you see “Surf Anonymously” 

and then tap Options.

start surfing
When the settings are as you want 

them, tap Start Surfing. The app takes a 

moment to connect to its VPN, then a VPN 

badge appears in the top bar. Switch to Safari 

or whatever app you need to use privately 

and use it as normal.

Compress website 
content to save data

The final setting is normally off. If you enable 

it, images are reduced in quality before they’re 

sent to your device, helping pages load faster 

by reducing how much data is received. On a 

mobile data plan, this can save you money.

Basic security
The first item sets the country you’d  

like to appear to be in, which will be set to 

Automatic by default. The three items below 

(encryption, masking your IP address, and no 

logging) are always-on features of using 

CyberGhost’s VPN.

Access video services
Switch back to CyberGhost and tell it 

to stop surfing anonymously. Swipe right to 

“Secured Streaming,” tap Choose Website,  

a service, then a country. It’s accessed through 

a server there and relayed over an encrypted 

connection that hides your location.

how to Make sense of CyberGhost

 
JarGoN buster

For greater security, 
check whether a VPN 
service provides a split 
tunnel, where access 
to internet services is 
unsecured but reduces 
bandwidth usage, or a 
full tunnel that encrypts 
all of your traffic.

 
terms aNd 
coNditioNs

Always check the terms 
and conditions of a free 
VPN in case the provider’s 
business model turns you 
into a product. Some may 
sell anonymized data 
to third parties.
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iCloud enables you to sync 
music and movies – plus 
photos, contacts, calendars 
and various kinds of data – 

wirelessly to the cloud. You need to be 
using the latest versions of iOS and 
macOS (there’s also a Windows desktop 
tool and iCloud control panel if you use 
a PC – see apple.co/1K7OMAN).

In Settings > iCloud, switch on and sign 
in to iCloud using your Apple ID, and then 
choose what to sync: contacts, calendars, 
reminders, notes, bookmarks, Mail 
accounts (and messages, if you opt to set 
up an iCloud Mail account) and more.  
Now instead of backing up to your Mac via 
iTunes, your device will sync with iCloud 
over Wi-Fi, even if you plug it into your 
computer manually using a cable. 

Part of the service is iCloud Photo 
Library, which syncs photos and videos: 
take a snap on your iPhone or iPad and 
it’ll be synced across your Mac and iOS 
devices, provided the feature is enabled 
(Settings > Photos & Camera). You can 
also use iCloud to privately share photos.

The basics of iCloud
Back up your iPhone or iPad and sync with other devices via Apple’s servers

In Safari, your bookmarks are synced 
to iCloud, as are your Reading List and 
browsing history. You can see what tabs 
you left open in Safari on other devices, 
and open them. Signing in to websites in 
Safari becomes easier when you enable 
iCloud Keychain – learn more on page 102.

You can also use iCloud to wirelessly 
back up your iOS device’s data by turning 
on the Backup feature in its settings.

Finally there’s iCloud Drive, which 
enables you to sync documents and data. 
5GB of space is provided for free. (Music, 
apps and other purchases from Apple’s 
stores don’t count towards the quota.) 
If you need more, prices start at 99¢ per 
month for 50GB of storage and rise to 
$19.99 per month for 2TB. 

If you’ve heard of iCloud Music Library 
and are curious why iCloud’s settings do 
not mention it, that’s because it’s in the 
Music app’s settings, and only available 
if you have an Apple Music or iTunes 
Match feature. Also, tracks stored in it do 
not take up any of your iCloud account’s 
storage allowance. Rob Mead-GReen

REQUIRES
iPhone or iPad,  
iOS 10 or later

yoU wIll lEaRn
How to share, sync 

and back up your 
documents and data

IT wIll TaKE
10 minutes

How To Share things via iCloud

Share photos
Go to Settings > Photos and switch 

on iCloud Photo Sharing. In the Photos 

app, select Shared, then tap + to create a 

new album. Give the album a name, then 

choose who you want to invite to view 

it. Now add the pics and videos to share.

Share calendars
In the Calendar app, tap 

Calendars, tap the ‘i’ beside a calendar, 

and tap Add Person to invite someone to 

share the calendar. Scroll down, switch 

on Public Calendar, then tap Share Link 

to invite people to view (but not edit) it.

Share documents
You can open and edit files at 

icloud.com – and so can other people 

using any supported browser, via links 

you send. You can also access files using 

iCloud Drive, which acts like a folder of 

links to your remotely-stored data.

>>>Create
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get more storage…
Your account provides 5GB of 

space for free. If you need more, go to 

Settings > iCloud > Storage > Change 

Storage Plan, and tap on the plan you 

want; 50GB now costs just 99¢ per 

month, and is enough for many people.

iCloud settings
Tap Settings > iCloud; if you 

didn’t enable iCloud during setup, you 

can here. Decide which services to use. 

Other accounts added on your other 

devices, such as Facebook, Twitter, 

and Gmail, are synced silently too.

Other devices
For devices other than the one 

you’re using, you can’t see this level of 

detail, but you can see when they were 

last backed up and the size of backups. 

You can delete backups, but be careful, 

especially in the case of other devices!

…or optimize first
On the Manage Storage screen, 

you’ll see your devices that are using 

iCloud to store their backups, and a 

summary of your documents and data 

in iCloud. Tap the name of your device 

to see details of data it’s backing up.

Documents & data
Tap iCloud Drive to reveal a 

switch that turns it on; its app will be 

added to your Home screen. You can 

select which apps can store docs and 

data in iCloud, and whether to use 

cellular data if Wi-Fi is not available.

Activate apps
For Apple apps such as Pages, 

Numbers, and Keynote, tap their name 

at Settings’ top level and set them to 

save to iCloud; the app’s docs are then 

accessible at icloud.com and synced to 

devices connected to your account.

Delete backups
To save space, remove old data. 

In the Manage Storage section, tap 

on an app – depending on the data it 

stores you’ll be able to delete individual 

files or entire folders; tap Edit, the red 

minus icon next to an item, and Delete.

Storage & backup
If you turn on iCloud Backup in 

Settings > iCloud > Backup, your iOS 

device will no longer sync and back up 

automatically to iTunes; it’ll back up to 

iCloud when it’s connected to Wi-Fi and 

power, and its screen is locked.

How To Master your iCloud Backup settings

> safaRi Tab synCinG

If you use Safari on iOS and Mac, 

you can sync open browser tabs 

across devices, as long as each 

is connected to the internet and 

signed into your iCloud account. 

In Safari on iPhone, for example, 

open the tab overview and then 

scroll down past the tab previews.
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>>> 128 essential Mac 
and iOS apps

>>> Clean up  
your Mac

>>> How Apple accidentally 
changed the world

In 1985, seven 
grand bought you 
a LaserWriter – 
or a car.
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IT was ONE of Apple’s most significant 

products, but, as you might guess, the 

story of the laser printer starts at Xerox. 

Twenty years after the company sold 

its first photocopier based on the 

xerographic process, combining 

photography with electrostatic printing, 

Gary Starkweather replaced photography 

with a laser beam, making it possible to 

output an image created digitally.

It was 1969, and work would continue 

at the famous Palo Alto Research Center 

to develop the technology into 

commercial products. Xerox, IBM, and 

others released laser printers for larger 

offices, and by 1979 the Canon LBP-10 

had brought the technology to the 

desktop. HP’s LaserJet, based on 

Canon’s CX engine, followed in 1984.

Equipped with AppleTalk networking 

so that the cost could be spread across 

a workgroup, the LaserWriter sold for 

$6,995, considerably more than its rivals. 

Again, it was PostScript that made the 

difference. Generating the raw code was 

challenge enough for the still-young 

Macintosh and the PageMaker package, 

but rasterizing the resolution-

independent page description for 300dpi 

output – over eight million dots per page 

– required even more processing power. 

With its 12MHz Motorola 68000 CPU, 

the LaserWriter thus became the fastest 

computer Apple had sold.

So what was the big deal about the 

Apple LaserWriter, another CX printer 

that arrived the following year? Not the 

hardware, but the software. Adobe’s 

PostScript page description language 

– created by two more PARC alumni, 

John Warnock and Chuck Geschke – 

abstracted typesetting and graphics from 

the mechanics of printing, setting page 

layout free.

It was Steve Jobs who saw the 

potential of this and negotiated to 

license the software. Together with Aldus 

PageMaker – developed by magazine 

editor Paul Brainerd to let users design 

pages visually – the combination of the 

Macintosh and LaserWriter became the 

first “desktop publishing” platform, a 

term that Brainerd coined.

NEXT ISSUE ON SALE

May 2

RaNdOM applE MEMORy

laserwriter
adam Banks on the printer that changed the publishing industry forever
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